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Summary
Ringtoets is the provisional name of new software for the compulsory safety assessment of
the primary Dutch flood defences (dike rings). Ringtoets will support the new Dutch
regulations, called VTV-2017 (Voorschriften Toetsen op Veiligheid). These regulations will
introduce a new assessment level, based on the failure probability of a dike ring. The
probabilistic method required for this purpose will also be used to calculate characteristic
water levels, to calculate characteristic overtopping levels, and to calibrate the required safety
factors for a traditional deterministic assessment, per dike section and failure mechanism.

Version 1.1 of this document contains the final specification of the functional and non­
functional requirements for Ringtoets, together with a third draft of the functional design and a
second draft of the technical design. The content is based on input and response from an
advisory group, consisting of representatives from regional water authorities and consultants.

The introduction and requirements are contained in chapter 1 to 3. Chapter 1 describes the
context and background. Chapter 2 describes the scope and the tentatively supported
workflow. Chapter 3 lists the functional and non-functional requirements, including priority
indications. The Waterdienst has formally approved the final content of these chapters in April
2012. This content is therefore closed for further discussion since version 1.0.

Chapter 4 (Functional Design) translates the workflow and requirements to so-called use­
cases, describing the interaction between the user and Ringtoets, during different workflow
steps. Chapter 5 (Technical Design) translates the use-cases to a more detailed technical
description of screens for the different activities, and to the data-model underneath.
Compared to version 1.0, chapters 4 and 5 contain the result of a review of version 1.0, in the
course of June 2012. Additionally, these chapters contain further improvements, following
from the preparation and execution of three actual implementation stages between
September 2012 and May 2013. Continuous further improvement during future stages is part
of the development strategy.
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1  Introduction 

 
1.1 Ringtoets 

 
Ringtoets is the provisional name of a new software system for compulsory safety 
assessment of the primary Dutch flood defence systems (dike rings), according to new Dutch 
regulations called VTV-2017 (Voorschriften Toetsen op Veiligheid). Ringtoets connects for the 
calculation of failure probability to separately defined software, called Hydra-Ring. 
 

1.2 Purpose and scope of this document 
 
The document in hand defines the functional and non-functional requirements for Ringtoets, 
as well as the functional and technical design.  
• First purpose of this document is to allow the principal to check if both the requirements 

and the functional design are according to expectations. The purpose of intermediate 
versions of the functional requirements and functional design is also to gather and use 
feedback from the Ringtoets Advisory Group. This group consists of both the regional 
water authorities responsible for assessment and the consultants to which assessment 
tasks are usually delegated.    

• Second purpose is to provide the Ringtoets developer with all required information for 
implementation, testing and (future) maintenance. Especially the technical design in 
chapter 5 serves this purpose.  

 
For a description of the new VTV-2017 assessment procedure, the reader is referred to the 
first framework description [Lit 6.6].  For a description of the requirements and the design of 
the probabilistic part, the reader is referred to the Hydra-Ring design document [Lit 6.2]. For 
the scientific background on the implemented methods and algorithms in the probabilistic 
part, the reader is finally referred to Hydra-Ring’s scientific documentation [Lit 6.1].  
 

1.3 Status and process  
 
Version 0.2 (December 2011) contained already a second draft for the requirements 
(chapters 1 to 3) and a first draft for the functional design (chapter 4). This version has been 
discussed with the Advisory Group on March 30, 2012. After that, all received feedback from 
the principal and the advisory group has been discussed with the principal on April 10, 2012. 
This discussion has resulted in agreement on the required modifications to the chapters 1 to 3 
[Lit 6.13].   
 
Version 1.0 (June 2012) contained the amended final requirements, together with a second 
draft of the functional design and a first draft of the technical design. Version 1.0 served also 
as input for the first development period in September 2012.  
 
Version 1.1 contains an update of both the functional and technical design (chapter 4 and 5). 
This update reflects the new insights, gathered during the first three development stages, up 
to and including April 2013. The update also reflects all received feedback from the principal 
and the Advisory Group. Further improvement will take place during the following stages of 
development. 
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1.4 Background 

1.4.1 WTI-2017 project 
 
Rijkswaterstaat has commissioned Deltares to develop a new set of methods and tools for 
assessing and designing the Dutch flood defence systems based on the failure probability of 
a dike ring. Since 2012, this development is a part of the project WTI-2017 [Lit 6.11]. A first 
version of the new regulations and supporting software needs to be available in the course of 
2013, in order to start an evaluation and improvement period that will run until the end of 
2016.  
 
 
 
 
 
Figure 1.1 Global time schedule TOI project 
 
Figure 1.2 presents a sketch of the view of Rijkswaterstaat on the context of the assessment 
instruments. The figure originates from the TOI Project Start Architecture document [Lit 6.7] 
 

 
Figure 1.2 Rijkswaterstaat  view on system context,  according to [Lit 6.7] 
 
 
Figure 1.3 shows the shared failure mechanism and UI libaries for WTI dike assessing and 
designing tools. Shared libraries allow for generic tool development and implementation, 
which fits into the Rijkswaterstaat’s vision to optimize the total support and maintenance costs 
of software applications.  
 

2009 
TOI: Preliminary 
development  

WTI-2017: further 
development and evaluation 2011 2016 

New instruments 



 

 

 
1207804-001-DSC-0002, 16 May 2013, final 
 

 
Ringtoets Requirements and Functional Design 
 

3 of 127 

 
 
 
Figure 1.3 Shared libaries for WTI dike assessement and designing tools 
 

1.4.2 Assessment method according to the VTV-2017 
 
The current set of regulations (VTV-2006) and supporting set of software (Hydra’s, 
Steentoets, Grastoets, Golfklap, D-GeoStability/MStab, Duros etc) is based on a partly 
probabilistic and partly deterministic safety assessment of dikes, dunes and structures. The 
Hydra software determines first in a probabilistic fashion the water level, wave parameters 
and overtopping characteristics per cross section. Further assessment for other failure modes 
(mechanisms) is executed per failure mode and per section, using a characteristic water level 
with allowed exceedance frequency (toetspeil) as calculated by the Hydra’s.    After an initial 
relevance check (level 0), a simple assessment by a decision rule (level 1) can be followed by 
a detailed assessment (level 2). The simple assessment usually requires only the geometrical 
properties to be known, whereas a detailed assessment usually requires additional physical 
model parameters. This deterministic method is also called semi-probabilistic, because 
prescribed partial safety factors implicitly ensure that the annual failure probability stays 
always below an allowed value per section and mechanism.  
 
The new VTV-2017 regulations will also support this VTV-2011 type deterministic assessment 
per mechanism and section. Part of the TOI project will therefore aim at the calibration of the 
safety factors for the final VTV-2017 mechanism models in 2017. Additionally, the new VTV-
2017 regulations and supporting software will allow an explicit probabilistic assessment, 
taking into account the combined contributions from different failure modes and different 
sections. The prescribed failure mechanism models for detailed probabilistic and semi-
probabilistic analysis will be identical. The VTV-2017 will also prescribe how to combine the 
results from sections and mechanisms that were assessed with different methods.   
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Figure 1.4 VTV-2017 assessment scheme, with additional new level 2b. Level 3 (advanced) is not shown. Also not 

shown is the additional assessment, based on criteria defined by the regional water authority 
(beheerdersoordeel)  

 
The result of a semi-probabilistic assessment is usually a certain factor of safety (FOS) per 
mechanism and section. A FOS is determined by the ratio between the allowed and actual 
value of certain load type (e.g. an overtopping discharge, a differential head for piping or a 
driving moment for slope instability). The result of a probabilistic analysis is an integrated 
failure probability for (a part of) a dike ring, which has to be compared with the allowed value. 
The failure probability is influenced by the uncertainty in both hydraulic loading and strength, 
as well as by the length and number of the sections. A probabilistic analysis for combined 
mechanisms and sections is always less conservative than a separate semi-probabilistic 
assessment per mechanism and section.  
 

VTV-2011 

 

 

2a: Detailed semi-probabilistic 
assessment (per mechanism and section) 

1: Simple Assessment (per mechanism and section) 

0: relevance check (per mechanism and section)  
 

2b: Detailed probabilistic assessment  
(for combinations of mechanisms and sections) 
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1.4.3 Global Assessment Work flow  
Figure 1.5 depicts the global assessment work flow which is to be supported by Ringtoets.   
 

 
Figure 1.5  Work Flow Safety Assessment. Ringtoets covers all tasks which are coloured green. The additional 

containers show the initial data (white) and project data (yellow). The Water authorities are responsible for 
delivering the flood defences key data and for executing the schematization and assessment.  
Rijkswaterstaat (RWS) is responsible for delivering the hydrodynamic and statistical data, and delegates the 
production  to Deltares.  The hydrodynamic data is contained in different physical databases for different 
regions. The project database content (flood defence schematizations, hydraulic boundary conditions,  and 
assessment results) is coloured yellow.  

 
Section 2.3 contains a more detailed description. 
 

Flood Defences           
key data  

(water authorities) 

Safety assessment 
• Deterministic per section and mechanism 
• Probabilistic for combined sections and mechanisms 
 

Geometry dependent schematization 
• Location and dimensions of the flood defence system 

Flood Defence schematization 
 

Further schematization per failure mechanism 
• Division in sections, with representative cross section 
• Simple models (less data required) 
• Detailed models (less conservativeness required) 

Assessment results  
 

Report results 

Calculation of Hydraulic Boundary 
Conditions, per cross section or 
per output location 
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1.4.4 Stakeholders and users 
 
• Rijkswaterstaat is responsible for delivering the assessment tools, including the format 

and content of the hydrodynamic database, as well as for the data format of the 
schematization and assessment results and the format of the final assessment report.  

 
• The regional water authorities (waterschappen) and Rijkswaterstaat are the end-users, 

responsible for the execution of the actual assessment, including data acquisition, 
schematization, analysis and reporting. 

 
• The regional water authorities commission their assessment tasks mostly to specialized 

civil engineering consultants. The total number of consulting employees doing actual 
assessments is not more than two hundred.  

 
During the Ringtoets definition and development stage, Deltares will frequently consult the 
Ringtoets Advisory Group in order to get feedback on intermediate results. This group 
consists of both the regional water authorities responsible for assessment and the consultants 
to which assessment tasks are usually delegated.   
 
Related to the WTI as a whole, the “Directoraat-Generaal Waterstaat” is primary responsible 
for all formal communication with public administration representatives and the Waterdienst is 
primary responsible for all formal communication with the regional water authorities (in 
coordination with the “Directoraat-Generaal Waterstaat”). Deltares is finally responsible for 
communication with the civil engineering consultants (in coordination with the Waterdienst). 
 

1.5 System documents 
Together with the document in hand, the following documents comprise the currently 
available system documentation for Ringtoets and Hydra-Ring. All these documents are 
under continuous development, until the VTV-2017 regulations and associated software will 
be formally released in 2017.  
 
Document Content 
Project Start Architektuur TOI [Lit 6.7] Gives constraints for usage of TOI within the 

infrastructure of Rijkwaterstaat and the water 
boards. 

Het raamwerk en de aanpak van het 
toetsproces: voorstel [Lit 6.6] 

Proposes a structure and approach for the new 
safety assessment procedures (VTV-2017), which 
are to be supported by Ringtoets. 
 

Hydra-Ring Design document [Lit 6.2] Describes the requirements for Hydra-Ring, as 
well as the design of the software structures, the 
data structures and the databases (project 
database, general configuration database, 
statistical configuration database, hydrodynamic 
databases per region).  

Hydra-Ring Scientific documentation [Lit 
6.1] 

Describes the methods and algorithms used in 
Hydra-Ring. Serves as the basis for the scientific 
background in the final User’s manual of 
Ringtoets.  
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1.6 Assumptions and Constraints 

 
Ringtoets has to comply with the following assumptions and constraints (CNS), related to the 
different purposes of Ringtoets at the different stages of the development. The reason for 
defining these assumptions and constraints prior to the definition of the requirements in 
chapter 3, is that each of them will affect multiple requirements.  Assumptions are also 
needed to specify the still undefined or uncertain parts of the WTI project context to a 
sufficient detail.  
 
CNS 1 The draft document “Project Start Architektuur TOI” [Lit 6.7] defines the constraints 

provided by Rijkswaterstaat1.   
 
CNS 2 The Deltares report “Uitgangspunten WTI” [Lit 6.12]  defines the general assumptions 

and constraints for the Deltares WTI project as a whole.  
 
CNS 3 The first evaluation version of Ringtoets must be available at the start of the evaluation 

period, which is tentatively in the course of 2013. The aim of the evaluation version of 
Ringtoets, in combination with the evaluation version of Hydra-Ring, is to support 
semi-probabilistic and probabilistic analysis of all Dutch primary flood defences, with a 
functionality similar to the Hydra’s and to PC-Ring. 

 
CNS 4 Ringtoets will support the deterministic and/or probabilistic analysis of all mechanisms 

contained in a new VTV-2017 software library of failure mechanisms. The 
specifications of different VTV-2017 failure mechanism models however, as well as 
the subsequent specification and development of the software library itself are not a 
part of the Ringtoets specification and development. 

 
CNS 5 The requirements and limitations for probabilistic analysis with Ringtoets (level 2b) are 

already defined in the Hydra-Ring design document [Lit 6.2].  This includes the 
requirements on the failure mechanism models and hydraulic load models to be 
supported probabilistically for respectively the evaluation version and the product 
version. This includes also the requirements and limitations with regard to the use of 
mechanism sections. And it finally includes the specification of the Hydra-Ring 
interface.  

 
CNS 6 Besides level 2b, Ringtoets needs to support also the decision rules in level 1 and a 

semi-probabilistic assessment in level 2a, as well as the combination of 
probabilistically assessed parts with semi-probabilistically assessed parts. Ringtoets is 
not expected to support decisions with regard to the relevance check (level 0). 
Ringtoets is also not expected to support a level 3 assessment (Toetsen op maat) and 
additional assessment procedures, such as Beheerdersoordeel. 

 
CNS 7 The first product version of Ringtoets is planned in 2016, before the start of the next 

assessment period in 2017. The aim of this product version is to supply full support for 
assessment with prescribed VTV-2017 models and procedures for at least 9 failure 
mechanisms (including simple or detailed deterministic assessment), with the help of 
Hydra-Ring. 

                                                   
1. The general constraints for Rijkwaterstaat software (such as huisstijl and web-based design) are not applicable for 

RIngtoets. 
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CNS 8 The applicability of Ringtoets will be limited to safety assessment for all Dutch primary 

flood defences (category a, b and d), based on the VTV-2017.  

CNS 9 According to Rijkswaterstaat, the final reporting of assessment results by the regional 
water authorities, in a fixed digital format, is not a part of the required Ringtoets 
functionality.  Instead, a connection to an external reporting module such as Toetsrap 
is envisaged. The specification of such a module is therefore not a part of the current 
Ringtoets definition2. 

 
CNS 10 The first product version of Ringtoets is not expected to offer automated 

design capabilities (i.e. functionality for automated determination of the required 
geometrical and physical properties, similar to the DAM software). The Ringtoets 
design must however allow for such an extension in the future. 

 
CNS 11 Ringtoets will supply some basic data visualization and data elaboration 

options as found in GIS systems and spreadsheets, and use data-connections to 
existing external GIS systems and/or spreadsheet software for further functionality. 
This means that Ringtoets will not fully replace the functionality of already existing GIS 
and spreadsheet software.  This philosophy is shared with the Hydra’s and with the 
DAM software. Further details on the supported options will be supplied as part of  the 
definition of the requirements (chapter 3) and the use-cases (chapter 4). 

 
CNS 12 Possible access to a remote Ringtoets installation via a Citrix web client is a 

minimum requirement for Rijkswaterstaat. It is however not a Rijkswaterstaat 
requirement or user requirement that the user-interface is fully web-based (meaning: 
access via a web browser, without Citrix client software).   

 
CNS 13 Ringtoets must be capable to import a snapshot of all key data from the 

original data sources maintained by the regional water authorities, using the same 
exchange formats and methods as DAM (Dike strength Analysis Module) already 
does. The reason for this constraint is that that the water authorities  obviously want to  
maintain only one  single data source for both DAM and Ringtoets. 

 
CNS 14 The models and algorithms supported by Ringtoets are not expected to be 

exactly equal to the models and algorithms supported by PC-Ring and the Hydra’s. 
Therefore, the numerical results are also not expected to be exactly equal. However, 
the trends and ratio of results are expected to be comparable.  

 
CNS 15 Ringtoets will not offer capabilities for direct import of PC-Ring or Hydra input, 

as the input data model of Ringtoets will be different. Instead it is assumed here that 
re-use of existing PC-Ring data (from the VNK project) during the test and evaluation 
period will be achieved via preprocessing. Automation of this preprocessing will 
however be not a part of the Ringtoets development. 

 
CNS 16 Rijkswaterstaat allows the use of third party software as part of Ringtoets, as 

long as this software does not require a separate user licence fee, and as long the 

                                                   
2. The structure of the workflow supported by Ringtoets will be different from the formal VTV-2017 structure to report 

the final assessment results. 
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availability is guaranteed for a minimum period of 10 years. This constraint does not 
apply to existing external software that has to be used in conjunction with Ringtoets. 

 
1.7 Summary of relevant concepts and procedures 

 
Some important concepts and terms for understanding the functional requirements are 
explained globally hereafter. A full glossary of terms is presented in appendix A and B.  For 
more detail on the mentioned concepts, models and procedures, the reader is referred to the 
scientific documentation [Lit 6.1]. 

1.7.1 Failure mechanisms 
 
A flood defence system consists of sections of dikes and/or dunes, with interjacent structures. 
A flood defence system can fail (meaning: lose its water retaining function) due to different 
failure mechanisms. An overview of relevant mechanisms for dikes is shown in Figure 1.6. 

 
 
Figure 1.6  Illustration of different failure mechanisms for dikes. 
 
Sometimes, actual failure will depend on the occurrence of more than one submechanism. An 
example is failure due to piping (internal erosion of sand underneath the dike or structure), 
which can only occur after preceding uplift of the protecting cover layer at the land side, see 
Figure 1.7. Another example is the failure of the inner slope due to erosion or instability, after 
a preceding occurrence of overtopping. 

Overflow Overtopping 

Slope stability outwards Slope stability inwards 

Seepage face erosion 

Liquefaction Revetment failure  

Piping (internal erosion) 
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Figure 1.7 Example of the fault tree for failure mechanism piping 

 
Submechanism failure is predicted on the lowest level by cross sectional models, requiring 
input that is partially model specific. A cross section can contain different zones of revetment, 
which need to be assessed per zone.  

Failure due to piping 

Piping (incl. heave) Uplift  

AND 
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1.7.2 Assessment levels and section divisions 
 
The safety assessment for different failure mechanisms according to the VTV-2017 must be 
executed stepwise on different levels, according to Figure 1.4 and Table 1.1.  
 
Table 1.1: Overview of assessment levels 
Level Type of assessment Outcome 
0 Relevance check per cross 

section and mechanism 
When the failure mechanism is not relevant for a 
cross section, the annual failure probability (FP) is 
assumed to be zero. 

1 Simple semi-probabilistic 
assessment per cross section 
and mechanism 

When the result of the simple assessment is positive, 
the annual FP is below a certain allowed value as 
derived from the ‘failure probability budget’ 

2a Detailed semi-probabilistic 
assessment per  section and 
mechanism 

The ratio between the conservatively determined 
deterministic strength and load is usually expressed 
via a factor of safety (FOS). The use of partial safety 
factors ensures that, when the FOS is larger than 1, 
the failure probability is below a certain allowed value 
as derived from the ‘failure probability budget’.  

2b Detailed probabilistic 
assessment (for combinations 
of sections and mechanisms) 

The result of the detailed probabilistic assessment 
will be the annual FP for the each failure mechanism 
per section, as well as an overall failure probability for 
the combined failure mechanisms and sections.  

  
As part of a level 2 assessment, the total stretches of dunes and dikes are divided by the user 
into different longitudinal mechanism sections. Inside each of these sections, the different 
input parameters for the considered mechanism model(s) are assumed to be more or less 
constant, but uncertain. The length of a section should be sufficient large for a failure 
mechanism to occur.  
 
In case of a semi-probabilistic assessment (level 2a), the assessment results from different 
mechanism sections (OK or not OK) are combined on so-called combination sections. The 
joined boundaries of all different mechanism sections determine implicitly the division into 
combination sections. The purpose of combination sections is to decide for which parts a 
semi-probabilistic assessment is sufficient, when considering all mechanisms together.    
 
In case of a probabilistic assessment (level 2b), the user will be able to define additional 
presentation sections. A presentation section consists of one or more combination sections. A 
presentation section is used for combination of the failure probability contributions from 
different mechanism sections, in order to determine if physical improvement of the section is 
required.   
 
See section 2.3 for further details on the stepwise assessment and section divisions. 
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2 Scope 

2.1 System definition 
 
 
The main goal of Ringtoets is to support the required model schematizations by the user and 
afterwards execute an automated assessment of primary Dutch flood defences, according to 
the VTV-2017 regulations. Schematization means the process of producing model input for a 
subsequent assessment, starting from already available key data. Automated means that 
Ringtoets will execute the assessment for combinations of multiple mechanisms and sections. 
It is intended that Ringtoets will finally replace PC-Ring and the Hydra’s, which together offer 
similar functionality.   
 
Ringtoets will have four main functionalities: 
1. Support for schematization using imported or inputted data, for the purpose of 

assessment; 
2. Calculation of the hydraulic boundary conditions; 
3. Execution of safety assessments on different levels (simple, semi-probabilistic and full 

probabilistic calculations) and combination of the assessment results; 
4. Presentation of assessment results. 
 
Figure 2.1 shows the global Ringtoets design. The main functions are steered by a controller, 
connecting to a graphical User-Interface (UI), an input/output (IO) layer and a business layer.   
 
• The user interface enables tabular or graphical presentation and manipulation of the 

project-data, the model schematization and the calculation results.  
 
• The input/output layer connects to the internal project database, and to different types of 

external databases and files. The external data sources are shown at the left hand side3. 
A GIS and a subsoil database (D-Soilmodel) are expected to be used increasingly by the 
waterboards as the original source for processed key data. Data exchange with Ringtoets 
is expected to be performed through CSV or SHP files. The CSV format allows also for 
connection to external spreadsheet software. The additional XML format is expected to be 
used mostly for archiving and exchanging project data, as well as for connection to 
external software, such as a formal VTV-2017 report module.  Map data is expected to be 
imported through shp files.  

 
• The business layer performs the tasks for assessment on all relevant levels and contains 

also the definition of the shared data-model. The business layer connects to the Hydra-
Ring component for the probabilistic assessment (level 2b).   

 
Ringtoets connects to software libraries containing components that are shared with other 
tools, including the stand-alone VTV tools and DAM (Dijksterkte Analyse Module). Sharing 
libraries between these tools will enable uniform connections to single data sources, a 
uniform look and feel and equivalent results from the shared mechanism models. Using 
shared libraries will also reduce the maintenance effort for each of these tools. 
 

                                                   
3. Import and export to NetCDF is currently not foreseen as a user requirement.  



 

 

 
1207804-001-DSC-0002, 16 May 2013, final 
 

 
Ringtoets Requirements and Functional Design 
 

13 of 127 

 
 
 
 

 
Figure 2.1 Global design of Ringtoets  
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2.2 Main features 
 
Schematization using imported or inputted data 
Ringtoets will have functionality for input or import of data, and support the schematization 
process from processed data to the required model input for assessment, either semi-
probabilistic or probabilistic. The user can specify the geometrical and physical properties of 
flood defence sections per mechanism. The user can connect these sections to predefined 
locations of hydrodynamic data, already available in databases. The graphical user interface 
will support the schematization process by offering tools for visualising, editing and modifying 
the properties per mechanism and longitudinal section.  

Calculation of hydraulic boundary conditions 
Ringtoets will offer a probabilistic calculation of the water levels, waves and overtopping 
characteristics at different locations. Ringtoets will use the output at cross section locations 
for a subsequent semi-probabilistic assessment of different failure modes. 
 
Execution and combination of safety assessment on different levels 
The main functionality of Ringtoets is to execute safety assessments on different levels. This 
means that a user can perform simple geometry based assessment, detailed semi-
probabilistic assessment and detailed probabilistic assessments with the help of Ringtoets. 
Ringtoets will also support the combination of assessment results from different mechanisms 
and different sections, potentially assessed at different levels. 
  
Presentation of assessment results 
Ringtoets can present the primary calculation results in tabular format. Additionally, some 
basic support will be supplied for graphs in time or space, and for visualization of results on 
map/GIS layers. Output of detailed semi-probabilistic results per mechanism and section is 
very important for a user, in order to gain confidence in the quality of the output. The 
contribution to the total probability of each individual failure mechanism at a certain section is 
of great use for the engineers. Post-processing will also be supported by output of data to xml 
or csv files (section 3.3.8).  
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2.3 Supported tasks and workflow 

2.3.1 Overview 
 
A schematic overview of the tasks to be supported at different levels for a regular assessment 
procedure is given in Figure 2.2.  This scheme enables a part of the required assement 
according to the VTV-2017, as far as currently known [Lit 6.6]. It should be noted in advance 
that Ringtoets will not support “Toetsen op maat” and “beheerdersoordeel”, see CNS 5.  
 
The presented scheme indicates that the initial relevance checks (level 0), calculation of 
hydraulic boundary conditions and further geometry based assessments (level 1) could be 
executed in principal at all considered cross sections. The result of such a cross section 
analysis reveals which stretches per mechanism require a more detailed level 2 assessment. 
 
A level 2a or 2b assessment is executed at the level of longitudinal sections (“dike sections”), 
containing one or more cross sections. The definition of the section division per mechanism 
within the relevant stretches should be performed with the help of: (a) the result from the 
preceding cross section analysis and (b) an analysis of the spatial variability of the boundary 
conditions and the additionally required model data per mechanism.  

 
Figure 2.2 Schematic tasks for safety assessment, as far as supported by Ringtoets.  
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2.3.2 Detailed Workflow 
 
Details on the workflow that needs to be supported are presented below, in bullet style. The 
purpose of this description is mainly to help in deriving and understanding the related 
requirements.  The workflow description will be restricted to three typical mechanisms 
(overflow/wave overtopping, revetment, heave/piping). Extension of the description to 
additional mechanisms is however quite straightforward. 
 
A.  Definition of cross section geometry and determination of the required assessment 

level per cross section, with the help of relevance checks (level 0) and geometry 
based checks (level 1). 

 

 
Figure 2.3 – Determination of required assessment level per mechanism and cross section. 
 
A1. Define Flood defence system  

• Input or import the actual dike location line of the flood defence system4 
• Input or import processed cross section surface lines (from Digital Terrain Model in 

GIS). 
• Optional: import existing definitions of characteristic point verticals along the dike line 

(such as outer levee toe, outer levee crest, inner levee crest, inner levee toe, berm 
crest, berm toe etc.) 

• Define or update the locations of the characteristic points  
• Import or define the inland piezometric head (polder head) distribution along the dike 

location line 
• For revetments and wave overtopping/overflow: import or input the location and 

properties of different revetment zones  
• For revetments and wave overtopping/overflow: import or input the locations and 

properties of breakwaters and foreland, both causing wave reduction. 
 
See UC 10 (page 40) to UC 17 (page 42) for details on the required key data. Note that the 
full key data includes already processed data, such as surface descriptions, subsoil 
schematizations and model parameters. 

                                                   
4. Two different versions of the dike line can exist (the global location according to the Rijkswaterstaat  administration,  

and the actual location according to  the water authority) 

• Characteristic values of hydraulic boundary conditions per cross section 
• Check if mechanism is irrelevant (level 0), if level 1 is sufficient, or if level 2 is 

required  
 

Determine the required assessment level per mechanism and per cross section  

Mechanism 2  

Mechanism 1  

Mechanism 3  2 

0 0 0 0 0 0 0 1 1 1 1 1 1 

2 2 2 2 2 2 2 2 2 2 1 1 

1 1 1 1 1 
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A2.  Compute water level, overtopping level and wave data 
• Use Hydra-Ring to calculate the characteristic assessment water level (the water level 

with a certain annual exceeding probability) along the flood defence system, at the toe 
of each location where measured cross section geometry is available, or at each 
output location. See UC 25 (page 45) for details. 

• If wave parameters are not available directly from the internal database with 
hydrodynamic data:  import or input fetch lengths per wind direction. 

• Use Hydra-Ring to calculate the wave data for a revetment assessment5. See 0 
details. 

• Use Hydra-Ring to compute overtopping probabilities as a function of crest height, 
using a schematized surface. See UC 27 for details. 

 
 
A3. Perform level 0 assessment 

• Select the mechanisms that can be excluded in advance along which part of the flood 
defence system, based on a relevance check6.  

 
A4. Perform level 1 assessment 7 

• For heave/piping and slope stability checks: input or import the piezometric heads at 
polder side 

• For all mechanisms: apply geometry based (level 1) decision rules  along the defence 
system when applicable and decide which parts of the flood system can be excluded 
for further assessment 

• View results per mechanism: cross sections along the dike location line requiring level 
1 or level 2 assessment. The associated output is illustrated in Figure 2.3. 

• Optional: export previously inputted or modified data. 
 
See from UC 28 (page 48) to UC 31 for details on step A4. 

                                                   
5. Wave parameters for revetment at different heights need to be determined in the so-called “design point” (illustratie 

punt), with a special approximated limit state function, such as: a b
s pR H T− , where R  is  some user-defined 

measure of strength. 
6. According to CNS 6, Ringtoets will not support the decision rules for a relevance check 
7. According to [Lit 6.12], it  is assumed that a cross section passing the  level 1 assement does not consume any 

failure probability budget. 
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B. Semi-probabilistic assessment 
 

 
Figure 2.4 – Semi-probabilistic assessment per mechanism section 
 
B1. Add model input for level 2 assessment, for selected stretches  

• For revetments:  
– Import of input for each revetment zone the physical properties to be used inside 

mechanism models: (a) mean value, (b) statistical standard deviation, (c) standard 
deviation. 

• For heave/piping: 
– import or input a material library with different soil types and physical properties, if 

available.  This library contains for each property: mean value, statistical standard 
deviation, standard deviation for mechanism model(s). 

– import or input a set of possible 1D soil profiles (a stack of different soil layers) 
including a link for each layer  to the soil library. 

– For one or more characteristic lines along the flood defence (river axis, outer toe, 
levee axis, inner toe, ditch axis, polder side): attach one or more probable soil 
profiles to certain stretches along the line and define the probability of occurrence 
along the stretch. Or use imported soil profile distributions along the characteristic 
lines. 

• Optionally: export previously inputted or modified data. 
 
B2. Per mechanism: divide into sections for level 2 analysis. 

• import existing section divisions from previous assessment, when available, to 
support the decision process. 

• Overflow/wave overtopping: decide for a (modified) division into sections, based on 
the difference between crest height and characteristic water level. 

• Revetment: decide for a (modified) division into sections, based on the location and 
types of revetment layers. 

• Heave/Piping: decide for a (modified) division into sections, based on the variation in 
subsoil conditions, in geometrical properties and in hydraulic loading. 

• Check where FOS is  sufficiently large for all combined mechanisms  
 

• Characteristic values of hydraulic boundary conditions per level 2 section 
• FOS (factor of safety) value per level 2 section, per sub mechanism and per layer 
• Check if FOS is sufficiently large per level 2 section, per sub mechanism and per 

layer. If not: a probabilistic analysis is required (level 2b) 
 

Create sections and perform semi-probabilistic check (level 2a) 
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• Optionally: export previously inputted or modified section divisions. 
 
B3. Optional: Perform semi-probabilistic analysis  (level 2a) 

• Revetment 
–  Define the partial safety factors to be used for physical properties and hydraulic 

loading 
– Per section: 

∙ Define the characteristic cross section surface. 
∙ Compute the characteristic wave parameters and characteristic load durations 

at different heights along the flood defence system with Hydra-Ring. 
∙ Determine the partial factor for the influence of section length 
∙ Per revetment layer along the outer slope: 

Compute characteristic values of physical properties, using mean values and 
standard deviations from the material library. 

∙ Compute the factor of safety for failure by wave attack (damage and 
subsequent erosion), depending on the revetment type, using the prescribed 
mechanism models. 

∙ View relevant output details.  
• Uplift/Heave/Piping: 

– Define the partial safety factors to be used for physical properties and hydraulic 
loading 

– Per section 
∙ Determine the partial factor for the influence of section length. 
∙ Define the characteristic cross section surface. 
∙ Select the characteristic subsoil profiles in the cross section direction from the 

set of probable profiles and determine the associated schematization factor. 
This results in a 1D or 2D schematization in cross section direction. 

∙ Import or define the schematized hydraulic head distribution in the 
characteristic cross section aquifers as a function of the external water level, 
by an entrance point and a damping factor at the inner toe for each aquifer.  

∙ Compute characteristic values of physical properties for the mechanism 
models, using mean values and standard deviations from the material library. 

∙ Check if heave will occur at some location along the polder side. 
∙ In case of heave: compute the critical differential head, the minimum piping 

length and the  Factor of Safety, using the prescribed mechanism models. 
∙ View relevant output details. 

• Overflow/overtopping 
– Define the partial safety factors to be used 
– Per section: 

∙ Select the characteristic cross section surface (already schematized in step 
A2). 

∙ Compute and view relevant output details on that cross section. 
 
B4. Optional: Combine semi-probabilistic results from different mechanisms and sections. 

• Check at which stretches the result from semi-probabilistic analysis for any of the 
mechanisms is insufficient. Stop if semi-probabilistic checks along the total flood 
defence are sufficient for all mechanisms. 

• Optionally: export the semi-probabilistic schematization and results. 
 
See from UC 32 (page 50) to UC 36 for details on step B. 
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C. Partially probabilistic assessment (Level 2b + level 1) 
 

 
Figure 2.5 – Partially probabilistic assessment of the combination of mechanism sections 
 
 
C1. Perform probabilistic analysis, using the same section division and model input as for 
semi-probabilistic analysis 

• If required: modify default settings for probabilistic procedures. 
• Overflow/wave overtopping: 

– (Define the model uncertainties to be used and the allowed factor of safety). 
– Per section: 

∙ Re-use the characteristic cross section defined for level 2a assessment. 
∙ Define the characteristic allowable overtopping discharge, or select the model 

to compute the allowable discharge as part of the probabilistic procedure. 
∙ Compute the annual failure probability per section with Hydra-Ring. 

• Revetment 
– (Define the model uncertainties to be used and the allowed factor of safety). 
– Per section: 

∙ Re-use the characteristic cross section defined for level 2a assessment. 
∙ Compute the annual failure probability per section by wave attack (damage 

and subsequent erosion), depending on the revetment type. 
• Uplift/Heave/Piping: 

– (Define the model uncertainties to be used and the allowed factor of safety). 
– Per section 

∙ Define the characteristic cross section surface, or use a stochastically defined  
cross section geometry. 

∙ Either use a characteristic 1D or 2D subsoil profile in cross section direction 
with associated schematization factor, or use a set of probable profiles 
(scenarios) with a probability of occurrence for each possibility. 

∙ Define the schematized hydraulic head distribution in the characteristic cross 
section aquifers as a function of the external water level, by input of an 
entrance point and a damping factor at the inner toe for each aquifer.  

Probabilistic output for presentation sections  
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• FP value per mechanism and layer (either probabilistically calculated value for level 
2 sections or semi-probabilistic upper limit for level 1 sections) 
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∙ Determine the partial factors, including the influence of section length. 
∙ Compute the failure probability with Hydra-Ring, using the prescribed 

mechanism models. 
 
C2. Combine failure probability contributions from mechanisms and sections  

– Calculate the allowed failure probability of the combination of probabilistically 
assessed parts, after subtracting the failure probability budget for semi-
probabilistically assessed parts. 

– Import or define a division in presentation sections for the probabilistically 
assessed parts for combination of mechanism contributions. 

– Calculate the failure probability per presentation section and for all probabilistically 
assessed parts and view the resulting FP values for the different sections. 

– If the total FP is too large: decide if the model schematization should be refined 
with the help of additional data. 

– If the total FP is still too large: Give an indication of the presentation sections that 
need to be improved based on probabilistic assessment  (the sections with the 
largest contributions). 

– Optionally: export the probabilistic schematization and results. 
 

See from UC 38 (page 53) to UC 44 for details on step C. 
 
 
Final remarks concerning section divisions and output per assessment water level: 

1. In case of a semi-probabilistic level 2a analysis, the FOS is the basic output per 
(sub)mechanism, per layer and per section.  

2. In case of a semi-probabilistic analysis, a FOS check (OK or not OK) is the basic 
output for combined mechanisms and sections.  

3. In case of a semi-probabilistic analysis, the FP budget values per mechanism and 
section are also required as output, for combination with probabilistically assessed 
parts. 

4. In case of probabilistic analysis, the model input is assumed to be equal as for 
detailed semi-probabilistic analysis. 

5. In case of probabilistic analysis, Hydra-Ring will be capable to calculate the combined 
FP on presentation sections, taking into account the contributions from parts of 
different mechanism sections.  

6. For the purpose of combining probabilistic and semi-probabilistic parts, the possible 
locations of presentation section ‘cuts’ should be limited to the locations of 
mechanism section cuts. Or in other words: a presentation section consists of one or 
more combination sections. 
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3 Requirements 

3.1 Introduction 
 
The following sections present an overview of the general, functional and non-functional 
requirements. The functional requirements also include some rules and constraints for the 
design of the graphical user interface. One of the following importance indicators is attached 
to each of these requirements. 
 
• Must have: minimally required for basic usage. 
• Should have: additionally required for practical usage. 
• Nice to have: additionally desired to support practical usage. 
 

3.2 General requirements 
 
General requirements focus on the main functionalities of Ringtoets. The general 
requirements are system qualities that the Ringtoets program must have, to support the 
assessment methodology of dikes. Ringtoets should meet for this purpose the following 
general functional requirements (GR).  
 
GR 1 Ringtoets must comply with general requirements and preferences for the TOI project, 

as much as practically possible. These preferences are derived from [Lit 6.5]. (must 
have) 

 
GR 2 The first product version in 2016 needs to support a probabilistic and semi-

probabilistic assessment for multiple mechanisms and sections. The probabilistic 
analysis tasks will be executed by Hydra-Ring must have). 

 
GR 3 The features of Hydra-Ring and supporting tools must include the output features of 

the existing Hydra software and supporting tools, as well as all calculation and output 
features of the existing PC-Ring software, as far as required for an assessment 
according to the VTV-20178.  (must have) 

 
GR 4 The first product version in 2016 must support all final mechanism models, hydraulic 

load models and assessment procedures as prescribed by the VTV-2017 and the 
defining documents to which the VTV-2017 refers, as far as these models are part of 
the VTV-2017 software library for failure mechanisms. See Table 3.1 for a tentative 
list. (must have) 

 
GR 5 The initial evaluation version of Ringtoets (at the start of the evaluation period) must 

already offer capabilities for probabilistic production of hydraulic boundary conditions 
(water level and wave parameters), as well as a probabilistic assessment for a 
selected number of mechanisms (Table 3.1), in combination with the TMR2006 
hydraulic data set. (must have) 

 
GR 6 Multiple users should be able to work simultaneously (collect data, schematize and 

calculate) on different mechanisms, and/or on different parts of one dike ring area. 

                                                   
8. It is not required that the supported models and algorithms are equal to PC-Ring and the Hydra’s, see CNS 14 
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This requires ideally a locking mechanism, to restrict the input access for selected 
mechanisms and sections to a certain user. (should have) 

 
GR 7 The user must be able to supply model input either by importing data or by adding 

data via the graphical user interface (GUI). (must have) 
 
GR 8 Semi-automated schematization from processed key project data to model data will be 

supported where possible. (should have) 
 
GR 9 Ringtoets will supply clear and sufficient feedback to the user (e.g. progress, error and 

warning). (must have) 
 
GR 10 Ringtoets will support tabular and (limited) graphical output presentation options.  

(must have) 
 
GR 11 The User Interface, the feedback messages and the reports will have a Dutch and 

English language mode. (must have) 
 
GR 12 The full theoretical background of Hydra-Ring will be available in English language. 

(must have) 
 
GR 13 The User Manuals will be in available in Dutch language, and contain a reference part, 

a tutorial part and a summary of the theoretical background. In the theoretical part, 
references will be made to the full theoretical documentation of Hydra-Ring (in English 
language). (must have) 

 
Table 3.1: Expected support of mechanism models in Ringtoets in 2017 (depending on results from other WTI and 

SBW subprojects) 
Type of flood defence Evaluation version  Product version  

 
Dike sections - Overflow / wave overtopping 

- Heave/Piping 
- Instability of the inner slope 
- Failure of the revetment 

- Overflow / wave overtopping 
- Piping 
- Instability of the inner slope 
- Failure of the revetment 
- Instability of the outer slope 
- Micro instability* 

Dunes  - Dune erosion 
- Wind erosion* 

Hydraulic Structures - Overflow / wave overtopping 
- Piping 

- Overflow / wave overtopping 
- Piping 
- Structural failure* 
- Non closure of gates or doors* 

General  - Strength and stability of transitional 
structures* 

- Foreland instability* 
- Failure due to non water-retaining 

structures* 
- Failure of vertical walls and other structural 

elements in dike sections (i.e. sheet pile 
walls)* 

* provided the timely availability of suitable software models in the VTV-2017 failure mechanisms library 
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3.3 Functional requirements 
 
The functional requirements will elaborate the relevant general requirements from section 3.2 
to a more detailed level, in order to define what a user must be able to do with Ringtoets.  
See several use cases in chapter 4 for a more detailed specification. 

3.3.1 Data connections 
 
FR 1 Ringtoets will supply a neutral XML interface for import and export of all processed 

and schematized data in the project database, enabling third party development of 
connectors to specific formats, and also enabling connection to web services. (must 
have)  

 
FR 2 Ringtoets will have an import and export connector to GIS, via shp files and a 

configurable mapping table (or translation table) between the GIS data and the 
Ringtoets data. This mapping table will relate data items in the different shp files to the 
Ringtoets data items (must have) 

 
FR 3 Ringtoets will have an import connector to the same subsoil database as the one to 

which DAM (Dike Analysis Module) connects, via CSV files. (must have) 
 
FR 4 For import from and export to spreadsheet tables, Ringtoets will connect to CSV files 

(supported by MS-Office and others). (must  have)   
 
FR 5 Ringtoets will offer options for exporting schematized data per cross section to stand-

alone tools. (should have) 

3.3.2 Import already available flood defence key data  
 
FR 6 Import processed measurements, such as surface profile, piezometric polder heads 

etc. (must have)   
 
FR 7 Import the locations of relevant objects, such as different revetment zones, different 

characteristic lines along the flood defence, breakwaters etc. (must have)  
 
FR 8 Import existing properties of relevant flood defence objects, such as revetment 

properties,  breakwater properties etc. (must have) 
 
FR 9 Import an existing subsoil model (profile plus properties). (must have) 
 
FR 10 Import selected already existing schematization choices for different mechanisms and 

models, such as a dike section partitioning. (must have) 
 
FR 11 Validation of data integrity during import, e.g. check on missing data, consistency and  

ranges. (should have)   
 
FR 12 All imported data must be saved to the project-database. (must have) 
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3.3.3 User input or modification of flood defence data 
 
FR 13 All user input data must be saved to and retrieved from the project-database. (must 

have) 
 
FR 14 A different dike section partitioning can be made for every failure mechanism. (must 

have) 
 
FR 15 Input or modification of locations, dimensions, material properties, additional 

parameters and schematizations must be possible for all relevant mechanisms and 
models. (must have) 

 
FR 16 Give suggestions for default values where possible. (must have) 
 
FR 17 Validation of input data in user interface forms (on the fly). For example validation on 

syntax, completeness, limits and consistency. (should have) 
 
FR 18 For probabilistic assessment with the help of externally defined models (advanced 

models and perhaps also D-GeoStability/MStab), the input of fragility curves (or 
actually: the linearized limit state surface for different values of the external water 
level) has to be supported, together with the definition of the associated stochastic 
model parameters (nice to have) 

 

3.3.4 Schematization support 
 
FR 19 Graphically supported definition of the location of mechanism sections and 

presentation sections. (must have) 
 
FR 20 Start with default parameters for dike section partitioning based on generic Water 

Board methodology if available (should have).  
 
FR 21 Selection of dike sections with ‘snap’-control. (should have) 
 
FR 22 Graphically support the selection of one characteristic measure surface profile from a 

couple of measured profiles. (nice to have). 
 
FR 23 Schematize the cross section surface profile from processed geometry data, by 

graphically selecting or modifying characteristic points. (must have) 
 
FR 24 It must be possible to assign different parts of the project to different users (GR 6), 

based on a division by failure mechanism, and optionally also a division by sections or 
division by data groups as indicated in datatree. (should have) 

 
FR 25 It must be possible to undo and redo a sequence of user actions. (must have). 
 
FR 26 Modify relevant model schematization parameters (y-axis) in a space-graph, based on 

dike reference system (x-axis). (should have) 
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FR 27 Functionality to suggest and connect the nearest hydraulic boundary locations 
(hydrodynamic output locations, sometimes also referred to as “stations”) to dike 
sections and/or vice versa. (must have) 

 
FR 28 Highlight the hydrodynamic output locations linked to a cross section location when 

selecting the cross section in top view. (should have) 
 

3.3.5 Visualisation of input and schematization data 
 
FR 29 Usage of GIS-layers, with the possibility to change the layer sequence and to toggle 

layers on/off. (must have) 
 
FR 30 Option to change background layers (e.g. topology maps, satellite images). (must 

have) 
 
FR 31 Option to use Web Map Services for background layers (should have).  
 
FR 32 Show the location of the flood defence system with the attached points, the connected 

location labels (e.g. hectometrering) and the axial reference coordinate in the dike 
(GIS-) layers. (must have) 

 
FR 33 Show the different section partitions per mechanism and the additional partitioning into 

presentation section in the dike (GIS-) layers. (must have) 
 
FR 34 Show the schematized dike profile cross section per section and per mechanism. Put 

all relevant dike items in one overall dike form. Dike form items include: dike 
geometry, soil profile scenarios, construction elements, ditches, summer quays (winter 
bed), measured profile. Visual distinction between imported data and input data to 
actual calculation is necessary (must have). 

 
FR 35 Show graphs of dike properties in axial direction, using the axial coordinate as x-axis. 

(should have) 

3.3.6 Execute calculations  
 
FR 36 Define or modify settings for different calculation methods (including the selected 

probabilistic method with associated parameters). (must have) 
 
FR 37 Select output locations, cross sections, mechanism sections and presentation sections 

for the calculation of results. (must have) 
 
FR 38 Define calculation options equal to the Hydra’s and PC-Ring, such as including or 

excluding the effect of foreland. (must have) 
 
FR 39 Start one or more of the following calculation types:  

a. Characteristic9 water level at the output locations (river axis), as well as a 
table of water levels per output location for different exceeding probabilities. 
(must have) 

                                                   
9. a characteristic value is a value with an allowed exceeding probability 
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b. Characteristic water level at the toe of selected cross sections, for a 
subsequent semi-probabilistic assessment, as well as a table of water levels 
per cross section for different exceeding probabilities. (must have) 

c. Wave parameters per cross section location at different heights, for a 
subsequent semi-probabilistic revetment assessment. According to the Hydra 
software, these wave parameters need to be determined with a special 
approximated limit state function a b

s pR H T− , where R  is  some user-defined 
measure of strength. (must have) 

d. The required crest level per selected cross section to limit the characteristic 
overtopping discharge to a user-defined allowed value, as well as a table of 
different crest levels with different overtopping exceeding probabilities 
(hydraulisch belastingniveau). (must have) 

e. Assessment results and FP budget per selected mechanism and section, 
following from semi-probabilistic analysis (level 1 or level  2a), with 
mechanism dependent output details.  (must have) 

f. FP per selected mechanism and section (incl. design point data), following 
from probabilistic analysis (level 2b). (must have) 

g. Combination of results from semi-probabilistic and/or probabilistic analysis. 
(must have) 

h. Fragility curves (tables of a FOS or FP as a function of stepwise variation of  
water level and other uncertain parameters) for different mechanisms and 
sections. (should have) 

 
 
FR 40 Validate the complete input data (from import and additional input) before the 

calculation starts, resulting in a clear message of what is missing or incorrect. This 
type of validation is equal to the validation of imported data only (FR 11). A calculation 
can not start if any errors are found (must have). 

 
FR 41 For the purpose of design, enable switching from the default assessment period (e.g. 

6 or 12 years) to a longer assessment period (e.g. 50/100 year). This is achieved 
internally by switching to a pre-defined set of modified distributions for the stochastic 
variables that determine the hydraulic load. (nice to have) 

 
FR 42 For policy studies, enable the selection of a different databases for Hydraulic 

boundary conditions. (nice to have) 

3.3.7 Reporting and visualization of results 
 
The following requirements reflect the input from the Advisory Group, as recorded during the 
first meeting. See also several use cases in chapter 4. Additional mock-ups   will be prepared 
in an early development stage and presented to the Advisory Group, in order to refine the 
specifications. 
 
FR 43 In general, Ringtoets must supply output for all the calculation types mentioned in FR 

39. This comprises most of the output as given by PC-Ring, as well as all the output 
given by the Hydra’s. (must have).  

 
FR 44 Improve the report format compared to PC-Ring and Hydra output, give it a modern 

look. Use convenient defaults for configurable parameter combinations, for example 
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cluster results per water depth vs dike system (dijkring). A good example is the 4-D 
table in the PC-Ring application. (should have)  

 
FR 45 Start multiple sessions on one computer to compare different Ringtoets assessments. 

(should have) 
 
FR 46 Import results from previous sessions and compare results in combined graphs. (nice 

to have) 
 
FR 47 Present a report with the tabular output of different calculation types, see FR 39. (must 

have) 
 
FR 48 The results report format must be such that information is grouped from 

general/aggregated information to detailed information. (should have)  
 
FR 49 Add a summary table at the beginning of the report and an overview of all input 

parameters and settings. (should have) 
 
FR 50 Show graphs of the different results for different divisions in axial direction, using the 

axial coordinate as x-axis. (should have) 
 
FR 51 Present the semi-probabilistic assessment results graphically and tabular for different 

mechanism sections and combination sections. (must have) 
 
FR 52 Present the assessment results graphically and tabular for different mechanism 

sections and presentation sections. (must have) 
 
FR 53 Make the report format suitable for exporting to MS Excel. (must have) 
 
FR 54 Make the report also suitable for exporting to HTML, PDF, XLS and other formats. 

(should have) 
 
FR 55 Create a new copy of the report when specifying a new name. (must have) 
 
FR 56 If parameters are reported with quantiles, the quantiles should be accompanied with 

the corresponding parameter value. (nice to have) 
 
FR 57 Show results of individual failure mechanisms in their ‘design points’ (illustratie 

punten). Show contribution of single failure mechanism to the overall failure probability 
(including length effects). (must have) 

 

3.3.8 Export input and results 
 
FR 58 Export input and calculation settings via the GIS connector as much as possible, see 

FR 39. Hydra-Ring will not write directly into the central water board databases. (must 
have)  

 
FR 59 Export the output of different calculation types via the different connectors for GIS, 

spreadsheets and text, see FR 39.  (must have)  
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FR 60 Export all input, calculation settings and results via the neutral XML connector. (should 
have)  

 
FR 61 Link meta-data to exported data (program version, date, data description, etc.). (must 

have)  

3.3.9 Design rules for the Graphical User Interface 
 
This section presents first rules and constraints that will be adopted during the actual design 
of the graphical user interface. These rules are based on opinions from expert users of 
existing assessment tools and/or GIS tools such as PC-Ring, Hydra’s, D-GeoStability/MStab, 
PC-Vink, DAM and ARC-GIS.  
 
 
FR 62 The work-process is leading in the design and hierarchy of the content in menu bars. 

(must have) 
 
FR 63 The main-window contains a combination of a navigation pane, a Map window, 

tables/graphs and property screens. Beneath the central form there is room for a 
message box. (must have)  

 
FR 64 Let the way to use GIS functionality in Ringtoets resemble the way to use it in existing 

GIS tools. (should have) 
 
FR 65 Input of all data and display of all results should be possible via the menu. 

Additionally, data and results should be accessible via a GIS map and/or via the data 
navigation tree, wherever applicable.  (must have)  

 
FR 66 The active mechanism is to be selected for assessment one level higher than the 

active mechanism section. The selection of the active mechanism can be controlled 
via the menu-bar, separate navigation pane, extra form (docking) or tabs in the central 
form. (must have) 

 
FR 67 The navigation pane will give access to different sections and cross sections along the 

dike location line, and to the (filtered) data connected to these sections and cross 
sections. (should have) 

 
FR 68 The main menu will be unfoldable to a limited number of levels (two). (should have) 
 
FR 69 Modeless forms are preferred above modal forms. Information in modeless form is 

actively linked to selected objects in another form (e.g. maps in project canvas). A 
modal form cannot lose focus within the program and has to be closed before you can 
continue with the program. (should have) 

 
FR 70 Toolbars will be necessary. Critical aspects are overview and scalable graphics. (must 

have) 
 
FR 71 The user must have the possibility to open, dock, hide/unhide, move and resize (sub) 

forms/windows. The latest window configuration must be stored and used at the next 
session. (must have) 
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FR 72 It must be possible to work with multiple screens (e.g. by spreading the several sub-
windows over multiple screens). (must have) 

 
FR 73 The usage of tabs is encouraged as a means to order large amount of parameters in 

forms, graphs, tables and also maps. (should have) 
 
FR 74 Data can be partly imported from already available data sources, for example the 

subsoil library. When the user changes the imported data it should be made visible 
that the data has been changed (e.g. by showing the data in a different (background) 
colour). (must have) 

 

3.4 Non-functional requirements 
Non-functional requirements, also called quality requirements, describe the qualities of a 
program. A non-functional requirement (NFR) is a requirement that specifies the operation of 
a system, rather than specific behaviour or functions. Implementing the quality requirements 
will be detailed in the system architecture. The quality requirements are described in the 
following sections. 
 

3.4.1 Standards and requirements Rijkswaterstaat 
 
NFR 1 According to CNS 1, the Project Start Architecture document  [Lit 6.7] will define to 

which extend Ringtoets has to comply with the following general requirements for 
Rijkswaterstaat software10. 

 
• Usage of open standards.   

http://www.open-standaarden.nl/open-standaarden/lijsten-met-open-standaarden/ 

• Requirements for web-interfaces.  

http: //rijkshuisstijl.communicatieplein.nl/. 

•  Algemene Richtlijnen Applicaties, versie 1.0  

• overheidsarchitecturen NORA en MARIJ:  

http://www.e-overheid.nl/onderwerpen/e-overheid/architectuur/nora-familie/nora  

http://www.wikixl.nl/wiki/ictu/index.php/Inleiding 

3.4.2 Additional conventions and standards 
 
NFR 2 The regular conventions, standards, tools and libraries for Deltares Systems 

software will be used. (must have). 
 
NFR 3 Data definitions will follow existing and emerging standards such as IRIS as much as 

possible. (must have) 
 

3.4.3 Operational and accessibility requirements 
 
                                                   

10. The applicability of  these general requirements for Ringtoets is limited 

http://www.open-standaarden.nl/open-standaarden/lijsten-met-open-standaarden/
http://rijkshuisstijl.communicatieplein.nl/
http://www.e-overheid.nl/onderwerpen/e-overheid/architectuur/nora-familie/nora
http://www.wikixl.nl/wiki/ictu/index.php/Inleiding
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NFR 4 The installation program for Ringtoets must allow installation of an application with 
relevant hydrodynamic databases on individual MS Windows PC’s or on Citrix 
servers. According to Rijkswaterstaat, the preferred installation will be on Citrix 
servers, offering access by multiple users inside and outside the local area network.   
Installation on local MS-Windows PC’s needs to be possible also, for situations 
where a Citrix based installation is not (yet) feasible. (must have) 

 
NFR 5 Ringtoets must allow multi-user access to the project database, which can optionally 

be located on an external network server. A central database on a network server 
can be used for direct access during assessment by users working in a Citrix 
environment, or for the purpose of exchanging and sharing data between users 
working locally on different assessment branches. (must have) 

3.4.4 Logging and error handling 
 
NFR 6 Ringtoets and its computational core must perform sufficient error checks on the 

validity and completeness of data during import or input, as well as during a 
computation.  Ringtoets needs to show warnings and error messages in an error-
message dialog, and write them also to a log file. The message text needs to be 
clear in what went wrong and where it went wrong (context). The message finally 
needs to supply suggestions for improvement wherever possible.  (must have) 

 
NFR 7 Ringtoets must support the selection of different logging modes for the computational 

core. The logging form should show the log information of the latest computation. 
This information can help the user when a computation does not succeed or when 
the user wants to analyse the quality of the calculation results. (must have) 

 
NFR 8 Output of detailed deterministic results must enable all users to trace back the 

correctness of the implemented mechanism models. (should have) 
 
NFR 9 Output of intermediate probabilistic results, in combination with documentation of the 

theoretical background, must enable expert users to trace back the correctness of 
the probabilistic procedures. (must have) 

 

3.4.5 General Performance 
 
No formal performance requirements have been set. During the evaluation period it will be 
determined if the computational performance is satisfactory under practical circumstances. 

3.4.6 Capacity 
 
NFR 10 The maximum number of simultaneous users that view results of a single project 

database is limited to 5. (should have) 
 
NFR 11 The maximum number of users that simultaneous can edit one single project 

database is limited to 3. The users can only edit part of the project area. (should 
have) 
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3.4.7 Reliability requirements 
 

NFR 12 The user-interface may not cause crashes during regular usage. (must have) 
 
NFR 13 The computational core must be robust in the sense that: (a) input parameters or 

stochastic variation of parameters cannot upset the computations; (b) iterative 
procedures converge to the true solution; (c) output parameters are checked for valid 
ranges. (must have) 

 
NFR 14 Consistency between the input data and the output data must be guaranteed. (must 

have) 
 

3.4.8 Validation Rules 
 
NFR 15 A documented test bench of unit tests and integration tests is required, to guarantee 

that numerical results are reliable and to prove that new versions give no unintended 
differences with previous versions. The current requirement is that at least 95% of 
the code of the computational core will be covered. (should have) 

 
NFR 16  Additional evaluation and acceptance tests need to emphasize the following 

aspects: 
a. The calculated boundary conditions should be comparable to those of the Hydra 

systems, if common procedures are used.  (must have) 
b. The results should be comparable to those of PC-Ring, for the water systems and 

probabilistic procedures common to both. (should have) 
c. The results from deterministic mechanism models must be comparable to the results 

from existing VTV software for deterministic cross section analysis, as long as the 
schematization and boundary conditions are equal. (must have) 

d. The practical applicability, robustness and performance under representative 
circumstances must be proven during the evaluation period. (must have) 

3.4.9 Recoverability 
 
NFR 17 Ringtoets should have an auto-save function, enabling recovery in case of 

unexpected disruptions during a user session. (should have) 
 
Recovery of the project database by means of an external backup will be the full responsibility 
of the system administrator. 

3.4.10 System availability and support  
 
NFR 18 Version 1 of Ringtoets (software plus hydraulic databases) requires the folllowing 

support in the period from 2017 up to and including 2029. (must have) 
 

The required support includes: 
a. a download server with the most recent version of software, databases and 

documentation; 
b. updates of the software, databases and documentation whenever required; 
c. a helpdesk, available during office hours; 
d. a training program.  
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NFR 19 In case of emerging new models after 2017, the Ringtoets development version will 

be separated from the product version, by using branches in the version control 
system, in combination with version tags. 

 
The system availability for a particular user will depend on the server or local PC on which 
Ringtoets and the databases are installed.  
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4 Functional Design – Use Cases 

4.1 Introduction 
 
The use cases, presented hereafter, intent to describe all different steps in the process of 
input, schematization and assessment, based on the detailed workflow in section 2.3.2 and 
based on the requirements in chapter 3. The interaction between the user and Ringtoets will 
be defined in terms of input, forms, GUI elements and output.    
 
The use cases supply a basis for the technical design in chapter 5, and additionally define the 
required functionality, which needs to result from different implementation tasks. The 
description of the Use Cases and the technical design in chapter 5 both assume that the main 
window of Ringtoets will consist of a number of specific bars and subwindows. These 
windows and theire functions are depicted in Figure 4.1, and listed below. 
 
• Menu bar: access to all supported tasks and settings 

NL: Bestand/Bewerken/Beeld/Toetsen/Gereedschap/Help,  
EN: File/Edit/View/Assess/Tools/Help 

• Tool bar: quick access to often used tasks and settings 
• Data Filter: for filtering the presented data in  the different sub-windows, based on the 

selected data. By default, all is shown. 
o NL: Data (Kerndata, Schematisatie, Resultaten, Alles) 
o EN: Data (Key data, Schematization, Results, All) 

• Task Filter: for filtering the presented data and available options, based on the selected 
activity/task. There are tasks for the computation of hydraulic loads and for the 
assessment of dikes, structures and dunes. The hydraulic load and the assessement 
computations are further specified for different mechanisms. 
o NL: Hydraulische belastingen: Waterpeilen in uitvoerlocaties, waterpeilen in 

doorsneden, overslag debiet, overslag kruinhoogte, golfparameters. 
EN: Hydraulic loads: Water level in output locations, water level in cross section, 
overtopping discharge, overtopping crest level, wave parameters. 

o NL: Toetsen – dijken: Overslag, bekleding, stabiliteit binnenwaarts, piping. 
EN: Assessment – dike: Overtopping, revetment, stability inward, piping. 

o NL: Toetsen – constructies: Overslag, piping, stabiliteit, sterkte constructie, niet-
sluiten. 
UK: Assessment – structures: Overtopping, piping, stability structure, Structure failure, 
Nonclosing of structures 

o NL: Toetsing – duinen 
UK: Assessment – Dune erosion 

o NL: Toetsen – combinatie 
UK: Assessment – Combination 

• Assessment level: For assessment levels for tasks (NOT for Hydraulic load): 
o NL: Toetsniveau: Releventie (0), Eenvoudig (1), Gedetailleerd (2a), 

Probabilistisch(2b) 
UK: Assessment level: Relevance (0), Simple (1), Detailed (2a), Probabilistic (2b).  

• Kaart/Map window: for topview presentation of the location of objects, for focus selection 
of one or more objects, using selectable layers for viewing object groups. Standard GIS 
functions like zooming and panning are available as well. Other GIS functions, such as 
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graphically defining or modifying locations of points, lines and objects will not be 
supported, except for the graphical definition of the locations of mechanism sections.   

• Eigenschappen/Properties tabs:  
o for editing all properties of a focused object  
o for editing settings for the project and for specific models and methods. 

• Lists and Charts section 
o Object lists with Key data and Schematization data 

The different tabs containing key data and schematization data are object lists, 
allowing the selection, adding, removing of objects or the editing of certain object 
properties.  

o Charts with Results. The different tabs with Results are charts, containing a tabular 
and graphical presentation of input and results per cross section, or along the 
dikeline.  

o The Meldingen/Messages list contains warnings and errors, with associated repair 
actions.  

o The Log Uitvoer/Log Output list contains the progress information and statistics as 
produced during an assessment run  

 
 
 

                    
 
 

 
 

Figure 4.1 Components of Ringtoets User-Interface 
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Furthermore, the following concepts and rules apply to more than one case. 
 
1 Ringtoets will allow for input or modification of the location of all objects in a tabular list 

and/or property window, and present the (modified) location in a map window.  
2 Ringtoets will not support the graphical definition or modification of key data in the map 

itself, as the regular procedure will be to use a fully featured external GIS system for 
that purpose. 

3 Ringtoets will support additional graphical definition of mechanism sections in the map 
itself, as this schematization task is primary executed in Ringtoets itself.  

4 Each tabular object list and chart will have the option for import and export of CSV data, 
additional to import and output through XML on a system level. 

5 User modifications to imported data in property window and in object lists will be 
recognizable by a different presentation. 

6 Any data modification and all calculation results are first stored in the Ringtoets’ 
memory. Only when a user invokes a Save command, the data are stored in central 
project database. 

7 Each main item in the menu bar will preferably have only a single layer of sub menus. 
Sub menus will give easy access to data windows for data manipulation and to action 
forms for user invoked actions. 

8 User invoked actions such as import, export and different calculations will be started 
from action forms, giving access to single or grouped actions as well as to related 
settings.  

9 Settings for different calculation procedures and models will be accessible: (1) through a 
tabbed settings form: (2) through an easy access button on action forms. 

10 For relevant settings and parameters that can change per cross section or mechanism 
section, Ringtoets will give the option to define global defaults, and then define per 
cross section whether these defaults should be overruled. 

11 When a user changes input of certain parameters or settings, Ringtoets will 
automatically remove all already calculated results affected by this input. A subsequent 
calculation action will be limited to the (re)calculation of the missing part. 

 
 

4.2 Installation of Ringtoets  
 
Installation of Ringtoets starts with reading the installation manual and starting the program 
setup. 
 
UC 1 Install Ringtoets. The system administrator downloads the installation software and 

associated manual from the download server or uses a CD-ROM. The system 
administrator reads the installation manual. This manual provides information on the 
setup procedure, project file names, hardware and network requirements for the 
Ringtoets application.  

 
The system administrator starts the program setup of Ringtoets for installation on a 
local PC or on a Citrix server farm. The install program asks for: (a) a destination 
folder for the Ringtoets application and the selected hydraulic databases; (b) the 
selection of one or more hydraulic databases to install, from a list.  
Finally, the setup checks the operating system (incl. version), physical requirements 
(access rights, disk space etc.), copies the program modules and selected hydraulic 
databases, adds a start-up icon in ‘Windows start menu’, etc. The program will ask 
the user to place a Shortcut on the Desktop (Yes and No button). At the end of the 
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installation, the program pops up a message box with a message of a successful 
installation, and asks whether the administrator directly want to open Ringtoets (or 
not).  

 
UC 2 Configure GIS connector(s). The basic Ringtoets installation will have a default, 

configured GIS-connector. The GIS-connector is necessary for the import of key-data. 
A mapping table relates the objects in different GIS files to the data objects required 
by Ringtoets. The system administrator can make (configure) a custom mapping table 
for different GIS databases with key-data. The system administrator can create a new 
mapping table for a custom GIS connector in the installation directory of Ringtoets, or 
by installing an already pre-configured file (for example for standardized IRIS data). 
The default installed GIS-connector will link to (standardized) IRIS data.  

 
4.3 Getting started 

 
UC 3 When starting Ringtoets for the first time, Ringtoets will open with an example input, 

equal to the example described in the tutorial part of the Users manual. The main 
structure of the menu bar of Ringtoets will show the following items:  Bestand/File – 
Bewerken/Edit –Beeld/View – Toetsen/Assess – Gereedschap/Toos – Help. The user 
can access the Users manual via Help > Handleiding/Manual. The Dutch language 
manual contains, besides the tutorial part, also a reference part and a scientific part. 
The tutorial part supplies a step-by-step example description, covering the input and 
assessment process for different types of mechanisms and for different assessment 
levels. After reading this section, the user is aware of the steps to follow and the input 
data to supply. When starting Ringtoets thereafter, Ringtoets will open with the last 
opened project. 

 
4.4 Create or open a project 

 
UC 4 Optional: setup access to a project database server. In case of an intended project 

database on a remote server, the server administrator needs to grant access to the 
users which are allowed to create or modify the project database(s). A server location 
in a ‘demilitarized zone’ is required, if people from outside the local area network need 
to have direct access11.  

 
UC 5 After each start of the program, Ringtoets will check the software version plus 

hydrodynamic databases (including the output locations database) and give a warning 
if they are not available or out-of-date. An internet connection is required for this 
functionality. The user can now create a new project. In the menu bar he selects 
Bestand/File > Nieuw/New. Ringtoets opens a dialog where the user must define a 
project name and select the location of the project. After confirmation, Ringtoets will 
create and configure the project database in the designated location.  

 
UC 6 The user that has defined a new project has also to define the project settings. The 

project form, which is displayed when the user selects Gereedschap/Tools > 
Opties/Options, provides the possibility to define the project settings as defined in par 
5.6.4. 

 

                                                   
11. If the central  Ringtoets project database is not accessible outside the local area network, then it is still possible to 

share project data manually, by using the import of XML files (UC 46).  
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UC 7 Each user can open an existing project. In the menu bar, the user selects 
Bestand/File > Openen/Open… Ringtoets opens a dialog in which the user can select 
a certain project database in a local folder, on a LAN folder or on a remote server.  
Ringtoets will load the project data and show the objects in the Map window. 

 
UC 8 Intermediate save.  At any time during the session, the user can select from the 

Bestand/File menu the commands Opslaan/Save, Opslaan als / Save as. 
 

UC8.a The Opslaan/Save command will cause an intermediate save of the project 
data to the project database including all changes and calculation results. 
Untill that moment, the data changes and any calculation results are only 
stored in Ringtoets’ memory and are not part of the project database yet.  

 
UC8.b After the Opslaan als / Save As command, Ringtoets writes a full project 

database including the latest changes and calculation results under a new 
user-defined name and/or folder location.  

 
UC8.c Ringtoets will have an Auto Save function which frequently saves the changes 

and calculation results since the last normal save to a recovery file. The auto 
save function will not save to the database. If Ringtoets terminates in an 
exceptional manner, the recovery file is used restore the previous session 
after a restart. The same kind of recovery file is used when exporting latest 
changes (UC 46).  

 
4.5 Import of key data 

When starting a new project, the user will usually import key data from existing GIS based 
databases or from archived project data. Key data includes all already processed data that is 
required for assessment. Examples of key data are the dike line, the cross section surface, 
the structures in the dike system, the revetment data and the subsoil library.   
 
UC 9 In the menu bar, the user will choose Bestand/File > Importeren/Import. Ringtoets 

opens the Importeren/Import dialog, where the location, type and name(s) of the files 
can be specified.  The supported file types are: (a) XML files; (b) shp and csv files. 
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The shp files are a “snap shot” of the databases maintained with GIS by the water 
boards. The subsoil csv files are a snapshot from a MDB database, maintained with 
the DSoilModel software.  
 
According to the more detailed use cases in section 4.6, Ringtoets can import the 
following key data from one or more XML files: 

 
UC9.a Dike line (referentie lijn). 
UC9.b Characteristic lines (karakteristieke lijnen) 
UC9.c Structures (kunstwerken) 
UC9.d Breakwaters (golfbrekers) 
UC9.e Revetment (bekleding) 
UC9.f Piezometric heads and inland water levels (stijghoogtes en polderpeilen) 
UC9.g Surface lines (hoogte dwarsprofielen) 
UC9.h Subsoil data (grondprofielen + grondsoorten).  

 
UC9.i XML files allow exchange of user input or reuse of archived input. In this 

case, links to modified or deleted data objects could be broken. To prevent 
that, Ringtoets will strictly check all imported XML files on broken or non-
existing links. If a broken or non-existing link is detected, Ringtoets will give a 
warning and decline the entire import file.  

 
UC9.j If the user selects a SHP or CSV source, Ringtoets will show which files with 

their pre-configured names (UC 2) are available at the specified location. The 
import dialog will ask for names of all the required files. Ringtoets will use the 
configured mapping table to connect the data items in the different files to the 
Ringtoets data items. 

 
UC9.k A user can select a “read” or add mode for import of XML, SHP and CSV files. 

In case of the “read” mode, Ringtoets will clear all existing input tables before 
importing data from the selected source. In case of the “add” mode, Ringtoets 
will add new database tables, and give a warning when a certain table is 
already available and data will be overwritten. Ringtoets will import all 
available data in the selected source file(s).  Ringtoets will check the used 
reference system of the data source and transform it to a default geographic 
reference system. 

 
UC16.a and others will show how Ringtoets offers also import facilities via CSV files 
on a lower level, by user selection of the corresponding CSV file from within one of 
the specific object lists, input tables and property window forms. 

 
4.6 Input or modification of key data 

 
This section describes optional modifications to the imported key data, or manual input of the 
key data. Basic functions are adding, selecting, moving or viewing objects. Modifying includes 
showing of object properties, editing or input of data, adding or deleting objects, selecting 
objects, moving or copying objects.  For all uncertain input variables for strength models, 
Ringtoets will allow input of a distribution type and distribution parameters such as a mean 
value and a standard deviation, and present the design value. The latter is used in a level 2a 
analysis, and derived by using a partial safety factor. 
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UC 10 The dike line (referentie lijn) is the geometrical ‘backbone’ of the schematization per 

cross section and mechanism. The dike line is a line element consisting of (multiple 
bending) points. Ringtoets will only allow for manual input or modification of one or 
more dike lines at the initial stage, before any other input or import of key data has 
taken place. After selecting Beeld/View > Tabellen/Tables > Referentielijnen / Dike 
lines from the menu bar, the user is able to define or modify the points defining the 
dike line, via the property window. 

 
UC 11 The characteristic lines (karakteristieke lijnen) along the dike line define the 

horizontal location of characteristic points in different cross sections. Examples of 
such help lines include:  (from water side to land side): 
 
• start voorland / start foreland,  
• Intredepunt piping / entrance point piping,  
• buiten teen / outer toe,  
• start  buitenberm nr i. / start outer berm nr i,  
• einde buitenberm nr. i./ end outer berm nr i, 
• buiten kruin / outer crest,  
• binnen kruin / inner crest,  
• binnen teen / inner toe  
• start sloot / start ditch 
• einde sloot / end ditch 
etc.  The object list with characteristic lines and property window are displayed via the 
Beeld/View > Tabellen/Tables > Karakteristieke lijnen / Characteristic lines command 
from the menu bar.  
 

UC 12 Relevant structures (kunstwerken) are defined, either as a point, as a line or as an 
area, depending on the type of structure. The object list with structures and the 
property window are displayed via the Beeld/View > Tabellen/Tables > 
Kunstwerken/Structures command from the menu bar.  In the map window, different 
types of objects are marked differently (e.g. circle, diamond etc.). The user can select 
structures, add or remove structures. Part of the structure properties will be specific for 
mechanisms. 

 
UC 13 Breakwaters (golfbrekers) like caissons, dammen / rubble mounds and verticale 

wanden / vertical walls can be edited in a properties window after selection of a 
breakwater in table or map.  The object list with structures and the property window 
are displayed via the Beeld/View > Tabellen/Tables > Golfbrekers/Breakwaters 
command from the menu bar.  In the map window, different types of objects are 
marked differently (e.g. circle, diamond etc.). The user can select breakwater 
structures, add structures or remove structures and change the properties of the 
structures. 

 
UC 14 Revetment (bekleding) can consist of different zones along a cross section, each 

zone spanning multiple cross sections. Every revetment zone has its own revetment 
properties. The revetment zones locations and properties are usually imported, but 
they can also be defined or modified by the user.  

 
UC14.a The available revetment zones are listed in a Bekledingzones / Revetment 

Zones List, with the last added ones by default in front.  New zones can be 
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added to or removed from that list with the help of buttons. A user can select a 
revetment zone in that list and then edit the properties in a Properties window. 
The required properties depend on the revetment type and subtype and on 
the mechanism model. It is possible to select a Revetment Zone in the List 
and use the Copy button to make a duplicate with a new name, and initially 
the same revetment properties.  

UC14.b Revetment in the map. The user starts by selection via the menu bar 
Beeld/View > Tabellen/Tables > Bekledingszones / Revetment Zones. The 
location of the available revetment zones will be shown in the map window via 
colour lines along the dike line. The user can edit the revetment features and 
properties in the map.     

 
UC 15 For the purpose of a uplift/heave/piping assessment: Add or modify the inland 

piezometric heads (stijghoogtes) and inland water levels (polderpeilen) along the 
dike line, after selecting the Beeld/View > Tabellen/Tables >  Stijghoogtes / 
Piezometric Heads and the  Beeld/View > Tabellen/Tables >  Polderpeil / Inland water 
levels command from the menu bar. The object list will show the available sets, 
consisting of an upper and lower limit for both the piezometric heads and the inland 
water levels. Ringtoets will display already imported or inputted piezometric heads and 
inland water levels in the chart window, as a function of the dike line coordinate, in a 
graph or in a table.  The user can add, delete or modify points and values in this table.  
The graph will show the name labels of location points along the dike line at certain 
distances. The user can modify or extend the piezometric data table when required.  

 
UC 16 After selecting the Beeld/View > Tabellen/Tables >  Dwarsprofielen / Cross Sections 

Surface command, the user can add or select a cross section via a cross section 
object list or via the GIS map. The Dwarsdoorsnede / Cross Section window shows 
graphically the selected cross section surface line, including the cross section name 
and the characteristic points. For good readability the surface line diagram has a 
horizontal and vertical fixed axis and clear marks of the characteristic points. Zoom 
and panning tools are available as well.  

 
UC16.a In the Eigenschappen / Property window, the user can define (in case of 

manual input) or modify (in case of already imported key data) a surface line, 
defining the relevant part from the water side to the land side.  Instead of 
manual input of a single surface line, the window offers also the possibility to 
import the list of coordinates locally, from a CSV file. He can also add a new 
point. Ringtoets will redraw the surface line. The cross section editor’s axes 
system is LZ oriented. L is perpendicular to dike line. Ringtoets automatically 
translates the LZ-coordinates to XYZ (RD)-coordinates in the map, and vice 
versa.  

 
UC16.b In the Dwarsdoorsnede / Cross Section window, the characteristic help lines 

(UC 11) are displayed as verticals.  Ringtoets can use these lines to 
determine the associated characteristic surface points (karakteristieke 
punten) automatically. The user can graphically select one or multiple surface 
line points and move or delete them. The user can define or redefine the 
location of characteristic points manually, by dragging them to the desired 
surface points. 

 



 

 

 
 
 
 
 

 
Ringtoets Requirements and Functional Design 

 

1207804-001-DSC-0002, 16 May 2013, final 
 

42 of 127 
 

UC16.c In the Cross Section window, the initial revetment zone locations are 
projected on the surface line.  The user can adjust the initial location manually 
by dragging the revetment zone boundaries horizontally. Ringtoets will give a 
repair action if the revetment zones do not cover the whole surface from outer 
toe to outer crest.  

 
UC 17 For an uplift/heave/piping assessment: Select the Beeld/View > Tabellen/Tables > 

Grondprofielen / Soil profiles command from the menu bar, to add or modify Subsoil 
profiles (grondprofielen).  Select the Beeld/View > Tabellen/Tables > Grondsoorten / 
Soil parameters command from the menu bar, to add or modify Subsoil parameters 
(grondparameters). Editing and presentation options for the subsoil data will be 
completely equal to the options provided by the DSoilModel application.  

 
When a sub soil library has already been imported or defined, then the available 1D or 
2D soil profiles, soil types and soil type properties for piping and slope stability will be 
available as a start, together with a definition of the stretches (segments) along which 
one or more subsoil profiles are valid.  
UC17.a A user can define soil materials in the object list window and edit properties in 

both the object list window and the properties window.  
UC17.b A user can add, delete and edit the different segments along the dike in the 

Object list window. The 1D or 2D soil profiles connected to a certain segment 
are visualised in the Cross section window.  

UC17.c A user can define or change the soil profile geometry in the properties 
window. The soil profile geometry must comply with the constraints posed by 
the piping model to be used (a cluster of cover layers, combined with one 
aquifer layer.  The horizontal 2D cross section coordinate is defined relative to 
the dike location line (LZ-coordinates instead of RD-coordinates).  
 

The required soil properties for a level 1 heave/piping assessment are only the cover 
layer thicknesses and densities. The required additional soil type properties for a level 
2 heave/piping assessment may include the dimensions and physical properties of 
one or two aquifers.  
 

UC 18 Multi-user edit.  Ringtoets will have multi-user functionality. This means that multiple 
users can work simultaneously on one project, by using storage of project data in a 
central project database with multiple user access.  

 
UC18.a If a certain user has made nonsaved changes to certain key data or 

schematization data, this data will automatically be locked for editing by 
others. The lock will automatically be released after a save to the database. 
The locking of data is necessary to prevent data inconsistency. When setting 
focus to an already locked object, the user will be warned that modification is 
not possible. Another (nonpreferred) method for working simultaneously is to 
work on local databases (UC 46).  

 
UC18.b Ringtoets will automatically lock blocks of data (both key data and 

schematized data) when a user starts assessment calculations that need to 
use this data. 
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4.7 Schematization for hydraulic boundary conditions, including overtopping 
 

UC 19 Activity and Data Filtering for hydraulic boundary conditions.   
UC19.a Selecting Toetsen/Assess > Taak/Task > Hydraulische belastingen / 

Hydraulic load or using the equivalent activity filter option, optionally followed 
by selecting  Toon Data > Schematisatie / Show Data > Schematization, will 
limit the visible data and options to those required/available for schematization 
of Hydraulic boundary conditions. 

UC19.b Ringtoets will show in the messages window (and/or the tentative workflow 
window) which schematization actions the user needs to perform before a run 
can start.  

 
UC 20 Linking cross sections to output locations.  

UC20.a Selecting Beeld/View > Tabellen/Tables > Dwarsdoorsneden / Cross sections 
will activate the object list with cross sections. After selecting the Auto-verbind 
uitvoer locaties / Auto-link output locations option for one or more cross 
sections, Ringtoets will automatically connect these cross sections to the 
nearest output location, with search paths restricted to the waterside. The 
resulting links will be visible in the table, as well as in the map window.  If the 
distance to the nearest output location exceeds a certain threshold, Ringtoets 
will give a warning and not link that cross section.  

UC20.b The thresholds can be altered by the user in a settings tab. 
UC20.c Ringtoets will automatically repeat the automated linking for a selected cross 

section when the location of that cross section changes. 
UC20.d The user can manually establish or modify links in the list, by first unselecting 

the Auto-Link selection for a cross section and then selecting one or two 
output location id’s from a list. In case of a connection to two output locations, 
the user has to specify the relative contribution of the second location. The 
user can also remove links. 

 
UC 21 Linking cross sections to breakwaters   
Selecting Beeld/View > Tabellen/Tables > Dwarsdoorsneden / Cross sections will activate the 
object list with cross sections. The user can manually establish or modify a link between a 
cross section and a breakwater in the list, by selecting a breakwater location id from a list. 
The user can also remove links. The resulting links will be visible in the map window. 
 
UC 22 All hydrodynamic databases in 2017 are expected to contain directly the wave 

parameters that are required for a revetment and overflow/overtopping assessment. 
The databases of most regions in 2006 and 2011 however, do not yet supply these 
wave parameters. Therefore, Ringtoets has to support temporary the import and/or 
input of fetch area (strijkvak) parameters for selected output locations, for the wave 
generation model according to Bretschneider.  
UC22.a Selecting an output location will give access to the Strijkvakken / Fetch areas 

tab in the Properties window.   In this window, the user defines a bodem 
ligging / bottom location and a strijklengte / fetch length for different wind 
directions. The number of shown wind directions is therefore 12 or 16, 
depending on the hydraulic load region in which the connected output point is 
located. 

UC22.b Ringtoets displays the inputted fetch areas for all wind directions and output 
locations in the map window. 
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UC 23 View or input other Hydraulic Load parameters and settings. 
UC23.a Selecting the command Toetsen/Assess > Instellingen/Settings will give 

access to a Instellingen / Settings tab in the Properties window, to view the 
following non-editable Hydraulic Load settings.: 

X Omschrijving Een-
heid 

Type Parameters Ruimtelijke  
spreiding 

Variatie in  
de tijd 

    ligging spreiding dx ρx ∆t ρt 

∆d fout in bodemligging m nor 0,0 m σ = 0,30 m 900 m 0 1 jaar 0,5 

mgH modelfactor 
Bretschneider voor Hs 

- log 1,0 σ = 0,15 900 m 0,7 - 1 

mgT modelfactor 
Bretschneider voor Ts 

- log 1,0 σ = 0,15 900 m 0,7 - 1 

∆hloc fout in lokale 
waterstand 

m nor 0,0 σ = 0,15 6000 
m 

0,5 - 1 

β* afwijking golfrichting o nor 0,0 σ = 20o vak 0 1 jaar 0,5 

ts stormduur uur log 7,5 V = 0,25 - 1 12 uur 0 

P1 Model factor overslag, 
golfoploop 1 

- Det 1,75      

P2 Model factor overslag, 
golfoploop 2 

- det 4,3      

P3 Model factor overslag, 
golfoploop 3 

- det 1,6      

P4 Model factor overslag 
voor brekende golven.  

- det 4,3      

P5 Model factor overslag 
voor niet-brekende 
golven.  

- det 2,3      

P6 Model factor overslag 
voor ondiepe golven. 

- det 0,21      

The stochastic properties are the following: 
(1) verdelingstype/ distribution type (deterministisch/deterministic or 

normal/normal or lognormal/lognormal);  
(2) verwachtingswaarde / mean value 
(3) standaardafwijking / standard deviation or variatie coefficient / variation 

coeffient;  
(4) correlatie lengte / correlation length;  
(5) ruimtelijke restcorrelatie / spatial correlation coefficient rho_x;  
(6) correlatieperiode / correlation period 
(7) restcorrelatie voor de tijd / temporatal correlation coefficient rho_t. 

 
Contrary to PC-Ring, Ringtoets will not give the option for input of auxiliary user-defined 
Hydraulic Load parameters, in case these parameters are not part of the hydraulic boundary 
conditions database. These auxiliary parameters are specifically: a golfhoogte / wave height 
and golfperiode / wave period per wind direction for deining/swell and a combined water level 
opzet/setup for the effect of  seiches/squall.. 
 
 
UC 24 For the purpose of an overflow/overtopping/revetment assessment per cross 

section: Select the cross section in the Navigator window. The Overslag 
Profiel/Overtopping Profile tab in the Properties window will give the possibility to 
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define a schematized surface line for the selected cross section12. Ringtoets will 
display in the cross section window the selected cross section surface (UC16.a) with 
characteristic points and revetment zone locations (UC16.c).  
UC24.a The automated schematization proposal by Ringtoets is already invoked for 

all applicable cross sections when a user selects the Toets/Assess > 
Taak/Task > Hydraulische belasting / Hydraulic load option. A cross section is 
applicable for automated schematization if no schematized overtopping 
surface is available yet. Ringtoets uses characteristic points and revetment 
boundaries for this automated schematization. The user views the results of 
this proposal in the table.  

UC24.b The user views the schematized profile also in the cross section window.  
UC24.c The user views the repair actions in the messages window for the selected 

cross section when automatized schematization is not possible.  A repair 
action is required when the constraints to the geometry for foreland and dike 
are not met.. 
• The schematized profile must comply with the overflow/overtopping 

model constraints for a deterministic geometry definition according to 
the Hydra software (see section 5.7).  

• Ringtoets will check if the schematized surface contains a foreland, by 
using the characteristic points defining the foreland start and end.  
Ringtoets will check if the schematization of the foreland complies to the 
foreland model constraints (e.g. slopes steeper than 1 to 10 are not 
allowed, etc. (section 5.7)) and give a message if not. 

UC24.d The user inputs or modifies the coordinates and roughness’s of the segments 
of the surface line in the list, wherever required. 

 
 
 

4.8 Calculate hydraulic boundary conditions and overtopping per cross section 
 
The probabilistic calculation of the hydraulic boundary conditions per cross section is required 
for a subsequent (semi-probabilistic) level 1 or level 2a assessment. Calculation of these 
conditions at the schematized cross sections (task A2) is possible after linking cross section 
locations to output locations for hydraulic boundary conditions and after schematization of 
linked breakwaters, foreland and fetch areas.   
 
UC 25 Ringtoets can calculate and/or display the water level with a certain exceeding 

probability, at both the output locations (river axis) and at the toe of selected cross 
section locations.  
UC25.a In the menu bar, the user selects Toetsen/Assess > Taak/Assessment > 

Hydraulische belasting/Hydraulic boundary conditions. With Toetsen/Assess > 
Instellingen/Settings the Rekeninstellingen/Calculation settings tab opens in 
the properties window. In the Toetspeilberekening/Water level computation 
section of this tab it is possible to select whether the influence of foreland and 
relevant hydraulic parameters should be included during a calculation at the 
toe (Voorland meenemen/Include foreland).  

UC25.b Cross section selection for calculation of the water level is possible via the 
navigation window. By default, none of the cross sections are selected. 

                                                   
12. Compared to PC-Ring, Ringtoets will not support the input of a stochastically defined surface geometry 
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UC25.c After Toetsen/Assess > Start/Start, Ringtoets will calculate the water levels at 
the selected output locations and the selected cross sections with linked 
output locations. Ringtoets will interpolate the calculated water levels along 
the dike line, in order to find values for the other cross sections. This enables 
a subsequent level 1 assessment at these cross sections without the need to 
compute the hydraulic boundaries for each cross section. Start is only 
enabled, if not all required results are available already. 

UC25.d During the calculation, a progress indicator will display the progress, while 
warnings, log messages and error messages will be written to the 
Meldingen/Messages table. 

UC25.e The calculation results are initially only stored in the Ringtoets’ memory. Only 
after a user invoked Save command the calculation results are saved to the 
project database.  

 
After the calculation has finished, the following results will be available as chart tabs: 
UC25.f The resulting graph along the dike reference line displays the distribution of 

the calculated characteristic water level (toetspeil) at the output locations 
(river axis) and at the toe of all cross sections (if available), as well as the 
value of the water level with an exceeding probability which is ten times 
higher. The names of different cross sections are added to the x-axis of the 
graph, at certain distances.  

UC25.g For a selected cross section or output location, Ringtoets will also present a 
table or graph of the water level (including the characteristic water level) as a 
function of exceeding frequency.  Location selection will be possible via the 
map, or from a list. Output should also include the value of the difference 
between the characteristic water level (toetspeil) and the water level at a ten 
times higher exceeding frequency (decimeringshoogte). 

 
For all water levels with different exceeding probabilities at different locations, 
RIngtoets will offer also the associated reliability index and design point value(s) as 
output.  Each design point is defined by the values of the stochastic variables in the 
design point, optionally per wind direction.  
 

UC 26 Ringtoets can calculate and/or display the wave parameters for a revetment 
assessment at the toe, for different water levels along the slope, and for different wind 
directions.  
UC26.a In the menu bar, the user selects Toetsen/Assess > Taak/Assessment > 

Hydraulische Belasting/Hydraulic Boundary Conditions. With Toetsen/Assess 
> Instellingen/Settings the Rekeninstellingen/Calculation settings tab opens in 
the properties window. The Golfparameters/Wave parameters section of the 
form will give the possibility to set whether the influence of foreland or 
breakwaters should be included, as well as the influence of different hydraulic 
parameters.  Ringtoets will calculate the wave parameters from the design 
point of a dedicated revetment strength limit state function, similar to the 
Hydra software, see also FR 39c. 

UC26.b Cross section selection for calculation of the wave parameters is possible via 
the navigation window. By default, none of the cross sections are selected. 

UC26.c After Toetsen/Assess > Start/Start, Ringtoets will calculate the wave 
parameters for different water levels at cross sections with linked output 
locations. Ringtoets will interpolate the calculated wave parameters along the 
dike line, in order to find values for the other cross sections. This enables a 
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subsequent level 1 assessment at these cross sections for different failure 
mechanisms, without the need to compute the wave parameters for each 
cross section. Selecting Start will only be possible, if not all required results 
are available already. 

UC26.d During the calculation, a progress indicator will display the progress, while 
warnings, log messages and error messages will be written to the 
Meldingen/Messages table. 

UC26.e The calculation results are initially only stored in the Ringtoets’ memory. Only 
after a user invoked Save command the calculation results are saved to the 
project database.  

 
After the calculation has finished, the following results will be available as chart tabs: 
UC26.f For a selected cross section or output location, Ringtoets will present a table 

or graph for each characteristic wave parameter (wave period, wave height) at 
the toe as a function of the water level, for different wind directions. Cross 
section location selection will be possible via the map, or from a list. For each 
level in the table, Ringtoets will also present the design point (illustratiepunt) 
of the stochastic variables, optionally per wind direction. Ringtoets will 
additionally give the associated wave parameters at the toe and at the start of 
a foreland and/or a breakwater, when applicable. 

 
For all calculated wave parameters with different exceeding probabilities at different locations, 
Ringtoets will offer also the associated design point value(s) as output.  This means the 
values of the stochastic variables, optionally per wind direction.  
 
 
UC 27 Ringtoets can calculate and/or display overtopping results per schematized cross 

section.  
UC27.a In the menu bar, the user selects Toetsen/Assess > Taak/Assessment, and 

Toetsen/Assess > Spoor/Mechanism > Overslag/Overtopping. To open the 
overtopping calculation settings select Toetsen/Assess > Instellingen/Settings 
and the Overslag/Overtopping window opens in the property window. In this 
form it is possibility to select whether the influence of foreland or breakwaters 
should be included, as well as the influence of different hydraulic parameters. 

UC27.b Cross section selection for calculation of overtopping discharges is possible 
via the navigation window. By default, none of the cross sections are selected. 

UC27.c After Toetsen/Assess > Start/Start, Ringtoets will start the overtopping 
calculation. Ringtoets will calculate the overtopping discharges at cross 
sections with linked output locations and with schematized cross section 
surface. Ringtoets will interpolate the calculated results along the dike line, in 
order to find values for the other cross sections. Clicking the Selecting Start 
will only be possible, if not all required results are available already. 

UC27.d During calculation of missing results, a progress indicator will display the 
progress, while warnings, log messages and error messages will be written to 
the Meldingen/Messages table. 

UC27.e The calculation results are initially only stored in the Ringtoets’ memory. Only 
after a user invoked Save command the calculation results are saved to the 
project database.  

 
After the calculation has finished, the following results will be available as chart tabs: 
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UC27.f At a selected cross section: a table or graph of different crest levels with 
associataed different probabilities of exceeding a user-selected critical 
overtopping discharge (default equal to 1 m^2/sec). This chart is called: 
hydraulisch belastingniveau.  

UC27.g Along the dike reference line: a table or graph of the actual crest level and the 
required crest levels (the levels where a user-defined critical overtopping 
discharge is equal to different user defined exceeding probabilities). 

UC27.h Along the dike reference line: the characteristic overtopping discharge with a 
specified exceeding frequency, calculated at the actual crest level.  

 
For all calculated values of height or discharge with different exceeding probabilities at 
different locations, Ringtoets will offer also the associated design point value(s) as output.  
This means the values of the stochastic variables, optionally per wind direction. Ringtoets will 
additionally give the associated wave parameters at the toe, including the amount of 
reduction caused by breakwaters and/or foreland. 
 

4.9 Schematization for level 1 assessment of height and stability 
 
This section describes the definition or modification of the additional data required for a  
level 1 assessment of the different stability mechanisms per cross section. A level 1 
assessment uses geometry based decision rules to decide if a more detailed assessment is 
required or not. Modifying includes showing of object properties, editing or input of data, 
adding or deleting objects, selecting objects, moving or copying objects.   
 
UC 28 Selecting the task filter Level 1 in combination with selecting the task filter for the 

appropriate mechanism will limit the required input and options for all mechanisms to 
the required assessment level.  

 
UC 29 For the purpose of a level 1 or level 2 uplift/heave/piping assessment, different 

schematizations are possible, depending on the available data. 
 
UC29.a Selecting the Toetsen/Assess > Piping Dijken / Piping Dikes command from 

the menu bar will show the relevant tables and options for Piping.  For a 
selected cross section, Ringtoets will display the selected surface (UC16.a) in 
the cross section window, together with the connected sub soil profile(s) (UC 
17), the polder level and the ‘inland piezometric head’. If the number of 
connected soil profiles is larger than 1, then a probability of occurrence for 
each scenario must be available.  
 

UC29.b The initial location of the piping entrance point in the cross section follows 
from a characteristic line (UC 11), and can be modified by the user. If no 
characteristic line is available, then Ringtoets will assume that the entrance 
point is located in the outer toe. 
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UC29.c If no subsoil data is available, then Ringtoets will use as a conservative 

assumption that the exit point is located at the inner toe, and that uplift and 
heave will occur.  
 

UC29.d If subsoil data is available for the considered cross section, then Ringtoets will 
use a procedure similar to the DAM software to check if uplift and heave can 
occur, assuming that a damping factor of zero and an infinite leakage length. 
In this conservative case, the required minimum factor of safety for uplift is 1. 
Ringtoets will use a minimally required FoS and the weight and thickness of 
the cover layers to check if uplift can occur [Lit 6.14], [Lit 6.15]. If the answer 
is true, Ringtoets will also determine the location of the exit point en check if 
heave at that location can occur. 

 
UC29.e Ringtoets will graphically display in the cross section window the resulting 

distribution of pore pressures and cover layer weight  from the inner toe to the 
polder side, together with an indication of the exit point (the first location 
where the FoS for both uplift and heave are smaller than the minimally 
values). 

 
UC 30 Export/import project data for a level1 assessment. For the purpose of data 

exchange, the user can export  the project data for a level 1 assessment  via the File > 
Export command. Another user can import this data via the File > Import command, in 
order to create an exact project database copy. 

 
 

4.10 Execute level 1 assessment for height and stability 
 
When the input for level 1 is completed and when the hydraulic boundary conditions and 
overtopping results are calculated per cross section, the user can start the level 1 
assessment procedure on cross section level.  
 
 
UC 31 Perform a level 1 assessment (task A3/A4).  

UC31.a In the menu bar, the user selects the mechanism (toetsspoor) and the 
assessment level 1 (eenvoudig).  

UC31.b Cross section selection is possible via the navigation window. By default, all 
valid cross sections are selected. 

UC31.c The user inspects the input data and applies modifications when required.  
UC31.d After clicking the Run button, Ringtoets will execute a level 1 assessment per 

selected mechanism and cross section, based on geometric dike 
characteristics. Clicking the Run button will only be possible, if not all required 
results are available already. 

UC31.e During assessment, a progress indicator will display the progress, while 
warnings, log messages and error messages are written to different tabs of 
the messages window. 

UC31.f The assessment results are initially only stored in the Ringtoets’ memory. 
Only after a user invoked Save command the calculation results are saved to 
the project database.  

 
The following results will be available after the assessment calculation is completed. 
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UC31.g The available results for all assessed mechanisms are displayed in the map 
window for all cross sections along the dike ring.  The user can change the 
selected mechanism via a drop down box. Each cross section will show per 
selected mechanism an indicator of the required assessment level (0, 1 or 2), 
see Figure 2.3.  If overtopping results per cross section are available, the map 
view will also show indicate at which cross section the crest height of the 
cross section is sufficient. 

UC31.h The available results are also presented in a chart tab. The table displays in 
the columns the cross section ID (name), the ring coordinate, and the required 
assessment level (0, 1, 2) per different stability mechanism. The table will also 
indicate in a number columns if the crest height of the cross section is 
sufficient with regard to different values of the overtopping criterion. 

 
4.11  Additional schematization for level 2 assessment 

 
The result of the level 1 assessment is per mechanism a dike line divided in stretches where 
the mechanism is irrelevant (0), where simple assessment is sufficient (1) or where a detailed 
assessment level (2) is required. The stretches marked with 2 are input for the detailed level 2 
assessment, as described in this section. Input of additional soil and revetment properties for 
a detailed level 2 analysis will be analogous to UC 14 and UC 17. 
 
UC 32 Selecting the assessment task Level 2a in combination with selection of the 

appropriate mechanism will limit the required input and options for the selected 
mechanism to the required assessment level.  
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UC 33 Specify user-defined parameters to calculate a piezometric distribution in the aquifer 
for the purpose of a piping assessment.   

 
UC33.a Selecting the Toetsen/Assess > Piping Dijken / Piping Dikes command from 

the menu bar will show the relevant tables and options for Piping.  For a 
selected cross section, Ringtoets will display the selected surface (UC16.a) in 
the cross section window, together with the connected sub soil profile(s) (UC 
17), the polder level and the ‘inland piezometric head’. If the number of 
connected soil profiles is larger than 1, then a probability of occurrence for 
each scenario must be available.  

UC33.b The initial location of the piping entrance point in the cross section follows 
from a characteristic line (UC 11), and can be modified by the user.  

UC33.c Ringtoets will use a procedure similar to the DAM software to define the 
location of the exit point and the piezometric head distribution in the aquifer 
for each subsoil scenario, with the help of a damping factor, a leakage length, 
a minimally required FoS and the weight of the cover layers  [Lit 6.14], [Lit 
6.15]. The default damping factor is 0.3, the default leakage length is infinite 
and the default minimum Fos for uplift is 1.2.   

UC33.d Ringtoets will graphically display in the cross section window the resulting 
distribution of  piezometric head and cover layer weight for uplift from the 
inner toe to the polder side, together with an indication of the exit point (the 
first location where the FoS for both uplift and heave are smaller than the 
minimally value. 

UC33.e If no subsoil profile are available, then  Ringtoets will assume that the location 
of the exit point is at the  

UC33.f If there is an uplift location found and if the heave criterion at that location is 
also exceeded, then Ringtoets will perform a simple piping check, 

 
              
UC 34 Define mechanism sections and link to a characteristic cross section. The dike 

line and the location of the cross sections is the same for all mechanism 
schematizations. However, the dike section division and the cross section 
configuration can be different for each failure mechanism. A dike section is defined by 
the ring coordinate of the begin and end of the section, implicitly encapsulating a 
group of one or more adjacent cross sections.  

 
UC34.a The user select from the menu bar: Schematize > Mechanism Sections. The 

map window and list tab shows the required assessment level indicators per 
cross section, for the (via the data filter) selected mechanism (0, 1 or 2). The 
screen shows also the imported section divisions, when available. 

UC34.b When a user wants to define a separate mechanism section for each cross 
section (implying that the mechanism section division is equal for all 
mechanisms), then Ringtoets must give the possibility to generate such a 
division via the action form. 

UC34.c  If there is no mechanism section per cross section generated, the user can 
select and mark groups of adjacent cross sections as level 1 and level 2 
sections, either graphically in the map window or in a list tab for mechanism 
sections  (the latter by entering a ring coordinate for the start and end point. 
For a decision on the required division, the user can use the previously 
calculated indication of the required assessment level per cross section, as 
well as an analysis of the spatial variability of boundary conditions, physical 
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properties and geometrical properties. During this process, a user can deviate 
from the cross section indication, when he or she feels that this is allowed 
under the specific circumstances.  

UC34.d After the cross section group selection or generation of mechanism sections, 
the user can modify the initial ring coordinate of each section boundary 
manually. Ringtoets will give a warning if the mechanism section length 
becomes small, compared to the mechanism length. 

UC34.e When mechanism sections divisions are equal for two or more mechanisms, a 
user must have the option to copy a mechanism section list for one 
mechanism to a mechanism section list for one or more other mechanisms. 

UC34.f The user links each mechanism section to a schematized characteristic cross 
section, either in the map window or in the mechanism section list tab. This 
applies to overtopping/overflow/revetment (see UC 24) as well as to 
heave/piping (see UC 29). 

 
UC 35 Inspect the default partial safety factors. The View > Defaults menu gives access 

to a tabbed form, containing amongst others an overview table of the partial factors for 
the relevant strength and load parameters, in relation to the models for the 
selected/locked mechanism(s).  

 
4.12 Execute level 2a assessment 

 
Level 2a (task B3) is a detailed semi-probabilistic assessment. This assessment is per 
mechanism and per mechanism section. The mechanisms include all relevant stability 
mechanisms, in combination with preceding overtopping when relevant. 
 
UC 36 Perform level 2a assessment and inspect results.  
 

UC36.a In the menu bar, the user selects Toetsen/Asses > Deterministisch (2a) / 
Level 2a, after preceeding selection of the mechanism group (toetsspoor). 
Ringtoets will display a form to input the data relevant to the selected 
mechanism group.  

UC36.b Mechanism section selection is possible via the navigation window. By 
default, all valid mechanism sections are selected. 

UC36.c After clicking the Execute button, Ringtoets will execute a level 2a 
assessment for the selected mechanisms and sections. Clicking the Execute 
button will only be possible, if not all input and assessment levels are 
available already. 

UC36.d During assessment, a progress indicator will display the progress, while 
warnings, log messages and error messages are written to different tabs of 
the messages window. 

UC36.e The assement results are initially only stored in the Ringtoets’ memory. Only 
after a user invoked Save command the calculation results are saved to the 
project database.  

 
The primary output of the computation is a FOS (factor of safety) or another 
mechanism dependent safety indicator for all available mechanism sections. The 
following results will be available after the assessment calculation is completed.  
UC36.f The map window will show the FOS in all calculated sections for the selected 

mechanism.  The user can change the selected mechanism.  
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UC36.g Tables or graphs of the FOS for one or more selected mechanisms along the 
dike line will be given also. 

 
Ringtoets will display the combined results of different mechanisms on so-called 
combination sections, after selection of the combination from the mechanism list. 
UC36.h The map window will give an overview of the combination sections where the 

FOS is sufficiently large for a level 2a assessment.  
UC36.i A list tab of the combination sections will give the same results.  
 
Mechanism specific detailed output per mechanism section will be available also, as 
far as required for tracing back the reliability of the computed FOS. The specific output 
is mechanism dependent.  
UC36.j An example for piping is a graph along the dike line of the minimally required 

piping length versus the actual piping length. 
UC36.k Another example for uplift/heave/piping is a graph of the actual characteristic 

water level (toetspeil) versus the allowed external head. 
 
 

 
 

4.13 Additional schematization for level 2b assessment 
 
Level 2 dike sections that do not pass a level 2a assessment are automatically input for the 
level 2b assessment (fully probabilistic check). For level 2b additional information per 
mechanism is required.    
 
UC 37 Selecting the data filter Level 2b in combination with selection the data filter for the 

appropriate mechanism will limit the required input and options for all mechanisms to 
the required assessment level.  

 
UC 38 Optional stochastic subsoil model for piping. The user can re-use the 

characteristic sub soil model (sub soil layers and materials) from level 2a, or switch to 
a stochastically defined subsoil model. For the latter purpose, the user can select the 
Schematize > Piping command, and check the “Use sub soil scenarios” check box in 
the properties window.  The dike stretches along which a certain set of probable 
subsoil profiles (scenarios) is valid, as well as the probabilities of the different 
scenarios along that stretch, can be defined manually by the user in the list or 
properties tab, or the required information can be directly imported from an external 
database which also contains the subsoil library. Ringtoets will automatically connect 
the subsoil scenarios along a stretch to the sections in that stretch, and give a warning 
if a single section is part of two or more subsoil stretches. 

  
UC 39 Define presentation sections. A presentation section is a part of the dike line used to 

calculate the combined failure probability for all selected mechanisms. The user 
activates the Presentation Sections form, via a menu bar command. An initial GIS 
screen or table shows the combination sections resulting from a level 2a analysis, with 
FoS indication. Initially, Ringtoets will use every combination section as a presentation 
section. The user can join two or more combination sections to one presentation 
section via GIS or via a table.  

 



 

 

 
 
 
 
 

 
Ringtoets Requirements and Functional Design 

 

1207804-001-DSC-0002, 16 May 2013, final 
 

54 of 127 
 

UC 40 Inspect and modify the default autocorrelation parameters in space and time. 
The View > Defaults menu gives access to an overview of the different autocorrelation 
factors in space and time for the relevant strength and load parameters, in relation to 
the selected/locked mechanism(s).  A user can modify one or more of these 
parameters when required13.  

 
UC 41 Export/Import project data for a level2 assessment. In order to share project data, 

one user can export the mechanism specific project data for the locked mechanism, 
and another user can import this data in a central database and then execute a 
level2a and level2b assessment. 

 
 

4.14 Execute level 2b assessment 
 
Perform assessment level 2b (task C1). Level 2b is a detailed probabilistic assessment. This 
assessment is per level 2 mechanism section and also for combined mechanisms and 
mechanism sections, on so-called presentation sections.  
 
UC 42 Perform level 2b assessment. In the menu bar the user chooses Assess > Level 2b. 

A Level 2b form will open.   
UC42.a After clicking the Select button, the form offers the possibility to select one or 

more available mechanisms and to select one or more available mechanism 
sections for either level 2a or level 2b assessment. The selected mechanisms 
are marked with a check symbol (√).  

UC42.b After clicking the Settings button, the user can change the default settings for 
various calculation options, including the probabilistic method (including start 
method) and the calculation scheme.  Additionally, the user can overrule the 
default settings per mechanisms section, when desired. 

UC42.c After clicking the Calculate Mechanisms button, Ringtoets will calculate the 
separate failure probabilities contributions and the associated design points 
per mechanism section, for all selected mechanisms and mechanism 
sections, based on input for the detailed mechanism models.  

UC42.d After clicking the Combine Mechanisms button, Ringtoets will calculate the 
combined failure probability and design point for all each of the selected 
presentation sections, using all available contributions from selected 
mechanisms and mechanism sections. 

UC42.e During calculation, Ringtoets will present progress and log information via a 
progress window. Ringtoets will also write the log information to a log file 
which can be inspected at any time via the Show Log button from the Level 2b 
form. 

 
UC 43 The user can inspect the results per mechanism section from the last executed 

level 2b assessment via the menu bar command Assess > Level 2b. The results for a 
selected mechanism are displayed for all selected mechanism sections. The user can 
change the selected mechanism via a drop down box. Toggling between a GIS view 
and a tabular presentation is possible. The Map window will show the dike line and the 
location of the dike sections and characteristic cross section.  
UC43.a The primary output of the computation is a failure probability and a design 

point (values of stochastic variables) for all available mechanism sections.  

                                                   
13. It is still under discussion whehter the user should be able to change those values. 
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UC43.b Secondary output is the failure probability per failure mechanism.  
UC43.c The log file contains additional intermediate results. These results include the 

different reliability indices and design points per wind direction, per revetment 
layer, per subsoil alternative, per cross section etc. 

UC43.d Conditional failure probabilities for design parameters. For example, what is 
the remainig failure probability if the water level has a reached a certain level 
(optional Ringtoets functionality). 

 
UC 44 The user can inspect the results per presentation section from the last executed 

level 2b assessment via a menu bar command.   
• Ringtoets will display the combined results of different mechanisms on 

presentation sections, after selection of the combined option from the 
mechanism list. Toggling between a GIS view and a tabular presentation 
is possible. The combined result is a probability of failure (or reliability 
index) with a design point for each presentation section, as well as a total 
failure probability (or reliability index) for all available presentation 
sections.  

• The output will also show the failure probability budget for stretches that 
are assessed at level 1 or level 2a, and the remaining budget that is 
available for the combined level 2b presentation sections. 

 
4.15 Report and Export input and/or results 

 
 

UC 45 Report intput and results 
 

UC45.a After selection the menu bar command View > Report. A dockable report 
window will appear. This report will first give an overview of the most 
important input data and results, (it has to be decided which data this is) 
followed by tables with complete results for cross sections, mechanism 
sections, combination sections and presentation sections. 

UC45.b The report can be written to different formats, including pdf and docx. 
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UC 46 Export. Via the menu bar command File > Export, the user starts the Export form. In 

this form, the user selects first an export destination (SHP, XML, CSV) and then 
chooses whether input, output or both need to be exported. This functionality is of use 
if project data is exchanged with users outside the organization (UC 1). Exporting and 
importing the latest changes is useful when working offline or parallel to a project. The 
latest changes are all data changes since the last Save of data to the central project 
database. When working offline, a user first makes a complete copy of the (online) 
project database and starts working on it in an offline environment. When he is 
finished, he exports the latest changes to the (original) online project database.  
When working parallel, a user makes a complete copy of the (online) project database 
and at the same time exports the latest (unsaved) changes. He then opens the copy of 
the project database and imports the latest changes. He now can work parallel 
(offline) to the original project. He can modify and change the model until he is 
satisfied with the calculation results. To use the changes het exports the latest 
changes from his offline copy and imports the changes to the online project database . 
The project manager must manage the data and file exchange to be sure that for 
example data is imported from the correct external user with the correct adjustments. 
Ringtoets can not see if a data file is the correct version or an older one.  

• Export of input to an editable XML file enables archiving of input, as well 
as exchange of input data between different users.  

• Export of input and results to XML facilitates also connection to external 
software, such as a potential dedicated report module for a presentation 
assessment schematization and results. 

• Export of latest changes to XML files (changes made since last Save to 
project database). See also Import of Key data (section 4.5). 

• Export of input and/or output tables to CSV files facilitates coupling to 
spreadsheet software. 

• Export to SHP files facilitates update of key data in the waterboard GIS 
database, as well as storage of final assessment results. 

• Tentative: Export the deterministic schematizations per cross section to 
stand-alone tools such as Steentoets, D-GeoStability, PC-Overslag etc. 
This facilitates examination of output details with the stand-alone tools, as 
well as usage of the schematizations for further analysis and design.14 

 
4.16 Strip results from database and close the project  

 
UC 47 When choosing File > Clear results, Ringtoets will remove the results from the 

database, after a final user confirmation. This is to be sure that storage of new and old 
results in one database is prevented. 

 
UC 48 Intermediate saving of input is already described in UC 8. The user will finally invoke a 

Close form, directly or indirectly, before Ringtoets will actually exit. 
• When choosing File > Close without intermediate save, the user can 

choose to a) save and accept the changes, b) go back to project 
database after last save and discard changes. Both actions require a final 
user confirmation.  

When choosing File > Exit, Ringtoets will first switch to the Close form if unsaved changes 
exist. 

                                                   
14. This feature will only  be available for  the new generation of stand-alone tools based on the Delta-Shell Light library  
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5 Technical Design  

5.1 Introduction 
 
This chapter describes the technical design of Ringtoets, based on the functional 
design as described in the previous chapter. The intended reader for this chapter is 
the programmer of Ringtoets. The two purposes of this chapter are: 
 

1. to define the required structure, prior to the actual development. 
2. to serve as system documentation for future maintenance. 

 
As already explained in section 1.3, this chapter will be further improved and 
detailed during the development periods.  
 

5.2 System architecture 
 
The global Ringtoets design has been depicted already in Figure 2.1.  This design 
corresponds to the generic design of a new generation of dike strength software 
applications (Ringtoets, stand-alone VTV tools and DAM), as presented in Figure 
5.1. 
 
Each application in the collection of new generation software consists of the 
following four layers.  
 
1 The control layer contains the data model and steers the execution of different 

tasks in the three other layers. 
2 The User Interface (UI) layer enables presentation and manipulation of input 

data and results.  
3 The I/O-layer connects the internal or external databases to the UI layer and 

business layer. 
4 The business layer contains all functionality to derive the user-requested 

output from the user-supplied input.  
12  

13 All layers connect to libraries for the functions that are shared with one or 
more other applications, such as the stand-alone VTV tools and/or DAM.  
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Figure 5.1 Generic architecture for the new generation of dike strength software 
 
The supported tasks in the main control layer are depicted in Figure 5.2. 
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Figure 5.2 Technical design of the main control layer 
 
 
The different Ringtoets packages (groups of software components) in the different 
layers are described below, and depicted in Figure 5.15. 
 
Main Control Layer 
Ringtoets plugin Code which brings all other components together, such as 

registration of UI components into the Delta Shell Light library 
Business Layer 
Key data model Contains all data and methods for the imported or inputted key 

data. Note that this package doesn’t depend on any other 
package. 

Assessment model Contains all schematized data and results related to assessments 
on either cross section level or mechanism section level. This 
package will use HydraRing as one of its components. 

Failure 
mechanisms  

Library of all failure mechanism models 

UI Layer 
Assessment UI User interface components for the data in assessment model 
Key and boundary 
conditions UI 

User interface components for the key data in soil model 

Delta Shell Light  Library with General facilities to build a user interface. 
IO Layer 
Import and Export Facilities to import and export project data to certain file formats 

(including the internal database format) 
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Figure 5.3 Software Packages  
 
 

5.2.1 Modular User Interface design, with the Delta-Shell Light library 
 
The Ringtoets UI an IO layers will be based on the Delta Shell Light library of 
software components, with a standardized look and feel. Delta Shell Light is a C# 
framework developed by Deltares and already used in different applications (DAM, 
D-SoilModel, Koswat, D-GeoStability).  
 
The main philosophy behind the design of the Delta Shell Light components is that 
a user should be able to start with execution of his tasks without a steep learning 
curve. To accomplish this, the UI based on Delta Shell Light has the following 
features. 
 
• A cross section editor and a map editor are placed centrally in the application. 
• Besides the map and cross section editor, there are a couple of windows. Each 

window has its own way of presenting data. For example, there is a table 
section which displays data in tabular form. The same data can be presented on 
the map and/or a cross section. The following windows are available in Delta 
Shell Light: 
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Window Description 
Map window Displays geographical located data. The map editor supports 

layers, which can be switched on and off on user request. 
The map editor is accompanied by a legend, which explains 
colours and symbols. 

Navigation window Displays a list with the most important objects to navigate to 
quickly and/or to select for specific actions. Often a list of 
locations is displayed here 

Cross section 
window 

Displays a cross section of the vertically arranged data in two 
dimensions, for example a sub soil cross section. The cross 
section editor supports layers and has a legend. 

Report viewer Displays a print preview of a report. A report can be printed 
or exported to a file format of choice. 

Property window Displays properties of a certain object, for example the 
selected object on the map or in a table. Depending on the 
type of object, there may be a different way of presentation. 
For example, a dike ring might contain a table of dike 
sections, a soil might have a long list with properties and a 
Q-h relation might display a small diagram. 

List and chart 
section 

Contains several tables and charts. All data which can be 
presented in a table can be displayed here. Also charts can 
be displayed, with or without connection with a table.  

Messages section Gives the user feedback about the data he has entered. This 
can be information about the validity of data or suggestions 
about which task to perform. For example, a message is 
displayed if a value exceeds the maximum allowed value. 
The suggested resolution is to assign the maximum allowed 
value, which will be performed on user request. The user will 
be able to start a calculation if all error messages have been 
resolved. 

Output section The output section is to be used for display of log messages 
generated by a calculation. The contents are purely 
informative for the user. 

 
Figure 5.4 displays an example of a user interface based on Delta-Shell Light. This 
example shows that a map display, a cross section display, a property window, a 
table section and a feedback section are used. 
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Figure 5.4 Example of an User Interface based on Delta Shell Light  
 

 
The following generic features are provided as part of the different Delta-Shell Light 
components. 
 
Feature Description 
Multi language 
support 

The application can be displayed in multiple languages 

Multi unit support The application can be displayed with different units. In this way 
the user can select units appropriate to the size of values or what 
he is familiar with. 

Track changes The application keeps track the original data source of data and 
whether it has been modified by the user. 

Startup behaviour The application can be configured what to do on startup, load a 
new project or load the last used project. 

Selection behaviour The selected object is synchronized among all windows. This 
helps the user to understand what is displayed in all windows. For 
example: the map window, cross section, property window and 
table section all display the same selection of a certain object. 

 
Delta-Shell Light uses C# components of the DevExpress and DotSpatial libraries. 
These libraries contain many different components for editing, visualization, 
reporting and exporting. Delta-Shell Light uses these features to create applications 
with a standardized look-and-feel. 
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Toolkit Description 
DotSpatial 
components 

Display a map; open shapefiles/grids/rasters and images in a 
map; render and reproject map data etc. 

DevExpress 
components 

Various UI components : navigation pane, editors, grids, tree lists, 
ribbon bars, reports and charts, printing and exporting in various 
formats (HTML, PDF, XLS, CSV ) etc 

 

5.2.2 Menu and toolbar 
 
The main form will have a menu and toolbar. The menu will tentatively contain the 
following menu and submenu items: 
 
Bestand/File   Description UC 

Nieuw/New Creates a new Ringtoets project dabase  UC 5 

Openen/Open Selects an  existing Ringtoets project database UC 7 

Project 
eigenschappen 

/Properties 

(Re)defines the properties of the open project UC 6 

Opslaan/Save Saves the current ringtoets project data or, if not 
saved before, performs save as behaviour 

UC 8 

Opslaan als/Save 
As 

Opens a dialog asking where to save the Ringtoets 
project database 

UC 8 

MRU List of most recently used projects - 

Importeren/Import  Import key-data (from GIS and soil database) using 
a preconfigured mapping table 

UC 9 

Importeren/Import  Import archived project data in XML format UC 41, UC 
44 

Exporteren/Export Archive project data in XML format  UC 41, UC 
44 

Afsluiten 
Project/Close 

Closes the project UC 48 

Afsluiten 
Ringtoets/Exit 

Terminates Ringtoets UC 48 

 
 
Bewerken/Edit Description UC 

Ongedaan 
maken,Opnieuw 

/Undo/Redo 

Undo and Redo recent actions FR 26 

Verwijderen/Remove  ??? 
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Beeld/View Description UC 
Herstel/Restore Restore the visibility of tabs to the initial 

settings 
 

Map/Kaart Set focus to the map window  
Dwarsdoorsnede/Cross Section Set focus to the cross section window  
Navigator/Navigator Set focus to the navigator window  
Meldingen/Messages Set focus to the Messages table  

Log uitvoer / Log output 
 

Set focus to the Log output table  

Toon data / Show data Select visible data  
• Alles / All Show all available data  
• Kerndata / Key data Show only key data  
• Schematisatie/Schematization Show only schematized data  
• Resultaten/Results 

 
Show only Results   

Tabellen/Tabels Set focus to a selected table with input 
or results 

 

• Referentie lijnen / Dike 
Reference Lines 

Input data for  the dike reference line(s). UC 
10  

• Karakteristieke lijnen / 
Characteristic lines 

Input data for the characteristic lines, 
defining start foreland, toe outer berm, 
entrance point piping, outer toe, outer 
crest, inner crest, inner toe, toe inner 
berm, start ditch etc  

UC 
11 

• Kunstwerken / Structures Input data for structures like gates, 
concrete defence walls, and other water 
works 

UC 
12 

• Dammen en Caissons / 
Breakwaters 

Input data for breakwaters like caissons, 
rubble mounds and vertical walls 

UC 
13 

• Bekleding / Revetment Input  data for different 
revetmentrevetment zones 

UC 
14 

• Stijghoogtes / Piezometric 
head 

Input data for the piezometric heads at 
land side on different horizontal 
locations along the dike location line 

UC 
15 

• Dwars profielen / Cross 
section profiles 

Input data for the cross section locations 
and surfaces, including links to output 
locations 

UC 
16 

•  Ondergrond / Subsoil  Input data for the subsoil profiles, soil 
types and parameters of soil types for 
different 1D or 2D subsoil profiles in 
different areas (bodemvakken)  

UC 
17 

• Uitvoer locaties / Output 
locations 

The available output locations of the 
hydraulic loading, with the input option to 
define fetch areas. 

 

……   
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Werkproces / Work 
process 

Description UC 

Work process Select work process to limit the amount of visible 
tables, Map data and property data.  

 

 

Kerndata / Key data View and modify key-data UC 10 
~ UC 
17 

Schematisatie / 
Schematize 

Schematize mechanism related data  

 Link cross sections to output locations UC 20 
 Link cross sections to rouble mounds UC 13 
 Define fetch areas at the output locations UC 22 
 View/edit auxiliary parameters and settings UC 23 

Resultaten / Results View results UC 
31, 
UC 
36, 
UC 43 

Alle / All View all.  
 
Toetsen/Assess Description UC 
Toetstaak / Task Select an assessment task, in order to limit the visible 

options and data to this task. 

 

UC 
19,  
UC 28 

Hydraulische 
belasting / Hydraulic 
load  

There are five tasks related to hydraulic load.  
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• Waterpeilen in 
uitvoerlocaties / 
water level at 
output  locations 

 

Calculate water level data per output location. UC 25 

• Waterpeilen in 
doorsneden / 
Water level at 
cross sections. 

Calculate water level data per cross section. UC 25 

• Overslag debiet / 
Overtopping / 
Overtopping 
discharge. 

Calculate overtopping discharge per cross section 
given a required frequency and (existing) crest height.  

UC 27 

• Overtopping 
kruinhoogte / 
Overtopping crest 
level. 

Calculate required crest height per cross section 
given the maximum allowed discharge for a given 
frequency.  

UC 27 

• Golfparameters / 
Wave parameters. 

Calculate wave parameters per cross section, for a 
revetment assessment on level 1 or 2a 

UC 26 

Toetsen / 
Assessment 

There are assessments per failure mechanism and 
for dikes and structures. 

 

• Dijken – Overslag 
/ Dike – 
Overtopping. 

Calculate results per overtopping dike section for a 
level 2a or 2b analysis 

UC 27 

• Dijken – Bekleding 
/ Dike – 
Revetment. 

Assess the cross section surface for overtopping and 
revetment. Schematize for revetment (stone, asphalt 
or grass), and calculate results per cross section for a 
level 1 analysis, or per macro-stability dike section for 
a level 2a or 2b analysis 

UC 24 

• Dijken – 
Macrostabiliteit 
binnenwaarts / 
Dike – macro 
stability inner 
slope. 

Schematize for macro-stability, and calculate results 
per cross section for a level 1 analysis, or per dike 
section for a level 2a or 2b analysis 

 

• Dijken – Piping / 
Dike - Piping 

Schematize and calculate piping results per cross 
section for a level 1 analysis, or per piping dike 
section for a level 2a or 2b analysis 

 

• Constructies – 
Overslag / 
Structures – 
Overtopping. 

Schematize for overtopping of structures, and 
calculate results per structure. Calculate results per 
structure for a level 2b analysis 

UC 27 

• Constructies - 
Piping / Structures 
– Piping 

Schematize and calculate piping results per structure 
for a level 1 or 2a analysis 

 

• Constructies - 
Stabiliteit / 
Structures - 
Stability 

Schematize for structures, and calculate results per 
structure for a level 1, 2a or 2b analysis 
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• Constructies – 
constructie sterkte 
/ Structures – 
Structural Strength 

Schematize for structures, and calculate results per 
structure for a level 1, 2a or 2b analysis 

 

• Constructies - 
Niet-sluiten / 
Structures - 
Nonclosure 

Calculate results for non-closure of structures for a 
level 1, 2a or 2b analysis 

 

• Duinerosie / Dune 
erosion 

Schematize for dune erosion, and calculate results 
per cross section for a level 1 analysis, or per dike 
section for a level 2a or 2b analysis 

 

• Combinatie/ 
Combine 

Combine the results on cross sections (level 1), 
combination sections (level 2a) or presentation 
sections (level 2b) 

 UC 
44 

 
 
Toetsniveau / 
Assessment level 

Description UC 

Assessment level Select assessment level from pull down menu. 

 

 

Relevantie (0) / 
Relevance (0)  

Assess the relevance of a failure mechanism based on dike 
geometry, dike location and expert judgment. 

CNS 6 

Eenvoudig (1) / Simple 
(1) 

 

Execute assessment on level 1 for selected mechanisms UC 31 
Inspect results  for all selected mechanisms on level 1 (for 
cross sections) 

Gedetailleerd (2a) / 
Detailled (2a)  

 

Execute assessment on level 2a UC 36 
Inspect results  for different mechanisms on level 2a for 
mechanisms sections 

 

Inspect results  for different mechanisms on level 2a for 
combination sections 

 

Probabilistisch (2b) / 
Probabilistic (2b)  

Execute assessment on level 2b UC 42 
Inspect level 2b results  on different mechanisms sections UC 43 
Inspect level 2b results on presentation sections  

 
Gereedschap / Tools Description UC 

Opties / Options Define various options in an option window.  
Eenheden / Units Define units for input and output of various properties  

Instellingen / Settions Gives information on the Ringtoets version etc.  
 
Help Description UC 

Handleiding / Manual Gives access to the users manual (in pdf)  
Over / About Gives information on the Ringtoets version etc.  
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5.3 Data model 
 
Before starting the technical design related to different functions, this section will 
first provide a description of the datamodel that is underneath in the different 
packages. The reason for using this sequence is that the technical design of 
functions will refer back to the datamodel. The datamodel itself will implicitely need 
to cover all the data. 
 

5.3.1 Key data  
The key data class contains the imported or inputted key data.  
 
The following sections are present in the model for key data: 
1. Sub soil data 
2. Water defence data 

5.3.1.1 Key data Sub soil  
The soil database contains extended soil data including soil profiles and soil 
properties. The data is stored in 3D-spatial databases. In top view the available soil 
data are point objects. Advance GIS-tools can calculate a soil profile at any location 
in the area. In Ringtoets soil profiles at dike cross sections are necessary as input 
for failure mechanisms, for example stability and piping. The soil profile is either 1D 
or 2D. In a 2D profile, the boundary between two layers can vary along the 
horizontal cross section axis (perpendicular to the dike line).   
 
The subsoil profiles will either be stored at mechanism sections or at regions. A 
choise between the two options must still be made. 
 
The soil profiles are mechanism dependend. For piping a 1D profile is required, for 
other mechanisms a 2D profile is needed. Technically, 1D and 2D profiles are 
stored separately. For visualization routines are designed for 2D profiles. 
Conversion routines translate 1D profiles to ‘2D’ profiles when profiles are 
visualised. The presentation of 1D and 2D profiles will be different. 
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Figure 5.5 Data Classes for subsoil key data 
 
The classes have the following meaning: 
 
Class Description 
SoilProfile The sub soil library contains a large number of 1D or 2D soil profiles. The 

locations of the imported profiles will be visible in the map meter as a 
symbol and a name (ID) label. Ringtoets will automatically link each dike 
cross section to the nearest soil profile. A tiny (dotted) line can make this 
link visible in the map meter. It is possible to change the links manually. 
 
In the cross section editor, the sub soil data will be visible as soil layers 
under the dike. By default the dike material is equal to the top layer 
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Class Description 
material. 

DeterministicSoilPro
file 

Soil profile which defines the appearance of a soil in a deterministic way, 
this means it is exactly defined which soil is present at which location. 

StochasticSoilProfile Collection of deterministic soil profiles, with each soil profile having a 
certain probability 

SoilProfile1D Describes a sub soil divided in horizontal layers 
SoilLayer1D Horizontal layer of a soil, with indication of top and bottom level resulting 

in layer thickness and layer position. The bottom level is always equal to 
the top level of the underlying soil layer. 
Piping indication (upper subsoil layer, shallow aquifer at dike, shallow 
aquifer next to dike, second deep aquifer). 
NL: naam, ligging bovenkant (laagdikten), type voor piping (deklaag, 
ondiepe watervoerende laag onder de dijk, ondiepe watervoerende laag 
buiten de dijk, tweede diepe watervoerende laag), ligging, laagdikte.  

Soil Contains all soil properties, such as mass density (dry and wet), piping 
parameters, damping factor, is aquifer or aquitard and stability 
parameters. 
NL: soortelijke dichtheid, parameters voor pipingmodel, bijv. 
erosiebestendigheid toplaag, weerstandscoëfficiënt onderlaag (afhankelijk 
van ligging). Stabiliteits parameters.  

SoilProfile2D Describes a sub soil, where the appearance of the soil depends on the 
horizontal coordinate 

SoilLayer2D Describes a 2D layer, i.e. the thickness and position of the soil depends 
on the horizontal coordinate. One can think of a polygon indicating the 
position of the soil. 
Piping indication (upper subsoil layer, shallow aquifer at dike, shallow 
aquifer next to dike, second deep aquifer). 
NL: naam,  

SoilSurfaceProfile Soil profile which consists of a deterministic soil profile and a surface line. 
The surface line truncates the soil profile from the air. 

SurfaceLine The surface line is a collection of points on the surface in such a way that 
it describes the contour of the dike. Usually the points are collected from 
DTM and corrected for riverbed and ditch. The points are supposed to be 
perpendicular to the dike line. The surface line has a surface line location, 
which is a point in RD coordinates, and an angle, which indicates the 
angle of the line with surface points with the RD latitude. The points are 
defined with relative coordinates to the surface line location and angle (X 
is distance to surface location, Y is zero, Z is real depth) 

SchematizedSurfac
eLine 

A surface line which is based on a surface line, but modified in such a way 
that it can be used by a failure model. This includes the definition of a 
number of characteristic points and possibly some additional bending 
points on the surface.  

CharacteristicPoint Characteristic lines run parallel to the dike line and are imported as key-
data. In the cross section editor the lines are visible as characteristic 
points at intersections with the surface line. The user can select, move, 
add and delete these characteristic points. Adding and moving is only 
possible along the surface line. Characteristic points must be labeled as: 
begin point fore land, entrance point piping, toe outer slope, outer crest, 
crest, inner crest, inner slope, toe inner slope, start ditch, end ditch, etc. 
NL: karakteristieke punte op dijkprofiel: begin voorland, intreepunt 
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Class Description 
(piping), teen buitenberm, buitenteen, buitenkruin, kruin, binnenkruin, 
binnenteen, teen binnenberm, start sloot, eind sloot, enz.  

GeometryPoint 3D Point, which indicates a point in a surface line. The X and Y 
coordinates indicate the geographic location, but defined relatively to the 
location of the surface line. 

Stochast Defines the stochastic distribution of a property in, for example, soil. The 
distribution type and parameters define the stochastic values. The number 
of values depend on the distribution type. The following distribution types 
exist: Deterministic (1 value), Normal (2), LogNormal (3), Uniform (2) 
 
For each stochastic parameter there is an associated property in a class, 
for example DryUnitWeight stochastic parameter is associated with the 
DryUnitWeight base property (being a double) in the soil class. This is 
defined by the owner and property in this class. 

5.3.1.2 Key data water defence 
This comprise all key data related to the water defence geometry and properties.  
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Figure 5.6 Data Classes for hydraulic key data and boundary conditions  

 
The classes have the following meaning: 
 
Class Description 
DeltaModel Container of all key data, such as soil profiles, dike lines and 

revetment location and properties 
DikeLine A dike line is a ‘backbone’ of a dike and applicable for all failure 

mechanisms. The user can select points along the dike line to 
view properties such as a name. 
Points have global XYZ-coordinates and local L-coordinates 
along dike line. Locations can have name (labels) or L-
coordinate indications (km-pole) 
NL: naam locatie, km-palen 

CharacteristicLine Line of points of the same characteristic type. These points are 
used to derive the characteristic points per schematized 
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Class Description 
surface line. The Characterstic points are the intersections of 
characterstic lines with SurfaceLines.  

Fetch (*) Fetch area. The incoming angle is relative to the dike normal 
(perpendicular to dike line) 

WindFetch (*) Fetch data per wind direction 
FetchLength (*) Fetch data per wind direction and layer 
Revetment Revetment zones are visible in the map editor and cross 

section editor. Revetment zones are defined by two paths in the 
horizontal plane, indicating the left and right border of the 
revetment zone. The distance is related to crest axis. Such a 
path is expected to be close to the dike line, but not 
necessariliy so. A path is a line consisiting of points. 
The actual top and bottom at a certain location become clear in 
combination with a (schematized) surface line (intersections 
revetement paths with surface line). The user can select, add, 
edit and remove revetment zones. 
Revetment types: grass, stone, asphalt, with sub-types. 
Revetment has physical revetment properties such as size and 
parameters for mechanism models. The model parameters are 
different per revetment type and sub-type. Inpuft for each 
property the mean value, statistical standard deviation and 
standard deviation used for mechanism. 
There can be more than one revetment zones in one cross 
section (profile sections or revetment zone sections on the 
surface line).  
NL: Bekledingszone, zonenaam, bekledingstype (gras, steen, 
asfalt met onderverdelingen), onder en bovengrens zone, 
bekledingseigenschappen (afmetingen, faalmechanisme 
specifieke parameters). 

Structure Hydraulic Structures like gates, concrete defense walls, etc 
Structurs are line objects and have a begin and endpoint 
(location points). Their line symbology in the map is different 
from the dike. They have a name, type, geometry, and other 
assessmemt specific properties.     
NL: kunstwerk; verticale muren. Eigenschappen: naam, type, 
afmetingen, overige eigenschappen voor toetsing. 

Breakwater Breakwaters like dam caisson, rubble mound, are line objects. 
They have a begin and end point (location points). The 
structures have a symbology that is different from the dike line. 
(e.g. line width, colour) in the map editor. The user can select a 
the structure and open its project property form for: name, type, 
geometry and other assessment specific properties.    
NL: dam, caisson, strekdam.  
NL: eigenschappen: naam, type, afmetingen, overige 
eigenschappen voor toetsing.  

PiezometricHead Piezometric Head is imported with key-data in the map editor 
as polygons. It is applied to all cross sections inside a particular 
polygon. Cross sections outside the polygon will need 
additional, manual input of the Piezometric head in the cross 
section editor. 
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Class Description 
PolderLevel Water level at the polder side, to be used as water level in a 

ditch on the polder side. 
NL: polderpeil.  

WaterLevelSetup (*) User defined water level setup value per wind direction. NL: 
opzethoogte, windrichtingsector. 

Swell (*) Wave parameters due to swell, no user data. 
NL: deining, golfhoogte, golfperiode. 

WaterLevel Water level at dike toe at the river side (if available). 
Wave (*) Wave data at dike toe. Properties are peak period and angle, 

i.e. angle of attack onto dike 
Seiche (*) Defines a seiche, i.e. a long standing wave 
(*) should not be part of project data, but part of internal database. 
 
Default values for hydraulic parametes will be applied if available.  

5.3.1.3 Linking routines key data 
Key data is translated to object classes. The relations between object classes are 
defined in class diagrams, which can be found in the following secions of this 
chapter. The class diagrams tell us what data is linked but not how the links are 
created. This section elaborates the basic design principles for linking object 
classes geographically. The purpose of these design principles is to guarantee 
correct and validated links of object classes. The principles will be used to design 
the linking routines (methods). The exact moment of activating linking routines is 
important for the performance of the UI. Timely activating also guarantees that the 
most recent data is used. 
 
Design princples for linking routines of key-data 
• The dike line is the ‘backbone’ of the model. Every linking routine must check 

on the availability of it. If a dike line does not exist, the linking routine must be 
aborted. Furthermore, if there is any change or modification to the dike line, all 
linking routines must be updated.   

• All data is projected on the dike line. A point on the dike line is called location 
point. Generic projection methods are necessary for the projection of different 
types of data on the dike line using a perpenducular. A point object, for example 
a hydraulic boundary point, must be projected on the closest dike location using 
the perpendicular. On that particular spot a location point is inserted on the dike 
line and linked to the hydraulic boundary point. The projection of a line on the 
dike line is somewhat different. Both the begin and end point of the line must be 
projected on the dike line. A polygon is another data type. Its boundary can 
cross the dike line twice. The dike line between these two intersections (location 
points) lies inside the polygon. 

• Soil data are imported in soil segments being areas (polygons) with a set of 1D 
or 2D soil profiles. Each profile has a probability of occurance.  

• Every location point on the dike line has a XYZ-coordinate in the global 
coordinate system and dike line coordinate (L-coordinate).  

• The connecting algorithms use spatial imaging technique to optimize the search 
algorithm.  

• After the data has been projected on the dike line, it can be projected on the 
cross sections including the dike surface lines.  



 

 

 
1207804-001-DSC-0002, 16 May 2013, final 
 

 
Ringtoets Requirements and Functional Design 
 

75 of 127 

• In Ringtoets, importing, editing and manually adding key-data is possible. All of 
these actions can affect the data and the associated data links. To guarantee 
that the most recent and actual data is used for calculations and visualization, 
the linking routines must be called only when it is necessary. This is the case if 
any object data has been added, deleted or moved and at the same time: 
a) a dike cross sections is open(ed), or   
b) a calculation routine is called. 

 
The following tables is a list of key-data, the linking routine, and the associated 
object class.  
  
Data item (shape type) Linking routine Class 
Start   
Background (picture)  N.a.  
Dike line (‘Backbone’)   
Dike line (line) Dike points are added to list of 

dike locations. Existiance of a 
Dike line is prerequest for any 
linking routine. 

DikeLine, 
DikeLocation 

Hydraulic structure (line) Begin- and end point projected on 
dike line. 

Structure 
DikeLocation 

Dike cross section   
Surface lines (line)  Surface line has a location point. 

Link location point to dike line. 
Surface line has angle relative to 
dike line orientation 
(perpendicular).  

SurfaceLine, 
DikeLocation  

Cross section (point) Cross section is a location point 
on dike line. In cross section the 
dike geometry, soil data and 
hydraulic boundaries are 
combined.  

DikeLocation, 
DikeCrossSection 

Characteristic lines (lines)   Intersect characteristic lines with 
surface lines. Create 
characteristic points.  

CharacteristicLn, 
CharacteristicPnt, 
GeometryPoints, 
SurfaceLine 

Revetment zone 
(polygons) 

Intersect zones with surface lines. 
Create dike surface points. 

Revetment,  
GeometryPoints 

Soil data   
Soil profiles from 
DSoilBase (polygons) 

Import SoilSegments with 
soilprofiles per segment, including 
probability. Segements have 
either 1D or 2D profiles. Project 
soil segment (polygon) on dike 
line. Assign cross sections to 
SoilSegments (thus soil profiles). 

SoilProfile1D/2D, 
DikeLocation, 
DikeSegments, 
DikeCrossSection 

Dike material (point).  Assign top soil layer to dike profile  
as dike material. 

SoilLayer1D, 
SoilLayer2D, Soil, 
DikeCrossSection 

Boundary Conditions    
Piezometric head Project polygon on dike line. DikeLocation, 
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Data item (shape type) Linking routine Class 
(polygon) Apply to nearby cross section. PiezometricHead, 

DikeCrossSection 
Polder level (polygon) Project polygon on dike line. 

Apply to nearby cross sections. 
DikeLocation, 
PolderLevel, 
DikeCrossSection 

Breakwater (line) Project breakwater on dike line. 
Mark begin and endpoint as dike 
locations. Link breakwater to 
affected cross sections.   

Breakwater, 
DikeLocation, 
DikeCrossSection 

 

5.3.1.4 Partial safety factors 
Partial safety factors are necessary for the semi-probabilistic assessment (level 2a). 
The partial factors will only be applied to strength parameters (resistance) and not 
to the load parameter. In theory, it is possible to apply partial safety factors either on 
the overall calculated strength of a mechanism, or on the individual strength 
parameters such as material properties. There will be a switch per failure 
mechanism to distinguish between an overall partial safety factor or partial safety 
factors per strength parameter. 
 
The above mentioned switch and all partial safety factors are part of configuration 
data. This means that the user can inspect the factors in the userinteface per 
mechanism (UC 35), but cannot modify them.  
 
If the switch is set to ‘overall’, the strength parameters accepts only μ and σ as 
input and have a characteristic values as output. If the switch is set to ‘parameters’, 
the individual strength parameters accept μ, σ and γi as input. The output is the 
design value.  

5.3.2 Assessment model (schematized data and results) 

5.3.2.1 Schematized data 
 
Dike lines are subdivided for a level 2 assessment into dike sections (mechanism 
sections, combination sections and presentation sections).  A mechanism section 
relates key data and additional hydraulic boundary data via the location of a 
characteristic cross section inside the mechanism section.  
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Figure 5.7 Data Classes for Dike location. 
 
The classes have the following meaning: 
 
Class Description 
DikeLineDivision Definition of a division of dike into sections. Note that soil 

model doesn’t refer to this class. It will be used by the 
assessment model. 
NL: vakindeling dijklijn, mechanisme vakken. 

DikeLocation Location or stretch along a dike 
DikeCrossSection Cross section which is used at level 0 and 1. The location 

coincides with a schematized surface line. Cross sections 
have (default) names.   

DikeSection Dike section which is defined as a stretch along a dike and 
using the key and hydraulic boundary data from a 
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Class Description 
representive DikeCrossSection 

 
Since dike sections refer to hydraulic data, which are considered representive for 
the dike section, sometimes combined hydraulic boundary conditions are used. 
They are modeled as follows: 
 

 
Figure 5.8 Data Classes for Hydraulic Boundary parameters.   
 
 
Class Description 
CombinedSwell Has swell properties, which are the result of a 

weighted combination of underlying swells 
CombinedWaterLevelSetup Similar as combined swell 
CombinedFetch Similar as combined swell 

5.3.2.2 Assessment control model 
 
The assessment model contains data needed by assessments and the failure 
mechanisms they use. The assessment model will refer to key data. Soil profiles 
are essential input data for a dike cross section. The collection of soil data for the 
assessment also depends on the failure mechanism and the failure mechanism 
section division (DikeLineDivision / MechanismDikeSection). Some additional soil 
parameters are mechanism specific, for example the damping factor for the failure 
mechanism piping. 
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Figure 5.9 Classes for Assessment control 
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Figure 5.10 Classes for probabilistic configuration 
 
The classes have the following meaning: 
 
Class Description 
AssessmentModel Gives access to all data needed for an assessment 
AssessmentMechanism Calculates the limit state value for  
AssessmentNeeded Indicates whether assessment is needed per 

assessment level, failure mechanism and dike section 
DikeLocation Location or stretch along a dike, either a 

DikeCrossSection or a DikeSection 
DikeLineDivision Defines a division of a dike line into dike locations or dike 

stretches. Per failure mechanism a dike line division 
exists, but also for combined and presentation sections 
and for cross sections for assessment level 0 and 1. 
The dike line division contains a list of division points. 
This is a list of IGeograpics which define the limits of the 
dike sections. The same IGoegrapic instances are 
present in the dike sections. 

Mechanism A failure mechanism calculation 
MechanismDikeSection A dike section defined for a certain mechanism. 
OvertoppingDikeSection A dike section defined for overtopping. An overtopping 

dike section is linked to a (user defined) mechanism 
section (via DikeLineDivision, DikeLocations, 
MechanismDikeSection). The mechanism section is 
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Class Description 
linked to a schematized surface line and cross section 
(via a DikeLocation). The cross sections is linked to 
geometric data, soil data and hydrodynamic data. This 
schematized surface line is called ‘charcteristic cross 
section’ (UC34.d).  
List of non-default values for allowable overtopping 
discharge.  
NL: non-default waarde voor toelaatbaar overslagdebiet. 

OvertoppingMechanism Performs an overtopping calculation for one dike section. 
List of allowable overtopping discharge. 
NL: toelaatbare overslagdebieten. 

PipingDikeSection A dike section defined for piping. See comments on 
mechanism sections at ‘OvertoppingDikeSection’. 
Characteristic cross section can also link to probabilistic 
soil profile.  
Default piping model. 
Optional: non-default damping factor (user defined). 
For piping two additional points must be added: 
1) Entrance point using support lines or toe outer slope 
(conservative assumption). 
2) Excess point using determined by algorithm or inner 
toe (conservative assumption). 
NL: intreepunt, uittreepunt, binnenteen, buitenteen. 

PipingMechanism Performs a piping calculation for one dike section 
Default value damping factor hydraulic pressure 
difference between entrance point and inner crest toe. 
NL: dempingsfactor stijghoogte (tussen intredepunt en 
binnenteen).  

RevetmentDikeSection A dike section defined for revetment. See comments on 
mechanism sections at ‘OvertoppingDikeSection’.  
Per mechanism type and sub-type non default model 
parameters.  

RevetmentMechanism Performs a revetment calculation for one dike section. 
Default model parameters per mechanism type and sub-
type.  

 

5.3.3 Import and export 
 
This section contains classes for facilitating import. Export is handled by 
DeltaShellLight components. The classes are described together with their 
interaction in section 5.5. 
 

5.3.4 Failure mechanisms 
 
The failure mechanisms package contains classes to calculate a failure mechanism. 
Its input and output data are part of key data, except calculation options. 
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5.3.5 UI 
Two UI packages contain the forms specific for items in the key data and 
assessment model classes. The naming of these classes is <item>PropertyControl, 
so the form where the user can enter swell data is called SwellPropertyControl. 
 
For drawing items in the cross section editor, there will be specific classes per item 
(as far as needed), called Drawing<item>. For example, the class 
DrawingRevetment draws the revetment zones in the cross section editor. 
 
Other kind of UI controls don’t need a specific class, because DeltaShellLight 
provides sufficient components already, for tables, charts and display of data in 
GIS. 

5.3.6 Ringtoets plugin 
 
The Ringtoets plugin has some control classes which configure and control 
Ringtoets. This comprises the registration of property controls for certain item types, 
the configuration how data should be displayed in GIS and the behaviour of the GIS 
and cross section editor. 
 
These classes are mentioned in the description how these editors behave, see 
sections 5.6.2 and 5.6.3. 
 

5.4 Project management 
 

5.4.1 Start a new project 

At the start of a new project, input of project settings is necessary, like the project 
database name and location. Ringtoets will come up with one Project Start Form 
that holds all those items together. The form pops up directly after selecting ‘Create 
new project’. The form also pops up if one of the items in the Project Start Form is 
missing of an existing project. After the users confirms these data, the data are 
imported and saved immediately. If the project exists already, the user is prompted 
to overwrite. 
 
When starting the application, the user is prompted with a form to create a new 
project or to open a previous project. This form is merged with the previous form.  
 
See UC 5, UC 6 and UC 7. 
 

5.4.2 Automatic Locking of data 

The Ringtoets application allows concurrent use of one project database. But users 
are not allowed to edit the same data at the same time, or to alter data which is in 
use for a running assessment calculation, see UC 18. Therefore locks are used: A 
user requests a lock for a certain part of the data and if granted, he is allowed to 
edit it. If refused, he can still view the data, but isn’t allowed to modify them.  
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Locking is performed implicitly on a first come, first served basis. Users do not have 
to identify themselves. Locks can be set on key data and on failure mechanisms. 
The following table indicates the required locks per action. 
 
Action Lock 
View data None 
Edit data Changed but unsaved 

data 
Calculate hydraulic boundary conditions All used data 
Perform level 1 assessment All used data 
Perform level 2a assessment All used data 
Perform level 2b assessment All used data 
 
 
Figure 5.11 Activity diagram for mechanism dependent locking 
 
The locker class sets a semaphore for the selected lock type. This semaphore is a 
file, which is opened exclusively. Only when this open action succeeds, the lock is 
granted. It doesn’t matter whether the file existed already, because this prevents the 
whole system being locked up if an application terminates unexpectedly. 

5.4.3 Saving data and configuration 
 
All Ringtoets project data is saved in a project database. Import and export of 
project data occurs via a separate xml file for the key data and general project data 
and separate xml files for data related to the the different mechanism branches for 
level2 assessment. In this way, concurrent data updates for different mechanism 
branches are possible. 
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Figure 5.12 Data Classes for writing to the project database 
 
The classes which are not accessible by the RingtoetsProject are used to control 
and configure the user interface. The RingtoetsPlugin makes the connection with 
the Delta Shell Light framework. 

5.5 Import and Export 

5.5.1 Import and export data model 
Importing data is performed from several file formats. As long as a file format 
targets one data type of object, this is done in a generic way. The file format is 
described by attributes or in an xml file. Then the data is read and corresponding 
data classes are populated. The soil model is queried for providing appropriate data 
classes. This is visualized in the figure below: 
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Figure 5.13 Activity diagram for importing data 
 
This is implemented in the following classes: 
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Figure 5.14  Data classes for importing data 
 
The classes have the following meaning 
 
Class Meaning UC 
Importer Takes care of populating data classes 

based on data read from file 
 

ShapeImporter Imports data from shape file  
CSVImporter Imports data from CSV files  
MultiImporter Starts import from several data sources 

and runs them in parallel.  
 

FieldDefinition Collects property definitions for one 
class type 

 

PropertyDefinition Defines the relation between a field 
name (e.g. the header in a CSV file) 
and a property in a data class 

 

FieldDefinitionImporter Fills the field definition  
AttributeFieldDefinitionImporter Fills the field definition based on 

attributes defined in the data classes 
 

XMLFieldDefinitionImporter Fills the field definition based on an xml 
definition 

 

IDataFactory Interface which defines a data factory, 
i.e. a data source which is capable to 
provide an instance of a data class 
based on a type definition. The 
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Class Meaning UC 
following methods are provided: 
 
Method Description 
GetObject Retrieves or creates an 

object of the requested 
type and key and 
locates it in the proper 
place, e.g. a swell is 
added to the list of 
swells. 

  
DeltaModelFactory Implementation of the IDataFactory for 

the delta model 
 

DeltaModel Top object of the delta model, see 
elsewhere. 

 

 

5.5.2 Import user interface 
 
When the user wants to import data, a form is displayed in which he can select per 
data type whether it should be imported and if so, its file location. Pressing the OK 
button will start the import. 
 
Next to the OK and Cancel button, there is the possibility to save and load file 
locations from an import definition file. 

5.5.3 Format of imported and exported data 
Imported data and exported has either a csv, shp or xml format. Different types of 
data can be contained in different files. 
 

5.6 Editing data 

5.6.1 Modification of key-data 
The UI of Ringtoets will use Delta Shell Light components (§ 5.2.1) such as a map 
and cross section window. Other UI components are property editors and tables. 
The user can select and modify objects through one of these components. The 
content of all these UI components is synchronized. With synchronization the 
property editor is for example updated if a user selects a new object in the map-
editor. Some key-data is mechanism specific. The user must select the assessment 
level and mechanism with the Map Editor controls, for the purpose of data filtering. 
Initially, the key-data is used for all mechanisms. When editing the key-data for one 
specific mechanism, Ringtoets implicitly will make a duplicate (copy) which can be 
altered per mechanism.  
 
Key-data is imported from external source and saved to the l project database. It is 
a ‘snap-shot’ of the external data. Modifications on the project data will not be 
stored (or otherwise synchronized) in the original data source.  
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General User Interface functionalities are described § 5.2, together with the access 
to specific menu functions for modification and visualization of key-data.  

5.6.2 Map window 
This section describes the functionality of the map window in detail. The Map 
window shows the dike geometry in top view, so only georeferenced data is visible. 
Data can be selected and then their properties are displayed in the property form. 
The following items are visible on the map. 
 
Item Description UC 
Layer Background picture (local or 

from server) 
Achtergrondkaarten  

Geographic coordinate 
system 

Coördinaat definities 

Layer definitions (optional) Laag definities 
 

 

Dike line A line with bending points, which indicates the location of the 
dike 

UC 10 

Soil segment Dike stretch representing the location of a soil segment  
Structure Dike stretch representing the location and type of a structure  
Breakwater The location of a breakwater UC 13, 

UC 21 
Fetch Group of lines pointing towards wind directions, see examples 

from Hydra-VIJ and PC-Ring below. 

 
Import of precalculated fetch tables. 
Automatically calculate fetch lengths (nice-to-have). 

UC 22 

Swell Symbol representing the location of swell input  
Revetment Indicates the revetment zones along a dike. Per revetment zone 

there is a line, so there may be multiple lines together, see the 
example below. 
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Item Description UC 

 
Figure 5.15 Revetment zones in Map Editor for dike with three revetment layers 

(upper line) and two revetment layers (bottom line) 
Dike section A dike section (mechanism section, presentation section) is 

indicated by small dike section points, indicating the begin and 
end of the dike section. Editing dike sections comes down to 
adding, moving or deleting dike section points. 
 

 

 
Coloring dike sections and dike lines can be done in the following ways. The user 
can select this with a drop down list in the toolbar of the map editor. 
 
Draw mode Display 
Input Input values for the selected failure mechanism, such 

as revetment. 
Assessment level The needed assessment level and whether it fails or 

passes 
Section failure probability The failure probability per dike section. This depends 

on the selected failure mechanism or combined or 
presentation sections 

Dike line failure probability Same as section failure probability, but for the whole 
dike line 

 
Labels appear with appropriate information about what is displayed.  

5.6.2.1 General map operations 
The user can perform the following general GIS actions  
 
Action Description 
Zoom and pan General GIS features, including mouse scroll functions.  
Select item Select an item with the mouse pointer. Its properties are 

shown in the property window at the right side of the screen. 
Move point Move selected cross section along the dike line (optional) 
Show / hide layers Each of the items listed in the table before appears in a layer. 

This layer can be hidden or made visible. 
Display layer 
information 

Colors and symbols and their meaning can be displayed and 
edited in a legend.  
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Action Description 
Save layer Each layer (except a WMS layer) can be saved to a shape file 
Add / remove 
background layers 

Background layers can be loaded from shapefile or retrieved 
via a WMS server (e.g. OpenStreetMap). They can be 
removed as well. 

Reorder layers The layers can be reordered with the following limitations 
• The WMS layer is the bottom layer always 
• A polygon layer is always behind a point or line layer 

Display fetch area Show fetch areas per cross section. Each fetch area points 
towards a wind direction.  

 

5.6.2.2 Linking Output Points to Cross Sections  
Cross sections are points on the dike line that contain dike geometry and soil data. 
Additional data from the Hydrodynamic Database is also required in the dike profile. 
Hydrodynamic data is located in geographic output points. A link between a cross 
section and a hydrodynamic output point is necessary. Because there are typically 
many cross sections, and automated linking routine is necessary (UC 20). 
 
It will be assumed here that hydraulic structures are also linked to a representive 
cross section plane.  
 
With the ‘Link’ button on the form, the user can start the automated linking routine. 
Ringtoets will pop up a warning message that says that any existing link will be 
removed. After a final confirmation, Ringtoets will start the automated linking 
routine.  
 
Ringtoets will look for a nearby output point for every single cross section point. For 
every point, Ringtoets looks for the closest output point within an inner threshold 
distance. If there is one (or more) points within the threshold distance, only the 
closest point is linked to that cross section. If none output point is found, the search 
area is enlarged to a larger, outer threshold distance. When there are two output 
points in that area, Ringtoets will couple both output points to that cross section 
(Figure 5.16). The database parameters are calculated by interpolating the values 
from both output points using the mutual distances to determine their relative 
influence. No link is made if one or zero output points are found inside the outer 
threshold. 
 
The links between the cross sections to the output points are displayed. A thin, light 
colored line in the Map Editor visualizes the links. The cross sections without a link 
get a different, striking color (e.g. orange). 
 
Manual linking of cross sections to one or two output locations is possible via the 
cross section list window or via the map, see UC 20. Removing links is possible as 
well. 
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Figure 5.16 Automated linking of cross sections to output points of hydrodynamic database  
 
Cross sections without a linked output point are allowed for level 1 assessment. In 
that situation, additional interpolation of the hydraulic boundaries from adjacent 
cross sections is necessary. For level 2a a linked output point is required to a 
characteristic cross section of every mechanism section.  
 

5.6.2.3 Linking Breakwaters to Cross Sections 
 
For linking breakwaters to cross sections, see UC 21 
 

5.6.2.4 Editing dike sections 
A level 2a or 2b assessment requires dike sections instead of cross sections. The 
two user-defined types of dike sections are ‘mechanism sections’ and ‘presentation 
sections’. The mechanism sections are homogenous dike stretches used as input 
for failure mechanisms. Presentation sections are dike stretches used for the 
combined failure probability of multiple mechanisms (level 2b).  
 
Initially the entire dike line is one large section. The user can split a dike section in 
two parts by adding a division point. A division point is a point in between two 
adjacent cross sections. It is only possible to apply a division points at one of the 
available dike points. A dike point divides the dike line between two cross sections. 
As a consequence, the smallest dike section possible contains only one cross 
section. The mouse pointer automatically snaps to those dike points. It is for 
example possible to move a division point along the dike line and release it at one 
of the existing mid points. Removing a point is possible as well. For convenience, 
the adjacent dike sections get contrasting coloring (dark/light) for good visibility.    
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Figure 5.17 Splitting a dike section by adding a division point  
 
The user can add or remove a dike point. Ringtoets automatically redraws the 
mechanisms sections.    
 
Revetment zones (§ 4.5) and subsoil scenario’s for piping and slope stability are 
expected to be defined already as key data along the dike line. A toolbar button 
‘Use Revetment Division’ is enabled if the mechanism Revetment is selected in 
combination with a level 2 assessment. When clicking this button, the existing 
division points are removed and the revetment zone boundaries are imported as 
new division points. Manually adjustment is possible thereafter. The same 
procedure applies for using the subsoil scenarios division (button “Use Subsoil 
division”) to determe a first division of mechanism sections for piping and slope 
stability. 
 
If the length of a mechanism section becomes smaller than the minimum value, 
Ringtoets will give an error. The first proposed repair action is to remove the end-
point of that small section and as a result merge it with the next mechanism section. 
If the end-point is the end-point of the dike line, than the begin point of the small 
section is removed.  
 
During a level 2a assessment, Ringtoets will create Combination sections (for level 
2a assessment) from the user input of mechanism sections. The division points of 
the mechanisms sections are projected on one dike line. Ringtoets uses 
combination sections  to indicate the stretches for which all different level1 or 
level2a assessments pass the associated assessment criteria of the different 
mechanisms.  
 
For level 2b the user can define presentation sections for the output. The begin and 
end-point of a presentation section must coincide with the division points of the 
combination sections. In a way, presentation sections are groups of combination 
sections. The location of the begin and end-points of presentation sections can 
therefore not be edited, since they must coincide with the begin and end-points of 
mechanisms sections.  
 
Initially the presentation sections are a copy of the combination sections. The user 
can edit them by removing division points. As said before, adding division points is 
only possible at begin and end points of combinations sections.  
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Figure 5.18 Activity diagram for map based editing 
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Figure 5.19 Activity diagram for changing the dike location line 

 

5.6.2.5 Linking characteristic cross section to mechanism section 
 
Level 2 uses mechanism sections instead of cross sections. Mechanism sections 
are stretches of a flood defense with more or less homogeneous properties and 
boundary conditions for a considered failure mechanism. A mechanism section 
contains one or more adjacent cross sections. A mandatory prerequisite is that one 
cross section is indicated as the characteristic cross section of the mechanism 
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section. Characteristic means that the cross section is characteristic for the entire 
mechanism section. The properties attached to the cross section location become 
the input for the considered failure mechanism.  
 
In the Map Editor there is a button to activate the ‘Link characteristic cross section’ 
mode. In that mode the user can mark a cross section inside a mechanism section 
as the characteristic section. First the user selects a mechanism section on the dike 
line. Second the user selects a cross section. Manual input in a mechanism 
sections list is possible too. The characteristic cross section gets a more striking 
color or shape (Figure 5.20).  
 
In the Map Editor toolbar there is also a button ‘Link to the most central cross 
section’. When pressing this button, a dialog appears in which the user must 
confirm that all existing characteristic cross sections for a certain mechanism 
branch will be removed. After confirmation, Ringtoets will remove all existing 
indications of characteristic cross sections and then look for the cross section 
location which is most close to the center of the mechanism section. Manual 
adjustments thereafter are possible.  
 

 
Figure 5.20 Manually select characteristic cross section for mechanism section. 

5.6.3 Cross section editor 
This section describes the functionality of the cross section editor in detail. The 
purpose of the cross section editor is to provide a comprehensive view of data 
defined at a dike section. The data will be visualized in the LZ plane. Only data 
which can be visualized in this plane will be displayed, for example sub soil data, a 
surface line, water level, etc., but not dike lines and computational settings. 
 
The figure below schematically displays the cross section editor: 
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Figure 5.21 Modifying characteristic points along surface line in dike cross section editor 
 
The following items are displayed: 
 
Item Actions UC 
Surface line Selectable 21 
SchematizedSurfaceLine Points can be added, moved and deleted.   
Characteristic point By default a characteristic point is located 

on the dike surface line. Its position is 
editable by dragging a vertical cursor line, 
which appears after selecting a 
characteristic point. The line can be 
dragged to the left or right, which leads to 
a repositioning of the characteristic point 
on the surface line. The point ‘snaps’ to 
dike points only (default). 
 
Characteristic lines determine the location 
of characteristic points on the surface line. 
After a modification of a characteristic 
point, the characteristic line will not be 
updated. This means that updates to 
charactersitc lines are not saved. In the 
map, the imported characterstic line is 
displayed.  
 
When selecting a characteristic point, the 
user can select ‘Disconnect’ option in the 
context menu (right mouse button). 
Disconnect is a point property. With this 
option, it is possible to drag the 

21 
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Item Actions UC 
characteristic point to a position free from 
the surface line, see Figure 5.22. Of 
course, the validation rules for the 
schematized dike line still apply (§ 5.7). 
 
Those functions are only enabled for 
Overtopping and Stability.  

Piping entry and exit point Selectable 21 
Soil layer (1D and 2D) A soil layer can be added or removed 21 
Soil Displayed in the soil layer 21 
Piezometric head Selectable for Piping and Stability. 18 
Revetment Selectable. A revetment zone has a start 

and end point in the cross section editor in 
horizontal direction (Figure 5.21). The 
user can select, add, edit and remove 
revetment zones. Overlapping zones are 
not allowed, gaps between zones are. 

19 

Swell Selectable  
Water level setup Selectable  
 
 
 

 
Figure 5.22 Disconnect characteristic point from dike surface line 
 

5.6.4 Property window 
Several items in Ringtoets can be selected, either on the map, in the cross section 
editor, in a table or via the main menu. When selected, their properties are 
displayed in a property editor. Sometimes several property editors are available for 
the same item. In that case they are displayed in different tabs in a tab control. 
Property forms are not linked to a Configuration Database.  
 
The following property editors are displayed: 
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Item Property editor contents UC 
SoilProfile1D Geographical location and list of all soil layers, 

with top and bottom and assigned soil 
 

Soil properties assigned to the soil profile and 
possibility to select another soil. Available soils 
are retrieved from the soilbase model 

 

SoilProfile2D Geographical location and list of all soil layers 
with assigned soil 

 

Soil properties assigned to the soil profile and 
possibility to select another soil. Available soils 
are retrieved from the soilbase model 

 

StochasticSoilProfile Geographical location and list of all soil 
profiles with their probability 

 

SurfaceLine Geographical location and list of all points and 
their coordinates and characteristic type 

 

Fetch Geographical location and list of all fetch data 
per wind direction 

 

Swell Swell properties  
Water level setup Water level setup properties  
Revetment List of all revetment zones with all properties  
Structure Structure properties  
Breakwater Breakwater properties  
Dike section Geographical and administrative information 

and assessment options (whether to include in 
assessment).  

 

Assigned (combined) hydraulic boundaries. In 
case of combined hydraulic boundaries, a list 
is supplied with contributions of underlying 
hydraulic boundaries. 

 

Soil profile with the possibility to select another 
soil profile 

 

Surface line with the possibility to select 
another surface line 

 

Failure mechanism specific data for the dike 
section. Reliability and design point details. 

 

Probabilistic method and indication whether 
default is used 

 

Dike line Administrative values of the dike line and a 
table with combined failure probabilities, per 
mechanism and combined over all 
mechanisms 

 

List with all bending points in dike line.  
Characteristic line Meaning of characteristic line and list with all 

bending points 
 

Project  
Attributes NL 
Name Naam 
Client Opdrachtgever 
Project 
administrator 

Project-
administrator 
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Item Property editor contents UC 
Main project 
database location 

Hoofd 
projectdatabase 
locatie 

Main project 
database checked 
out sections 

Hoofd 
projectdatabase 
uitgecheckte delen 

Location Hydraulic 
Boundary database 

Locatie 
Hydraulische 
randvoorwaarden 
database 

Location temporary 
files 

Locatie tijdelijke 
bestanden 

Pre-configured 
mapping table 

Vooraf 
geconfigureerde 
koppeltabel 

 

Failure mechanism General properties of the selected failure 
mechanism 

 

Assessment model Default properties of the selected assessment 
model. General calculation options including 
the calculation scheme and probabilistic 
method.  
 
For assessment model 2b probabilistic 
properties are displayed for the selected 
mechanism. 
 
For 2a and 2b, a list is displayed with all 
available failure mechanisms, where the user 
can specify whether it should be used in the 
assessment. 

 

5.6.5 Tables and charts 
Tables and charts are displayed with close relationship to each other. Within a 
table/chart window, both a table and a chart are displayed. The chart is displayed 
right or below of the table, depending on the available space. The user can switch 
off one of them if he wishes.  
 
The following data are available in the tables. By default the number of columns 
equals the number of item properties. Hiding of columns of for example 
intermediate results is possible.  
 
Item Table Chart UC 
Dike sections Dike sections for the selected 

failure mechanism. In case no dike 
division has been set up yet, each 
dike line is assumed to be a dike 
section. Group per dike line. 
The table includes the failure 
probability for the dike section 

The L coordinate 
indicates the offset 
along the dike line. 

 

Dike division All division points for the current No chart.  
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Item Table Chart UC 
points failure mechanism. Group per dike 

line 
Dike lines Contains all failure probabilities 

valid for the whole dike linel  
Bar chart with 
failure probability 

 

Charaterisic 
lines  

Displayes meaning of line and 
allows focusing in map and 
property editor 

No chart  

Soil profiles 
1D 

All available 1D soil profiles in the 
soilbase model.  

No chart.  

Soil profiles 
2D 

All available 2D soil profiles in the 
soilbase model.  

No chart.  

Stochastic soil 
profiles 

All available stochastic soil profiles 
in the soilbase model. 

No chart.  

Surface lines All surface lines in the soilbase 
model. 

No chart.  

Swells All swell data No chart.  
Fetches All fetch data No chart.  
Water level 
setups 

All water level setup data No chart.  

Breakwaters All breakwater data No chart.  
Structures All structure data No chart.  

5.7 Validation 
Validation is run automatically after each change in the input data. It runs in a 
separate thread, so it won’t block the application. After validation finishes, a list of 
messages is displayed. These messages are either errors or warnings. If errors are 
present, running an assessment is not allowed. 
 
The following validations take place: 
 
Type Validation 
Error Exceedance of minimum or maximum of various objects 
Warning Check if cross sections are linked to one or two HB-output point(s) for 

level 1 assessment. Note: cross sections without HB-output point(s) 
can use interpolation (0) to get a characteristic water level and wave 
parameters.  

Warning Check if cross sections have characteristic points for the foreland and 
outer dike slope as input for the computations. If not, give a warning 
that interpolation is necessary.  

Error Check if characteristic cross sections (one for each mechanism 
section) are linked to one or two HB-output point(s) for level 2a and 
level 2b assessment. 

Warning Dike section consists of complete dike ring 
Error Dike surface line validation in the Cross section editor for Overflow and 

Wave overtopping. 
 
Foreland: 
- The horizontal surface point coordinates must increase going from 
start foreland to outer dike toe (important for tabular input). 
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Type Validation 
- Slopes steeper than 1 to 10 are not allowed (both rising and 
downward parts); gentle slopes are allowed.  
- The minimum distance between surface points is 10 m: too much 
detail in foreland is not allowed. 
- The surface points cannot go lower than the first foreland point. 
 
Dike: 
The dike consists of one or multiple dike line segments. The segments 
are either slope segments or berm segments: 
-  Slope segments have a minimum inclination of 1 to 8. 
- Berm segments have a minimum inclination of 1 to 100 and a 
**maximum inclination of 1 to 15. 
As a result, dike segments between 1 to 15 and 1 to 8 are not allowed. 
These ‘intermediate’ area’s cannot be calculated by the wave run-up 
routine. 
- A maximum of two berm segments are allowed. 
- The minimum distance between dike points is 2 meter. Too much 
detail in the dike profile is not allowed. 
- The horizontal point coordinates must increase looking from dike toe 
to dike crest. 
- The vertical point coordinates must increase looking from dike toe to 
dike crest. 
- Slope segments are steeper than 1 to 8 but cannot be steeper than 1 
to 1 (almost vertical slopes or vertical walls are not allowed). 
- The first and last slope section must be steeper than 1 to 8. 
 
Revetment: 
- A revetment segment, to determine the roughness, cannot be smaller 

than 1 meter. 
- The revetment cannot be positioned lower than the lowest slope point 

or lower than the endpoint of the foreland. 
- Overlapping revetments segments are not allowed, gaps between 

revetments are. 
 
Note: These revetment segments validation rules apply to the main 
mechanism Overflow and Wave Overtopping and not for the main 
mechanism Revetment. The main mechanism Overflow and Wave 
Overtopping just need the revetment surface roughness to calculate the 
hydraulic conditions on the outer dike slope.  

5.8 Assessments 

5.8.1 Assessment Level 0 
Some failure mechanisms are irrelevant for a certain stretch at a certain location. In 
Assessment level 0 the user can exclude these failure mechanisms for further 
assessments.  

5.8.1.1 Execute Level 0 assessment 
Starting point for level 0 assessment is imported dike key-data as described in 
§5.3.1. In the map-editor the user can view that data such as the dike line with the 
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characteristic lines and the cross-section points. With the basic GIS-functions and 
controls in the map editor, the user can open the dike cross-sections in the cross 
section editor. The expert can then view and inspect the dike geometry in the cross 
section editor.  
 
The level 0 assessment must be performed for each failure mechanism. The user 
can switch between failure mechanisms by the drop down box failure mechanisms 
located on top of the map editor.  
 
The expert assesses the relevance of a failure mechanism based on dike geometry, 
dike location and expert judgment. When a failure mechanism is assessed as not 
relevant, the dike section will be marked as a level 0 assessment section. The cross 
sections will get a different marking in the map editor. The map legend must link 
that specific mark with the status ‘Level 0’. The failure probability of a Level 0 
section will be assumed to be zero. The remaining cross sections are input for 
further assessment (level 1 or 2).  
 
The user will be able to mark a dike section as level 0 in four different ways: in the 
cross section editor, in the map editor, in the property editor and in a table. Methods 
to mark a dike section as Level 0 section include the following: 
 
• By a button in the cross section toolbar. 
• In the map editor by drawing a box with the mouse pointer. The cross sections 

inside the box will become ‘selected’. With a button on the map editor toolbox, 
the user can mark the selected cross sections as Level 0. 

• With a check box in the property editor of an activated (selected) cross 
section.  

• In a table that lists all available cross sections. A column ‘Level 0’ will be 
available in that table, giving the user the possibility to set the Level 0 status 
for multiple cross sections in one go.   
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Figure 5.23 Activity diagram for a level 0 assessment (relevance check) 
 

5.8.2 Assessment Level 1 
A Level 1 assessment is a simple assessment (Table 1.1) based on deterministic 
decision rules for different failure mechanisms. Input for the dike strength 
calculations are characteristic points in the dike geometry but also other variables 
like entrance points and Piezometric heads. Most input variables for the failure 
mechanisms, both load and strength, are imported or inputted as key-data at the 
start of the project.  

5.8.2.1 Execute level 1 
Assessment Level 1 is a simple assessment based on (deterministic) design rules. 
The assessment is performed per mechanism at cross section locations. The 
assessment will only be applied to cross sections that are not marked with a level 0 
status.  
 
Ringtoets will call Hydra-Ring for the computation of the characteristic water level 
and wave parameters per cross section, usually in combination with an overtopping 
calculation. For this purpose a schematization of both the foreland and outer dike 
slope are necessary. The user can select certain cross sections for this first 
hydraulic boundary schematization. For the cross sections in between, Ringtoets 
will use interpolation to determine the hydraulic boundary conditions. Ringtoets will 
need to pass data from the project database to Hydra-Ring and vice versa.  
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Figure 5.24 Activity diagram for a level 1 assessment  
 

5.8.2.2 Inspect level 1 results 
Ringtoets will execute a level 1 assessment at the cross sections that were not 
marked by the user with ‘level 0’. Level 1 is a simple, deterministic assessment 
based on decision rules. The result indicates only if cross section passes the 
assessment or not. Ringtoets will mark the cross sections that pass with a ‘level 1’ 
status. The remaining cross sections will be marked for further assessment (‘level 
2’). The results will be visible if ‘Assessment Level 1’ is activated in the Ringtoets 
toolbar. 
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The user can inspect the results in the Map editor. A button ‘Show results’ on the 
map editor toolbar displays the results on the dike line per cross section. The 
possible statuses are 0 (irrelevant for this mechanism), 1 (passing a level 1 
assessment), or 2 (level 2 assessment is required). The same information will also 
be available in the table presentation.  
 
Ringtoets will also store the maximum allowed failure probability per level 1 
approved mechanism and cross section, unless this value is zero. The user can 
inspect  these values in a table presentation. The maximum failure probability will 
be affected by the dike length associated to a cross section. 
 

5.8.3 Assessment level 2a 

5.8.3.1 Additional schematization for level 2 assessment 
Level 2 is a detailed analysis using a semi-probabilistic calculation (2a) or a full 
probabilistic calculation (2b). The difference with the previous assessment levels is 
that the level 2 assessments use mechanism sections instead of cross sections.  
 
A mechanism section is a stretch of a flood defense with more or less 
homogeneous properties and boundary conditions for the considered mechanism. A 
mechanism section is built from multiple, adjacent cross sections. Initially the entire 
dike line is one mechanism section. The user can split one mechanism in two 
separate mechanism sections by adding a point on the dike line. Merging of 
mechanism sections is possible as well.  
 
Import of existing mechanism sections divisions will also be possible, eventually in 
combination with manual adjustments. For the revetment mechanisms branch, 
Ringtoets will automatically propose a first distribution, based on the location of 
different revetment zones.  
 
For every mechanism section the user must select one characteristic cross section. 
The properties of that cross section will be used as input for following level 2a 
assessments. By default, Ringtoets will automatically link the cross section that is 
most close to the middle of the centerline of the dike section. Manual selection of 
another cross section is possible.  

5.8.3.2 Execute level 2a assessment 
Level 2a assessment is a semi-probabilistic assessment. The assessment is per 
mechanism section. If the assessment is positive, the failure probability is below a 
certain maximum derived from the failure probability budget by using characteristic 
values for strength and loading, in combination with partial safety factors. The 
length of a single mechanism influences that failure budget (length effect) via partial 
safety factors.  
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Figure 5.25 Activity diagram for a level 2a assessment  
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5.8.3.3 Inspect level 2a results 
The result of a 2a assessment is a check on the Factor of Safety (FOS). The results 
show whether the FOS is sufficiently large enough (‘OK’,) or not (‘Not OK’). The 
user will also have the possibility to inspect the actual calculated FOS.  
The results will be shown in the Map Editor where mechanism sections are 
indicated with a green color (‘OK’) or orange color (‘Not OK’). The user can inspect 
the results per mechanism (pull down menu in Ringtoets toolbar). The mechanism 
sections with a green color are either stretches marked as ‘level 0’, ‘level 1’, or ‘level 
2a OK’. The ‘level 2a Not OK’ stretches will have the orange color. Those sections 
are input for the 2b assessment.  
 
In the ‘Combined’ mode (combined for all mechanisms) the map editor shows the 
results projected on combination sections.  Ringtoets creates the combination 
sections by projecting the begin and end points of all mechanism sections of all 
mechanisms on the dike (Figure 2.5). The ‘Combined’ mode can be activated by a 
button on the Ringtoets toolbar. This mode is additional to the failure mechanisms 
(e.g. Overtopping | Revetment | Piping | Combined).  
 
The table below the bottom of the Map Editor shows the results per mechanism 
section or per presentation section. If a mechanism is activated (in the pull down 
menu), there will be at least columns with the mechanism section’s name (Id), the 
assessment level (0, 1, 2) and level 2a results (OK, Not OK). If the item ‘Combined’ 
is selected, the table shows the presentation section Id’s and the level 2a results 
(OK, Not OK).  
 
The FOS can be displayed per failure mechanism as well (combined for mechanism 
sections). In the Map Editor the user must select the ‘FOS’ button. The color of the 
mechanism sections and the legend will change to a ‘FOS’ display. Additionally the 
actual, digital FOS value can be displayed in a mechanism section label. The FOS 
value can be displayed in the table presentation. 
 
Detailed assessment results for overtopping/overflow will also be presented in the 
table presentation. 

5.8.4 Assessment Level 2b 
Assessment Level 2b is full probabilistic check. Initially the 2a mechanism sections 
that did not pass the semi-probabilistic check are input for 2b. Additional input 
(probabilistic data) is necessary but not mandatory. The level 2b results can be 
displayed on user defined presentation sections.   

5.8.4.1 Additional schematization for level 2b assessment 
By default the input for level 2b are the level 2a section that did not pass the semi-
probabilistic check. Initially all mechanism sections that did not pass the semi-
probabilistic test are input for the full probabilistic assessment. Additionally, it will 
also be possible to manually select mechanism sections with the status ‘level 1 OK’ 
or ‘level 2a OK’ sections as input for the level 2b assessment. With the check box 
‘Select all’ the user can select all available mechanism sections as input for level 2b 
(except for level 0 stretches) at once. This check box is located in the level 2b 
assessment calculation form (§ 5.8.4.2).  
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Ringtoets can accept a stochastic definition for many model parameters. These 
model parameters are imported as key-data and/or edited in property forms and 
tables. 
 
The user must modify (move) characteristic points if they don’t comply with the 
(more) stringent constraints. Probabilistic input is possible for the mechanisms 
overflow/overtopping and revetment. At writing of this report, this functionality will 
not be implemented yet.  
It is possible to input stochastic soil profiles for piping. For one cross section the 
user can for example select three 1D soil profiles from the soil database. Each 
profile gets a certain probability and the summed probabilities is 100%. If only one 
soil profile is available, it automatically has a probability of 100%. 
 
The level 2b assessment computes the combined failure probabilities of all failure 
mechanisms on presentation sections. Presentation sections are groups of the 
combination sections from level 2a. The user must define the presentation sections 
in advance of the level 2b calculation. By default the presentation section division is 
equal to the combination section division from level 2a.  
 
To combine level 2b results with level 1 and level 2a results, the failure probability 
budgets of these dike stretches are needed.  

5.8.4.2 Execute level 2b assessment 
Level 2b assessment is a full probabilistic assessment, which means that stochastic 
variables are used for load and strength computations. Note that it is not mandatory 
to model all parameters as stochastic variables.  Instead, Ringtoets can also use for 
selected parameters also the same unfavorable values as in a semi-probabilistic 
analysis. A level 2a assessment can be easily replaced by a level 2b assessment, 
as no additional data is needed. In case of a combination with level 1 assessed 
parts, Ringtoets wil need to reduce the admissible failure probability for level 2b, if 
the maximum failure probability of some level 1 assessed parts is significantly larger 
than zero. 
 
Ringtoets will call Hydra-Ring twice for the execution of Assessment level 2b.  
• First for the calculation of failure probabilities per mechanism section (the 

mechanism section loop is expected to be part of Hydra-Ring). Output are the 
Failure Probabilities (FP) and design points per mechanism section.   

• Second for combination of failure probabilities to presentation sections and to 
combinations of presentation sections. 

 
Ringtoets will need to pass data from the database to Hydra-Ring and vice versa.  
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Figure 5.26 Activity diagram for a level 2b assessment  
 
The following classes are involved in controlling HydraRing: 
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Figure 5.27 Class diagram for controlling HydraRing 
 

5.8.4.3 Inspect level 2b results 
Output of level 2b assessment are failure probabilities and design points. Ringtoets 
combines the FP of separate mechanism sections to FP for presentation sections 
and the total dike ring.  
 
The user can inspect the FP per mechanism section in the Map Editor. The Map 
Editor shows the FP on the dike line for each failure mechanism section with a 
color. The FP value can be displayed in a mechanism section label. With a pull 
down menu the user can switch between the results for different mechanisms. In 
level 2b the pull down menu also has the item ‘Presentation sections’, showing the 
FP per presentation section. The results are also visualized in the dike line graph. 
 
If ‘Presentation sections’ is selected, the Map Editor shows the total FP for the 
(entire) dike ring. The total FP as a numerical value is shown in a label located at 
the center of the dike ring. The color scheme is similar to the previous used FP 
legend colors.  
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If the user double clicks the dike line, a property form opens. The tab ‘Level 2b’ in 
that property form will show the total FP per failure mechanism and the (entire) dike 
ring.   
 
The numerical values of the FP per mechanism sections are also shown in the table 
presentation below the Map Editor. The values are updated whenever the user 
selects another mechanism in the pull down menu. The table also shows the 
previously used failure probability budget for level 1 and level 2a sections. If the 
user chooses ‘Presentation section’, the table shows the FP for presentation 
sections. In this mode, the table not only presents the FP values but also the 
available failure probability budget per presentation section.  
 
The table lists the design points as well. A design point is a collection of values of 
stochastic variables. The number (columns) of displayed stochastic variables may 
be limited to key-variables if there are too many. The user can set the application in 
a mode to display design point values. Then all property editors and tables show 
data values according to the design points. This is taken care for by the 
StochasticParameter class. 
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A Glossary of terms (English to Dutch) 

(Terms in italic are not used in the current report) 
English  Dutch  Description  

APT  APT  Arbitrary point in time – refers to a alternative 
method for FBC, modelling the time position in a 
trapezoidal shaped evolution of a discharge wave 
or lake level by using an additional stochastic time 
variable. 

Assessment  Toets  refers to the assessment of flood defences to 
determine if they comply with legally mandated 
protection levels during the assessment period 

Assessment 
water level  

Toetspeil  Characteristic water level associated with a legally 
mandated exceeding probability at the end of the 
assessment period. 

Block  Blok  Refers within the FBC calculation scheme to the 
rectangular shape of a temporal process, such as 
a discharge wave. 

Block duration  Blokduur  The width (in time) of a temporal process 
represented by a block  

Central form Centrale dialoog The central form of the program screen. 
Characteristic 
lines  

Karakteristieke lijnen Lines parallel to the dike, which combine a certain 
characteristic point in different dike cross sections.  

Characteristic 
value 

Karakteristieke waarde Value with a certain exceedance probability 

Combining  Oprollen  Combining failure probabilities for  elements with 
unequal design points, using the Hohenbichler 
method 

Combination 
sections 

Combinatie vakken Dike sections, with a division following from the 
joined  mechanism sections, for a semi-
probabilistic assessment of combined 
mechanisms 

Cross section  Doorsnede  A  dike cross section  
D Dagenlijn D(Q). The average number of days per winter 

period that the discharge Q exceeds a certain 
value 

DAM DAM Dike strength Analysis Module, for automated 
schematization, analysis and design, based on 
geotechnical failure mechanisms.  

Design point Illustratiepunt 
/Ontwerppunt 

The combination of parameters at failure with the 
highest probability. The FORM method linearizes  
the Limit State function in this point, after 
estimating it by a gradient search method. 

Design water 
level  

MHW, Ontwerppeil  Characteristic water level associated with a legally 
mandated exceeding probability at the end of the 
design life  

Detailed 
assessment 

Gedetailleerde 
toetsing 

A  semi-probabilistic or probabilistic assessment 
(level 2a or level 2b), based on failure mechanism 
models requiring detailed input. 

Dike Dijk A dike as part of a defence system.  
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Dike line Dijk lijn The dike location line, usually connecting the 
points at the approximate centre of the dike crest.  

Dike point Dijkpunt Point on dike line marking the begin/end point of a 
dike section.  

Dike ring Dijkring A dike ring is a continuous line of flood defences 
(dikes, dunes, structures, barriers or high ground), 
protecting a certain region. 

Dike section Dijkvak  A part of the dike for which strength and load 
properties are homogeneous  

Discharge afvoerdebiet The river discharge Q  
Discharge 
peak  

Afvoerpiek  The highest discharge in a modelled discharge 
wave  

Discharge 
wave 

Afvoergolf The assumed development in time of the river 
discharge during a high water period. 

Drop down 
menu 

Drop down menu A drop down menu with a number of predefined 
selection options.  

DS Directional Sampling Monte carlo directional sampling 
Dune Duin Dune as part of a defence system. 
Discharge 
exceedance 
frequency 
curve  

Werklijn, Frequentielijn   F(Q).The average number of occurrences per 
winter period that the discharge Q exceeds a 
certain value 

Failure 
Mechanism  

Faalmechanisme  A fundamental process or defect causing failure of 
the water retaining function. Examples are: 
overtopping/overflow, slope instability, piping, 
revetment failure, dune erosion etc. 
 

Failure 
mechanism 
model 

Faalmechanisme 
model 

A failure mechanism can have more failure 
mechanism models. The failure mechanism piping 
can have one or more sub soil models. 

Failure 
probability (FP)  

Faalkans  The annual probability that a flood defence fails, 
i.e. that water enters the protected area.  

FBC  FBC  calculation scheme named after Ferry, Borges 
and Castanheta, with a blockwise description of 
the temporal evalution of a discharge wave or lake 
level..   

Fetch area Strijklengte The fetch area per wind direction for the 
development of wind waves according to the 
Bretschneider model. 

File format Bestandsformaat File formats are defined for specific data sets.  
Flood defence  Waterkering A  water retaining object (dike, dune, structure), 

protecting the hinterland. 
Foreland Voorland Area outside the dike, from dike toe to (hydraulic 

boundary) point with undisturbed hydraulic 
conditions.   

FORM  FORM  Probabilistic method: First Order Reliability 
Method, determines the so-called design point 
and associated FP using iterative linearization of 
the limit state function  

FOS Veiligheidsfactor Factor of Safety. Ratio between allowed and 
actual value of a certain load type.  
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FP budget Faalkansenbudget The allocated allowed failure probability for 
different mechanisms and sections, in case of a 
sem-probabilistic assessment 

GIS GIS Geographic Information System 
GIS-layer GIS kaartlaag Layers in a GIS map of a certain theme.  
GIS-map GIS kaart A map with geographic background and objects.  
Heave Opbarsten Mechanism of heave of the cover layer, due to  

the upward pore pressure in the aquifer 
underneath .  

Hydraulic load Hydraulische belasting Load of a construction due to hydrodynamic 
processes. 

Hydrodynamic 
database 

Hydraulische 
randvoorwaarden 

Database with the hydrodynamic parameters. 

Key data kerngegevens Key data, for setting up a dike schematisation. 
Most key data will be imported from existing 
databases, maintained by the water boards.  

Length effect  Lengte effect  The increase in failure probability that results from 
considering longer stretches of dike (or dunes)  

Limit State 
Function (LSF)  

LSF  Describes the interface between failure and non-
failure for different combinations of stochastic 
parameters  

Loop sequence  Rekenschema  Refers to the sequence of loops (e.g. over time 
periods, wind directions and mechanisms) in 
programming code  

MC-C MC-C Probabilistic method: Crude Monte Carlo 
sampling. 

MC-IS MC-IS Probabilistic method: Monte Carlo importance 
sampling 

Mechanism mechanisme see Failure mechanism 
Mechanism 
section 

Mechanismevak  A stretch of a flood defence with more or less 
homogeneous properties and boundary conditions 
for the considered mechanism. 

Menu bar Menubalk  

N Overschrijdingsduurlijn Duration line. N(Q) = D(Q)/F(Q). The average 
duration of the  period in which Q exceeds a 
certain value 

Navigation 
pane 

Navigatie paneel Navigation pane with lists of editable GIS-objects 
such as cross sections, dike line and hydraulic 
boundary points. 

NTI Numerieke 
tijdsintegratie  

Refers to a method for modelling the shape of a 
temporal evolution of a discharge wave or lake 
level, by discretizing it into sections of width Δt, 
and combining the failure probability contributions 
of all sections. The combination of NTI with NI 
gives characteristic water levels equal  to the 
Hydra’s. 

NI Numerieke integratie  Probabilistic method: Numerical Integration. 
Discretizes random variables and for each 
combination computes the probability of 
occurrence and subsequently sums over all 
combinations that led to failure  
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Overflow  Overloop  failure mechanism that occurs when the water 
level is higher than the crest height of the defence  

Overtopping  Overslag  failure mechanism that occurs when the waves 
run over the crest height of the defence (water 
level + wave > crest height)  

Piping  Piping  The mechanism that causes loss of stability by 
internal erosion  

Presentation 
section 

Presentatievak Sections consisting of one or more combination 
sections, for the purpose of presenting the 
combined contribution from different mechanisms 
in case of a probabilistic analysis. 

Probabilistic 
analysis 

Probabilistische 
analyse 

Probabilistic determination of failure probabilily, 
using stochastically distributed variables for 
loading and strength.   

Project 
database 

Project database Database with all project data, except for the 
results database and hydrodynamic database of 
the active project. 

Relevance 
check 

Relevantie toets Relevance check for a certain failure mechanism 
for a certain dike section (level 0).  

Revetment Bekleding Revetment of a dike, defined by different zones, 
each consisting of a certain revetment type with 
associated properties.   

Screen Beeldscherm The screen user interface of the Ringtoets 
application.  

Semi-
probabilistic 
analysis 

Semi-probabilistische 
toets 

A deterministic assessment (level 1 or 2a), using 
conservative characteristic values for loading and 
strength parameters, together with partial safety 
factors. The safety factors are calibrated such, 
that the failure probability will always stay below 
the allowed value. 

Section vak Part of the flood defence system with more or less 
homogeneous loading and strength properties.  

Simple 
assessment 

Eenvoudig toetsing Simple assessment of a dike section (level 1), 
using failure mechanism models requiring only 
geometrical data. 

Slope 
instability  

Macro-instabiliteit  The mechanism that causes slope shear failure of 
dike embankments  

Structures Kunstwerken Civil structures build as part of the defence 
system. 

Sub-
mechanism  

Deelmechanisme  A submechanism which only causes failure when 
combined together with another submechanism  

Subsoil Ondergrond Subsoil of the dike’s basement.  
Subsoil profile Ondergrondprofiel A sequence of subsoil layers, either 1D or 2D.  
Subsoil 
scenario 

Ondergrondscenario A subsoil profile with certain occurrence 
probability, in case of stochastic subsoil modelling. 

Surface line Dijkoppervlak The surface line of the dike in the cross section, 
including the relevant part of the waterbed and the  
hinterland.  

System 
Architecture 

Systeemarchitectuur The hardware design of an application.  

Tab Tabblad Tabs are used to switch between different forms. 
Tidal period  Getijperiode  A period of (approximately) one tide, relevant in 

the load modelling for an arbitrary discharge wave 
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shape  
Upscaling  Opschalen  Combining failure probabilities for a number of 

elements (time elements or spatial elements) with 
equal FP  

XML XML Self describing data format, suited for exchange 
through files or web-services 
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B  Glossary of terms (Dutch to English) 

(Begrippen in schuinschrift worden in het rapport niet gebruikt) 
Dutch  English  Beschrijving 

Afvoerdebiet Discharge De rivierafvoer (Q) 
Afvoergolf Discharge wave De aangenomen ontwikkeling in tijd van de 

rivierafvoer gedurende een hoogwaterperiode.  
Afvoerpiek  Discharge peak  The hoogste afvoer in een gemodelleerde 

afvoergolf. 
APT  Arbitrary Point in 

Time 
Refereert naar een alternatief rekenschema voor 
FBC, waarin een trapeziumvormig verloop van 
een afvoergolf of het meerpeil wordt 
gemodelleerd middels een extra stochastische 
variabele voor het evaluatietijdstip binnen de 
afvoergolf. 

Beeldscherm Screen Het beeldscherm van het programma Ringtoets 
Bekleding Revetment Bekleding van een dijklichaam. Deze bestaat 

doorgaans uit verschillende geometrische 
zones,  met elk een bepaald bekledingstype en 
daaraan verbonden eigenschappen.  

Bestandsformaat File format Bestandsformaat, meestal gedefinieerd voor de 
uitwisseling van specifieke gegevens. 

Blok  Block  Refereert binnen het FBC rekenschema naar de 
rechthoekige vorm van een tijdsafhankelijk 
proces zoals een hoogwatergolf.  

Blokduur  Block duration  De duur (in de tijd) van een tijdsafhankelijk 
proces dat geschematiseerd is als een blok.  

Centrale dialoog Central form Centrale dialoog van het programma 
beeldscherm.  

Combinatievakken Combination 
sections 

Vakindeling die resulteert uit het “opbossen” van 
de indelingen voor verschillende mechanismen, 
ten behoeve van een semiprobabilistisch 
toetsresultaat voor gecombineerde 
mechanismen. 

Dagenlijn D(Q). D(Q). Het gemiddelde aantal dagen in de 
winterperiode waarbij de rivierafvoer een 
bepaalde waarde overschrijdt.  

DAM DAM Dijksterkte Analyse Module voor 
geautomatiseerde schematisatie, analyse en 
ontwerp op basis van  geotechnische 
faalmechanismen. DAM wordt ontwikkeld onder 
regie van STOWA 

Deelmechanisme  Sub-mechanism  Een deelmechanisme dat alleen kan leiden tot 
falen in combinatie met een ander 
deelmechanisme.  

Deterministische 
toetsing veiligheid 

Deterministic safety 
assessment 

De deterministische toetsing van de 
dijkveiligheid, gebaseerd op deterministisch 
vastgestelde processen, vaak leidend tot ruimte 
(conservatieve) veiligheidsmarges.  

Dijk Dike Een dijk of dijklichaam 
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Dijklijn Dike line De hartlijn van het dijklichaam, meestel gelegen 
in het midden van de dijkkruin. 

Dijkoppervlak Surface line De oppervlaktelijn van een dijk in een 
dwarsdoorsnede, inclusief het relevante deel 
van het waterbed en het achterland. 

Dijkpunt Dike point Punt op dijklijn die het begin/einde van een 
dijkvak markeert. 

Dijkring Dike ring Een dijkring is gedefinieerd als ondoorbroken lijn 
van waterkeringen (dijken, duinen, stuwen of 
hoge gronden), die een bepaald gebied 
beschermt. 

Dijkvak  Dike section Een deel van de dijk (in as-richting) met min of 
meer homogene eigenschappen en belasting 

Doorsnede  Cross section  Een dwarsdoorsnede van de dijk 
Drop down menu Drop down menu Een keuze menu met vooraf gedefinieerd aantal 

mogelijkheden. 
DS DS Probabilistische methode: Monte Carlo 

directional sampling 
Duin Dune Een duin als onderdeel van een waterkering. 
Eenvoudige toetsing Simple Assessment Een eenvoudige toetsing (level 1), met 

faalmechanismodellen waarvoor  doorgaans 
geometrische informatie volstaat   

Faalkans  Failure probability 
(FP)  

Op systeem niveau is dit de jaarlijks kans dat 
een waterkering faalt, dus dat water het 
beschermde gebied binnengaat. Hydra-Ring 
gebruikt een combinatie van technieken om de 
faalkansbijdragen van verschillende 
faalmechanismen en dijksecties te combineren.  

Faalkansen budget FP budget De toedeling van de toelaatbare faalkans over 
verschillende mechanismen en vakken, voor 
een semi-probabilistische toets 

Faalmechanisme  Failure Mechanism  Een proces dat kan leiden tot het falen van de 
waterkerende functie. Bijvoorbeeld: 
overloop/golfoverslag, helling instabiliteit, piping, 
bekleding falen, duin erosie etc. 

Faalmechanisme 
model 

Failure Mechanism 
model 

Het eenvoudige of gedetailleerde model dat 
wordt gebruikt om het faalmechanisme te 
beschrijven.  

FOS   Zie veiligheidsfactor 
FBC  FBC  Ferry, Borges en Castanheta model voor het 

modelleren van tijdelijke processen binnen een 
faalkansberekening, zoals PC-Ring dat ook 
doet.  

FORM  FORM  Probabilistische methode: Eerste orde 
betrouwbaarheidsberekeningen, bepaalt het 
ontwerppunt en de bijbehorende faalkans 
gebruikmakend van iteratieve linearisatie van de 
faalkansfunctie.  
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Gedetailleerde toets Detailed 
assessement 

Gedetailleerde toets: semi-probabilistisch 
(niveau 2a) of probabilistisch (niveau 2b). In 
beide gevallen wordt gebruik gemaakt van een 
faalmechanismemodel dat gedetailleerde invoer 
nodig heeft.  

Getijperiode  Tidal period  Een periode van getijde periode, relevant voor 
het modelleren van de vorm van een 
willekeurige afvoergolf.  

GIS GIS Geografisch Informatiesysteem 
GIS kaart GIS-map Een GIS kaart waarin de gebruiker kan 

navigeren en objecten bekijken.  
GIS kaartlaag GIS-layer Kaartlagen in een GIS kaart met verschillende 

thema’s.  
Hydraulic Load Hydraulische 

belasting 
De hydraulische belasting op een dijklichaam. 

Hydraulische 
randvoorwaarden 

Hydrodynamic 
database 

De hydraulische belasting zoals vastgelegd in 
het Hydraulische Randvoorwaardenboek.  

Illustratiepunt 
/Ontwerppunt 

Design point De combinatie van parameters waarbij falen 
optreedt met de hoogste kans op voorkomen. 
De FORM methode maakt gebruik van een 
gelineariseerde faalkansfunctie. Het punt wordt 
gevonden door het afschatten van de gradiënten 
in het ontwerppunt.  

Karakteristieke lijn Characteristic line Lijn parallel aan de dijk lijn, die een bepaald 
karakteristieke punt in verschillende 
dwarsdoorsneden verbindt.  

Karakteristieke warde Characteristic value Waarde met een bepaalde overschrijdingskans. 
Kerngegevens Key data Onmisbare gegevens voor het opzetten van de 

dijk schematisatie. Deze kerngegevens worden 
doorgaans beheerd door de waterschappen, in 
een GIS. 

Kunstwerken Structures Civieltechnische constructies die onderdeel zijn 
van de (primaire) waterkering. 

Lengte effect  Length effect  De toename van de faalkans bij toename van de 
dijklengte.  

LSF  Limit State Function 
(LSF)  

Beschrijft de grens tussen falen/niet-falen voor 
verschillende combinatie van stochastische 
parameters.  

Macro-instabiliteit  Slope instability  Afschuiven van het dijktalud. 
Mechanismevak Mechanism section Een dijkvak waarop de sterkte-eigenschappen 

en belastingvariabelen voor een zeker 
mechanisme homogeen zijn. 

MC-C MC-C Probabilistische methode: Crude Monte Carlo 
sampling. 

MC-IS MC-IS Probabilistische methode: Monte Carlo 
importance sampling 

Mechanisme Mechanism Zie Faalmechanisme 
Menubalk Menu bar Een balk met keuze opties bovenin het 

beeldscherm. 
MHW, Ontwerppeil  Design water level  Waterniveau aan het eind van een ontwerp 

verbonden aan de wettelijk opgelegde 
herhalingstijd. 
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Navigatie paneel Navigation pane Navigatievenster met model items van het 
geopende project.  

Numerieke integratie 
(NI) 

Numerical 
Integration  

Probabilistische methode: berekent de faalkans 
door numerieke integratie over alle 
stochastische variabelen.  

Numerieke 
tijdsintegratie (NTI) 

Numerical Time 
Integration 

Refereert naar een alternatieve methode voor 
FBC, waarbij de vorm van het verloop van een 
afvoergolfof meerpeil wordt gemodelleerd door 
hem op te delen in stukjes met elk een duur van 
Δt.  De NTI  methode in combinatie met NI is 
vergelijkbaar met de methode die de Hydra’s 
gebruiken voor de berekening van toetspeilen 
en hydraulische belastingniveaus. 

Ondergrond Subsoil Ondergrond van het dijklichaam. 
Ondergrondprofiel Subsoil profile Opbouw van de ondergrond in grondlagen (1D o 

f 2D). 
Ondergrondscenario Subsoil scenario Ondergrondprofiel met een bepaalde kans op 

voorkomen in de ondergrondmodellering.  
Opbarsten Heave Opbarsten van de deklaag door opwaartse 

grondwaterdruk in de onderliggende 
watervoerende laag. 

Oprollen  Combining  Combineren van faalkansen voor elementen met 
ongelijke ontwerppunten, gebruikmakend van 
Hohenbichler  

Opschalen  Upscaling  Combineren van faalkansen voor een aantal 
elementen (tijd of ruimte elementen) met gelijke 
faalkansen.  

Overloop  Overflow  Faalmechanisme dat optreedt wanneer het 
water niveau hoger is dan de dijkkruin.  

Overschrijdingsduurlijn  N(Q) = D(Q)/F(Q). De gemiddelde duur van een 
periode waarin Q een bepaalde waarde 
overschrijdt.  

Overslag  Overtopping  Faalmechanisme dat optreedt als golven over 
de dijkkruin slaan.  

Piezometric head Stijghoogte  Stijghoogte grondwater in een bepaald punt of 
van een bepaalde laag.  

Piping  Piping  Het mechanisme dat leidt tot stabiliteitsverlies 
door interne erosie.   

Presentatievakken Presentation 
sections 

De onderverdeling van de dijk in 
presentatievakken , voor combinatie van de 
faalkansbijdragen van verschillende 
mechanismen (niveau 2b). Een presentatievak 
bestaat uit een of meer combinatievakken.  

Probabilistische 
analyse 

Probabilistic 
analysis 

Een berekening van de faalkans, gebaseerd op 
stochastische verdelingen van variabelen voor 
belasting en sterkte. 

Project database Project database De database met daarin de projectgegevens van 
het geopende project. 

Rekenschema  Loop sequence  Refereert naar de volgorde van rekenlussen 
(bijv. over de windrichtingen, en over de 
faalmechnismen) in de programma code.  

Relevantie toets Relevance check Relevantie toets voor een bepaald mechanisme 
langs een dijkring (niveau 0). 
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Semi-probabilistische 
toets 

Semi-probabilistic 
assessment 

Een  deterministische toets (niveau 1 en niveau 
2a), met conservatieve karakteristieke waarden 
voor belasting en sterkte variabelen, in 
combinatie met partiële veiligheidsfactoren. De 
veiligheidsfactoren zijn zo gekozen dat de 
faalkans altijd beneden een toelaatbare waarde 
blijft. 

Strijklengte Fetch area De strijklengte per windrichting voor het 
ontwikkelen van windgolven, voor het 
Bretschneider model. 

Systeemarchitectuur System architecture Het fysieke ontwerp van een systeem. 

Tabblad Tab Via tabbladen kan tussen verschillende dialogen 
worden gewisseld. 

Toets  Assessment  Refereert naar de toetsing van waterkeringen 
om te bepalen of ze voldoen aan de wettelijk 
vastgelegde normen voor de jaarlijkse faalkans.  

Toetspeil  Assessment water 
level  

De karakterististieke waterstand met een 
jaarlijkse overschrijdingskans gelijk aan de 
toelaatbare.  

Vak Section Zie dijkvak 
Veiligheidsfactor Factor of Safety De veiligheidsfactor is de verhouding tussen de 

toelaatbare en actuele belasting voor een zeker 
faalmechanisme. 

Waterkering (systeem) Flood defence 
(system) 

Waterkering (dijk, duin, vaste en bewegende 
constructies). 

Werklijn, Frequentielijn  Discharge 
Exceedance 
frequency curve  

 F(Q). Het gemiddeld aantal  keren dat een 
afvoer een bepaalde waarde overschrijdt in één 
winterperiode.  

Voorland Foreland Gebied buitendijks van de dijk vanaf de teen tot 
aan het (hydraulische randvoorwaarde) punt met 
ongestoorde hydraulische condities.  

XML XML Zelfbeschrijvend data formaat, geschikt voor 
uitwisseling via files of via web-services 
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